Copyright
© 2006 Digidesign, a division of Avid Technology, Inc. All rights reserved. This
guide may not be duplicated in whole or in part without the express written
consent of Digidesign.
Avid, Digidesign, Pro Tools and Pro Tools|HD are either trademarks or registered
trademarks of Avid Technology, Inc. in the US and other countries. All other
trademarks contained herein are the property of their respective owners.
Product features, specifications, system requirements, and availability are
subject to change without notice.
PN 9106-18921-00 REV A 07/06

Warning
This product contains chemicals, including lead, known to the State of California
to cause cancer and birth defects or other reproductive harm. Wash hands after
handling.

Communications & Safety Regulation Information

Compliance Statement
The models D-Control and XMON comply with the following standards regulating
interference and EMC:
• FCC Part 15 Class A
• EN55103 – 1, environment E4
• EN55103 – 2, environment E4
• AS/NZS 3548 Class A
• CISPR 22 Class A
• ICES-003 Class A

Canadian Compliance Statement:
This Class A digital apparatus complies with Canadian ICES-003
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du
Canada.

CE Compliance Statement:

Digidesign is authorized to apply the CE (Conformité Européenne) mark on this
compliant equipment thereby declaring conformity to EMC Directive

Australian Compliance:

Radio and Television Interference
This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules.

Communications Statement
This equipment has been tested to comply with the limits for a Class A digital
device. Changes or modifications to this product not authorized by Digidesign,
Inc., could void the Certification and negate your authority to operate the product.
This product was tested for CISPR compliance under conditions that included
the use of peripheral devices and shielded cables and connectors between system
components. Digidesign recommends the use of shielded cables and connectors
between system components to reduce the possibility of causing interference to
radios, television sets, and other electronic devices.

Safety Statement
This equipment has been tested to comply with USA and Canadian safety
certification in accordance with the specifications of UL Standards; UL6500 and
Canadian CSA standard; CSA C22.2 No.1-M90. Digidesign Inc., has been
authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Important Safety Instructions
1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with dry cloth.
7) Do not block any ventilation openings. Install in accordance with the
manufacturer’s instructions.
8) Do not install near any heat sources such as radiators, heat registers, stoves,
or other apparatus (including amplifiers) that produce heat.
9) Do not defeat the safety purpose of the polarized or grounding-type plug. A
polarized plug has two blades with one wider than the other. A grounding type
plug has two blades and a third grounding prong. The wide blade or the third
prong are provided for your safety. If the provided plug does not fit into your
outlet, consult an electrician for replacement of the obsolete outlet.
10) Protect the power cord from being walked on or pinched particularly at plugs,
convenience receptacles, and the point where they exit from the apparatus.
11) Only use attachments/accessories specified by the manufacturer.
12) Use only with the cart, stand, tripod, bracket, or table specified by the
manufacturer, or sold with the apparatus. When a cart is used, use caution when
moving the cart/apparatus combination to avoid injury from tip-over.
13) Unplug this apparatus during lightning storms or when unused for long
periods of time.
14) Refer all servicing to qualified service personnel. Servicing is required when
the apparatus has been damaged in any way, such as power-supply cord or plug
is damaged, liquid has been spilled or objects have fallen into the apparatus, the
apparatus has been exposed to rain or moisture, does not operate normally, or
has been dropped.

WARNING
To reduce the risk of fire or electric
shock do not expose this equipment
to rain or moisture.

CAUTION
Risk of electric shock
Do not open
Avis
Risque de choc electrique ne pas ouvrir

Do not attempt to service the equipment. There are no
user-serviceable parts inside. Please refer all servicing to authorized
digidesign personnel.
Any attempt to service the equipment will expose you to a risk of
shock and will void the manufacturer’s warranty.
SPECIAL WARNING REGARDING VENTILATION:
Do not install D-Control anywhere or in any way that blocks free air flow at any time around the back panel of the unit.

SPECIAL WARNING REGARDING AMBIENT TEMPERATURE:
Before powering on the D-Control unit, be sure to allow it to reach room temperature. The unit includes some components that are sensitive to cold temperatures, so it is recommended that you unpack the unit and allow it to acclimate before turning it on for the first time.

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.
# Contents

## Part I  Introduction

**Chapter 1. Introduction to D-Control**

- D-Control Features .................................................. 3
- D-Control System Components ........................................ 3
- System Expansion Options ............................................. 4
- Operational Requirements ............................................. 4
- Connection Requirements ............................................... 4
- System Requirements .................................................. 4
- Mechanical Specifications ............................................ 5

## Part II  Installation

**Chapter 3. Setting Up D-Control** .................................. 15

- D-Control Stand ...................................................... 15
- Installing D-Control Units ............................................. 22
- Installing a Video Display ............................................. 27
- Mounting D-Control Cables (Optional) ............................ 30
- Reconfiguring the D-Control Keyboard for a Windows System .. 30
- Moving the Keyboard and Trackball (Optional) ..................... 31
- Replacing the Trackball with an External Trackball or Mouse (Optional) .................................. 31

**Chapter 4. Connecting D-Control** .................................. 33

- D-Control Connections ................................................ 33
- Audio Connections ..................................................... 35

**Chapter 5. Configuring D-Control** .................................. 39

- Starting Up and Shutting Down the System ......................... 39
- Software Configuration ................................................. 39
- Setting D-Control Preferences ....................................... 40
- System Calibration ..................................................... 44
## Part III  Reference

### Chapter 6. Channel Strip Controls  ................................................................. 47
   Channel Strips .............................................................................. 47
   Channel Strip Master Section ..................................................... 53

### Chapter 7. Plug-in Controls  ................................................................. 65
   Plug-ins and D-Control ............................................................... 65
   Displaying Dynamics Plug-in Gain Reduction on Channel Meters  68
   Dynamics Section ..................................................................... 69
   EQ Section .............................................................................. 76

### Chapter 8. Transport and Navigation Controls ..................................... 83
   Transport Section ..................................................................... 83
   Zoom/Navigate Section .............................................................. 88
   Bank/Nudge Section .................................................................. 89
   Bank Select Matrix .................................................................... 89

### Chapter 9. Management Sections ...................................................... 91
   Window Management Section .................................................. 91
   Session Management Section ................................................... 92
   Soft Keys Section ..................................................................... 93
   Miscellaneous Controls Section ................................................ 100

### Chapter 10. Monitor and Meter Sections ........................................... 103
   Monitor Section Controls ......................................................... 103
   Control Room Monitoring System ............................................ 104
   Headphone/Cue System ............................................................ 109
   Talkback/Listen System ............................................................. 110
   Meter and Time Code Displays (Main Unit) ................................. 112
   Meter Displays (Fader Module) .................................................. 113
   Setting D-Control Meters for Different Reference Levels .............. 113

### Chapter 11. Operating Modes ............................................................. 115
   Normal Mode ........................................................................... 115
   Inline Console Mode ................................................................. 120
   Custom Fader Modes ............................................................... 120
<table>
<thead>
<tr>
<th>Appendix A. Utility Mode</th>
<th>129</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entering Utility Mode</td>
<td>129</td>
</tr>
<tr>
<td>Navigating Utility Mode</td>
<td>129</td>
</tr>
<tr>
<td>Exiting Utility Mode</td>
<td>130</td>
</tr>
<tr>
<td>D-Control System Info Page</td>
<td>130</td>
</tr>
<tr>
<td>D-Control Name Page</td>
<td>130</td>
</tr>
<tr>
<td>D-Control Test Pages</td>
<td>131</td>
</tr>
<tr>
<td>Resetting D-Control to Factory Defaults</td>
<td>134</td>
</tr>
<tr>
<td>D-Control Preferences</td>
<td>134</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix B. Audio Connections and Pinouts</th>
<th>137</th>
</tr>
</thead>
<tbody>
<tr>
<td>25-Pin Female Connector Pinouts</td>
<td>137</td>
</tr>
<tr>
<td>15-Pin Connector Pinouts</td>
<td>139</td>
</tr>
</tbody>
</table>

| Index                                          | 141 |
Part I: Introduction
Chapter 1: Introduction to D-Control

Welcome to the D-Control™ worksurface for Digidesign ICON systems.

D-Control provides hands-on control of every feature in Pro Tools, and offers powerful options for customizing the Pro Tools mix environment.

D-Control Features

D-Control provides a full set of controls for all Pro Tools recording, editing and mixing tasks, and a versatile remote-controlled audio monitoring system.

Control Features

- Touch-sensitive, motorized Penny and Giles faders
- Touch-sensitive, multi-purpose rotary controls
- Dedicated controls for assignment and activation of inputs, outputs, inserts and sends
- Flexible display of pan, insert, send, plug-in and mic pre controls
- Dedicated EQ and dynamics plug-in control sections
- Dedicated controls for all channel strip functions including recording and input monitoring modes, mute, solo, and channel select
- Dedicated controls for automation mode, enable and safe status
- Flip Mode for transfer of parameters from rotary controls to faders
- Custom Fader Mode for flexible channel and parameter mapping
- Full transport and navigation controls, including location commands and scrub/shuttle capability

Monitoring Features

- 8-channel control room monitoring system supports mono through 7.1 surround monitoring, with up to 6 possible input sources and 3 selectable output paths
- 2-channel cue system with 5 separate outputs and selectable talkback feed
- Built-in talkback microphone and external talkback mic Input
- Standalone mode for monitoring without Pro Tools

D-Control System Components

The following components are included in a D-Control 16-channel or 32-channel system:

Main Unit
- D-Control Main Unit
- AC power cord
- Ethernet cable
- USB cable
- Windows keyboard caps set
- Ethernet loopback plug (for Ethernet testing)

Fader Module
(1 for 16-Channel System, 2 for 32-Channel System)
- D-Control Fader Module unit
- AC power cord
- Ethernet cable

XMON Monitoring System
- XMON Interface
- AC power cord
- XMON cable

D-Control Stand
- Left and right leg assemblies
- Rear crossbar assembly
- Rear pan support rail
- Front pan support rail
- Left and right plastic side caps
- Leg front caps
- Leg rear caps
- Stand hardware
- Video display arm assembly and hardware
System Expansion Options

Fader Modules
Additional 16-channel Fader Modules can be added to D-Control, up to a total of 80 faders (five 16-channel Fader Modules).

Surround Panner Option
The Surround Panner option for D-Control work surfaces provides tactile control for many mixing and panning features to enhance multichannel mixing for surround sound.

For details on D-Control expansion and customization options, visit the Digidesign Web site (www.digidesign.com).

Operational Requirements

Temperature and Ventilation
D-Control should be installed and operated in a climate-controlled environment, away from heat sources, and with adequate ventilation. D-Control should be operated at an ambient temperature that does not exceed 100 degrees F (35 degrees C).

The back panel and the front half of the bottom panel of each unit should be exposed to ambient air. Blocking or partially blocking the back panel or bottom panel of a D-Control unit may cause the unit to malfunction and may void your warranty.

The D-Control stand is designed to provide adequate ventilation for the D-Control units. Installation of D-Control units in other stands or studio furniture is not recommended, and may void your warranty if adequate ventilation is not maintained.

Water and Moisture
D-Control units should be operated away from sources of moisture or humidity and should be kept clear of liquids that might spill into the units.

Cleaning and Maintenance
If you need to clean the D-Control top surface, apply a non-bleach cleaning solution to a cloth or paper towel, then carefully wipe the surface. Do not use abrasives, cleaning solutions with bleach, or spray cleaners.

Connection Requirements

Power Connections
Each D-Control unit (Main Unit and Fader Modules) and the XMON Monitor Interface requires its own power connection. Make sure your power source is correctly rated for the number of units you are connecting. A surge protected power source (not included) is highly recommended.

Ethernet Connections
Each D-Control unit communicates with Pro Tools via Ethernet. A 10-BaseT Ethernet hub (not included) is required to connect D-Control units to the host computer.

USB Connections
The computer keyboard and trackball on the D-Control Main Unit require an available USB connector on the host computer or on a USB hub if your system has one.

Audio Connections
All external analog audio inputs and outputs for control room monitoring and studio communication are connected to the XMON interface. D-Control connects to the XMON interface with a single 15-pin cable (included). All analog inputs and outputs on XMON are DB-25 connectors.

Audio Cables for D-Control Monitoring
Digidesign offers a range of DigiSnake cabling options for connecting Digidesign interfaces and external sources to the XMON monitoring system. For details, visit the Digidesign Web site (www.digidesign.com).

System Requirements
D-Control requires the following system components:
- Pro Tools|HD® system (which includes at least one Pro Tools|HD audio interface)

An expanded HD-series system is required for higher track counts.

For complete system requirements, visit the Digidesign Web site (www.digidesign.com).

Compatibility Information
Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved. For a list of Digidesign-qualified computers, operating systems, and third-party devices, refer to the Digidesign Web site (www.digidesign.com).
Mechanical Specifications

<table>
<thead>
<tr>
<th>D-Control Stand Dimensions (not including video display arm)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Height</td>
<td>39.7 inches (100.9 cm)</td>
</tr>
<tr>
<td>Maximum Width</td>
<td></td>
</tr>
<tr>
<td>Main Unit with 1 Fader Module (16-channel system)</td>
<td>65.3 inches (165.9 cm)</td>
</tr>
<tr>
<td>Main Unit with 2 Fader Modules (32-channel system)</td>
<td>88.5 inches (224.8 cm)</td>
</tr>
<tr>
<td>Maximum Depth</td>
<td>45.7 inches (116.1 cm)</td>
</tr>
</tbody>
</table>

*Figure 1. Stand dimensions for a 16-fader D-Control system*

*Figure 2. Stand dimensions for a 32-fader D-Control system*
Chapter 2: D-Control Overview

D-Control Main Unit

Main Unit Top Panel

Figure 3. D-Control Main Unit top panel
**Meter Display**
The Meter display on the D-Control Main Unit can be set to show the output levels, or levels associated with a track or plug-in. See “Meter and Time Code Displays (Main Unit)” on page 112.

**Time Scale Displays and Location Indicators**
The Time Scale displays and Location indicators mirror the corresponding indicators in Pro Tools. See “Meter and Time Code Displays (Main Unit)” on page 112.

**Display Shelf and Display Arm Housing**
D-Control gives you two options for using a video display: You can place a free-standing display on the display shelf, or you can install a VESA TFT display on the included display arm. See “Installing a Video Display” on page 27.

**Focus Channel Strip**
The Focus Channel Strip on the D-Control Main Unit is used to bring the controls of any channel strip in a session to the center of the control surface, bringing them to the center mix position. See “Channel Strips” on page 47.

**Dynamics and EQ Sections**
The D-Control Main Unit provides dedicated Dynamics and EQ sections for plug-ins that support D-Control Dynamics and EQ plug-in mapping. See “Plug-ins and D-Control” on page 65.

**Monitor Section**
The Monitor section on the D-Control Main Unit includes a full set of controls for the control room monitoring, headphone/cue, and talkback/listenback sections of D-Control. See “Monitor Section Controls” on page 103.

**Zoom/Navigate Section**
The Zoom/Navigate section on the D-Control Main Unit is used to control navigation, display, and selections in the Pro Tools Edit window. See “Zoom/Navigate Section” on page 88.

**Bank/Nudge and Bank Select Sections**
The Bank/Nudge and Bank Select sections on the D-Control Main Unit are used to control the display of Pro Tools tracks on the control surface, in both Normal and Custom Fader modes. See “Bank/Nudge Section” on page 89 and “Bank Select Matrix” on page 89.

**Window Management and Session Management Sections**
The Window Management and Session Management sections on the D-Control Main Unit include controls for opening and closing Pro Tools windows, and managing and saving Pro Tools sessions. See “Window Management Section” on page 91 and “Session Management Section” on page 92.

**Soft Keys Section**
The Soft Keys section on the D-Control Main Unit provides access to a wide range of Pro Tools commands directly from the control surface. It also provides access to preferences and settings specific to D-Control. See “Soft Keys Section” on page 93.

**Miscellaneous Controls**
The Miscellaneous Controls section on the D-Control Main Unit includes controls for basic Pro Tools editing and display functions. See “Miscellaneous Controls Section” on page 100.

**Transport Section**
The Transport section on the D-Control Main Unit includes two complete sets of transport controls, switches for setting the transport mode, scrub/shuttle controls, as well as advanced audition and locate controls. See “Transport Section” on page 83.

**Channel Strip Master Section**
The Channel Strip Master section is a set of controls that appears on both the left and right sides of the D-Control Main Unit, allowing easy access to powerful assignment, display, and channel function controls from any mixing position. See “Channel Strip Master Section” on page 53.

**Custom Fader Controls**
The Custom Fader controls in the D-Control Main Unit invoke a special set of D-Control modes, called *Custom Fader modes*, which let you set aside and customize channel strips for display and editing of a variety of functions. See “Custom Fader Controls” on page 62.

**Talkback Switches**
Two Talkback switches on the Main Unit provide mirrored control of the D-Control Talkback function. See “Talkback Switch” on page 63.

**Automation Mode Controls**
The Automation Mode controls mirror the function of the on-screen Automation Mode selector for each track. See “Automation Mode Controls” on page 63.
**Main Unit Back Panel**

**Figure 4. D-Control Main Unit back panel connectors**

**AC Power**
The AC Power connector accepts a standard AC power cable. The D-Control Main Unit is auto power-selecting (100V to 240V) and automatically works with a standard modular power cord when connected to an AC receptacle in any country.

**Power Switch**
The Power switch applies power to the D-Control Main Unit.

**Footswitch Jack**
The footswitch jack on the back panel of the D-Control Main Unit is a 1/4-inch TRS jack that supports two footswitch connections. See “Footswitch Connections” on page 34.

**Keyboard/Trackball USB Connector**
The USB connector on the back panel of the D-Control Main Unit links the computer keyboard and trackball on the Main Unit to the Pro Tools system. See “USB Connections” on page 34.

**Ethernet Connector**
The Ethernet connector on the back panel of the D-Control Main Unit provides communication to Pro Tools. See “Ethernet Connections” on page 33.

**XMON Monitoring System Connector**
The 15-pin connector on the back panel of the D-Control Main Unit provides remote control of all audio monitoring functions from the D-Control Monitoring section. See “XMON Monitoring System Connection” on page 35.
Meter Section
The Meter section on the D-Control Fader Module can display track levels, plug-in meters, and other parameters depending on D-Control metering preferences. See “Meter Displays (Fader Module)” on page 113.

Channel Strip
Each channel strip on the D-Control Fader Module has identical channel controls, including six touch-sensitive rotary encoders, display and mode controls, and a touch-sensitive fader. See “Channel Strips” on page 47.

Modifier Keys
Each D-Control Fader Module has a set of four switches in its lower left corner that duplicate the function of the Pro Tools computer keyboard modifiers. See “Modifier Key Switches” on page 52.

Fader Module Back Panel

AC Power
The AC Power connector accepts a standard AC power cable. The D-Control Fader Module is auto power-selecting (100V to 240V) and automatically works with a standard modular power cord when connected to an AC receptacle in any country.

Power Switch
The Power switch applies power to the Fader Module.

Ethernet Connector
The Ethernet connector on the back panel of the D-Control Fader Module provides communication to Pro Tools. See “Ethernet Connections” on page 33.
D-Control XMON Interface

D-Control monitoring is based on the XMON analog interface, which is remotely controlled from the D-Control monitoring section.

XMON Front Panel

![XMON Front Panel Diagram]

- **Power Switch**
The Power switch applies power to the XMON Interface.

- **Mute Indicator**
The Mute indicator shows the mute status of XMON.

- **MIDI Receive Indicator**
The MIDI Receive indicator shows MIDI activity between XMON and D-Control.

- **Mute Button**
The Mute button mutes all XMON outputs. It is not possible to unmute XMON with this button. The XMON mute state can only be cleared from the D-Control Monitor section (see “Monitor Section Controls” on page 103).
XMON Back Panel

The back panel of the XMON interface includes connectors for all external analog audio inputs and outputs for D-Control. See “Audio Connections” on page 35.

Figure 7. XMON back panel
Part II: Installation
Chapter 3: Setting Up D-Control

This chapter explains how to set up 16-fader (Main Unit plus one Fader Module) and 32-fader D-Control systems (Main Unit plus two Fader Modules).

D-Control Stand
(16-Fader and 32-Fader Systems)

Figure 1. Assembled D-Control stand

The stand configurations for 16-fader and 32-fader systems have similar assembly procedures and the same number of parts (the crossbar and support rails are longer for a 32-fader system).
Stand Components

Unpack the stand and confirm that you have all of the necessary parts. Figure 2 shows the metal parts of the stand. Figure 3 shows the plastics parts of the stand. Set the plastic parts aside to protect them from damage during initial assembly.

Figure 2. D-Control metal stand parts

Figure 3. D-Control plastic stand parts
Stand Hardware

The following hardware is provided with the D-Control stand (spare pieces may be included).

Hardware for Metal Stand Parts
- (14) 1/4-inch-20 x 1/2-inch button head cap screws
- (10) 1/4-inch-20 x 1/2-inch socket head cap screws
- (22) M6 x 8mm Phillips pan head screws
- (8) 1/2-inch-20 x 1-inch socket head cap screws for leveling the stand (not pictured)
- (3) 1/2-inch roll pins

Hardware for Plastic Stand Parts
- (3) #10-32 x 1/2-inch socket head cap screws
- (4) #10-32 x 3/4-inch socket head cap screws
- (26) #10-32 x 1-inch socket head cap screws
- (8) #10 x 3/4-inch Phillips pan head screws
- (3) #6-32 x 7/16-inch Phillips pan head machine screws

Cabling Accessories
- (14) cable tie mounts
- (8) screw mount cable ties
- (14) cable ties
- (4) Velcro rip ties
- (10) #8 x 1/2-inch self-tapping screws (for use with rip ties and screw mount cable ties)

Tools for Assembling the Stand

The following tools are included with D-Control:
- 5/32-inch hex driver (for button head cap screws)
- 3/16-inch hex driver (for socket head cap screws)
- 3/8-inch hex driver (for stand leveling screws)

The following additional tools are required to assemble the D-Control stand:
- #2 Phillips screwdriver (for large Phillips head screws)
- #1 Phillips screwdriver (for small Phillips head screws)
- small hammer (for 1/2-inch roll pins)

The following tools are optional, but will help with assembly:
- rubber mallet for adjusting the stand
- ratcheting nylon strap for closing up the stand
**Placement of D-Control**

In planning the placement of your D-Control, make sure to account for the dimensions of the assembled system, allowing for at least 1 inch (2.5 cm) of open space behind the finished unit. This meets the ventilation requirements for the D-Control units.

For detailed dimensional information, see “Mechanical Specifications” on page 5.

When assembling the unit, you will need additional clearance on either side of the unit to push the sides of the stand together in the final steps of assembly. You will also need access to the rear of the unit to make cable connections.

**Preparing the Stand Legs**

Before assembling the D-Control stand, make sure the floor in the installation space is level and the areas directly under the legs are flat.

Each stand leg has three holes for leveling screws in its base, which can be used to fine-tune the leveling of the unit.

If you are placing the unit on a cement or hardwood floor, you can apply adhesive-backed rubber pads (included) to the bottoms of the legs to protect the floor and help level the stand. If you are using the leveling screws, you can place rubber pads directly under the screws to further protect the floor.

**Figure 5. Location of leveling screws**

**Figure 6. Applying rubber pads to bottom of D-Control leg**
Assembling the Stand

After you have prepared the installation space for D-Control, begin by assembling the metal parts of the stand.

⚠️ It is important that you first build the stand slightly wider than its final dimensions, and leave all screws loose enough to allow the stand legs to move side-to-side relative to the rear crossbar and rails. After you install the D-Control units on the stand, you will then slide the leg assemblies inward and tighten all screws.

To assemble the stand:

1. Place the right and left leg assemblies upright, and at the approximate width of the rear crossbar assembly. Position the legs so that their crossbar mounting brackets are on the insides of the legs, facing each other as in Figure 7.

2. Lift the rear crossbar assembly into position and slide it onto the crossbar mounting bracket on each leg. (The two sides of the crossbar are identical, so it does not matter which side faces front.) Position the legs so there is a small gap between the sides of the crossbar and the inner surface of each leg. The screw holes in the brackets should be visible in the slots on the crossbar.

![Figure 7. D-Control stand legs positioned with crossbar brackets facing each other](image)

![Figure 8. Placing the rear crossbar assembly on the mounting bracket (left); Detail of gap between crossbar and leg (right)](image)
3 Using a 5/32-inch hex wrench, attach the crossbar to the brackets with 1/4-inch-20 x 1/2-inch button head cap screws (see Figure 9), using 6 screws on each side (3 in front and 3 in back). Make sure to leave the screws loose enough so that the legs can be moved side-to-side relative to the rear crossbar.

4 Locate the rear pan support rail, which is the larger of the two rails provided with the stand.

5 Position the rear rail so that the edge with the V-shaped notch points toward the left stand leg.

6 Lift the rear rail into place so that the rail rests on the rear rail tabs of the stand legs (see Figure 12). The holes on the ends of the rail should line up with the slots in the rear rail tabs on each leg.
7 Using a 3/16-inch hex wrench, attach the rear rail to the rail tabs on each leg from below with 1/4-inch-20 x 1/2 inch socket head cap screws (see Figure 13), using 2 screws in each side. Make sure to leave the screws loose enough so that the leg assemblies can be moved side-to-side relative to the rear rail.

8 Locate the front pan support rail, which is the smaller of the two rails provided with the stand.

9 Position the front rail so that the edge with the V-shaped notch points toward the left stand leg.

10 Lift the front rail into place so that the rail rests on the front rail tabs of the stand legs. The holes on the ends of the rail should line up with the slots in the front rail tabs on each leg.

11 Using a 3/16-inch hex wrench, attach the front rail to the rail tabs on each leg from below with 1/4-inch-20 x 1/2 inch socket head cap screws, using 2 screws in each side. Make sure to leave the screws loose enough so that the leg assemblies can be moved side-to-side relative to the front rail.

With the rear crossbar, rear support rail and front support rail in place (see Figure 15), you are now ready to install the D-Control units on the stand.
Installing D-Control Units

After the stand has been assembled, the next step is preparing the D-Control Main Unit and Fader Modules for installation.

Attaching the Spacer Plate

A metal spacer plate goes between each D-Control unit on the D-Control stand.

![Figure 16. D-Control spacer plate (removed from a Fader Module)](image)

A spacer plate is pre-installed on the right side of each Fader Module. Depending on the size and configuration of your D-Control system, you may need to move the plate from one of the Fader Modules to the Main Unit. Refer to the section below for your system configuration.

16-Fader System

If you are building a 16-fader D-Control, you can place the Main Unit either to the left or to the right of the Fader Module.

- If you are placing the Main Unit to the left of the Fader Module, you need to move the spacer plate from the Fader Module to the Main Unit. Refer to “Moving the Spacer Plate” on page 23 before installing the units on the stand.
- If you are placing the Main Unit to the right of the Fader Module, you can use the spacer plate as pre-installed on the Fader Module. Proceed to “Installing the Units on the Stand” on page 24.

![Figure 17. 16-channel configurations](image)

32-Fader System

If you are building a 32-fader D-Control, you can place the Main Unit to the left, to the right, or in between the two Fader Modules.

- If you are placing the Main Unit to the left or in between the two Fader Modules, you need to move the spacer plate from the far-right Fader Module to the Main Unit. Refer to “Moving the Spacer Plate” on page 23 before installing the units on the stand.
- If you are placing the Main Unit to the right of the two Fader Modules, you can use the spacer plates as pre-installed on the Fader Modules. Proceed to “Installing the Units on the Stand” on page 24.

![Figure 18. 32-channel configurations](image)
Moving the Spacer Plate

When installing any Fader Modules on the right of the Main Unit, you will need to remove the spacer plate and its screws from the far right Fader Module and place them on the right side of the Main Unit.

⚠ Do not use a power screwdriver or similar high-torque device to remove and replace the screws for the spacer plate, as it might strip the threads in the screw housing.

To move the spacer plate:

1. Remove the screws holding the spacer plate in place. Make sure to note the location of the longer screws (2 in the front and 5 in the back) as you remove them.

2. Remove the spacer plate from the right side of the Fader Module.

3. Remove the corresponding screws from the right side of the Main Unit, and save them for the Fader Module.

4. Position the spacer plate on the right side of the Main Unit, and attach it in place with the screws that originally held it on the Fader Module. Make sure to note the location of the longer screws.

5. Place the remaining screws in the side of the Fader Module. Make sure to note the location of the longer screws.

⚠ The holes on the spacer plate are countersunk for installation on the right side of a unit. Do not attach the spacer plate to the left side of any D-Control unit.

Leveling the Pins on the Rightmost Unit

Fader Modules and Producer’s Desks ship with two pins in their right side to help anchor the units together on the stand. (These pins are not needed on the rightmost unit in your configuration, and can be removed.)

To level the roll pins on the rightmost unit:

1. Identify the unit that will occupy the rightmost position in your configuration.

2. Use a small hammer to tap in the two pins the right side until they are flush with the side of the unit. (There is no stop inside the pin rails, so you will be able to install new pins if you expand your system later.)
Installing the Units on the Stand

After the D-Control Main Unit and Fader Modules are prepared for installation, the units are placed on the stand in the appropriate order for your configuration. Install the units from left to right on the stand.

To install the D-Control units on the stand:

1. Lift the first unit into place on the stand so the channels in the bottom of the unit go over the rear and front rails of the stand.

2. Slide the unit to the left side of the stand, leaving a gap of about an inch (2 cm) between the side of the unit and the flange on the inside of the stand.

3. Lift successive units into place on the stand, being careful not to bend the pins in the units you installed previously.

4. Slide the units together, guiding the pins in each unit into the corresponding holes in the side of the next unit.

5. Attach the units to the front and rear rails from below with M6 x 8mm Phillips pan head screws, using a total of 6 screws for the Main Unit (3 each in the front and rear rails) and a total of 4 screws for the Fader Module (2 each in the front and rear rails). Make sure to leave these screws loose enough so that the units can still move side-to-side relative to the rails.

Figure 23. Placing a Fader Module on the stand

Figure 24. Leaving a gap between the unit and stand

Figure 25. Attaching a unit to the rails from below
Closing Up the Stand

Next, you will close up the stand and finish attaching the units.

To close up the stand:

1. Move the stand legs together to completely close the gap between the stand and the outer units. (You may want to tap the base of the legs with a rubber mallet to help move them into place.)

2. Use a ratcheting nylon strap to compress the stand legs together.

3. If there is still any gap between the rear crossbar assembly and either of the legs, position the crossbar so that the gap is equal on both sides.

4. Tighten the 6 button cap screws on each side of the rear crossbar.

5. If necessary, use the ratcheting nylon strap to compress the D-Control units together by running the strap around the top part of the legs and across the D-Control units as shown in Figure 27. Make sure the nylon strap does not contact any switches or encoders on the surface.

6. Tighten the 2 socket head cap screws on each side of the front and rear rails from below.

7. Attach the outside (rightmost and leftmost) units to the flanges on the legs from below with M6 x 8mm Phillips pan head screws. Tighten these screws.

8. Tighten the Phillips pan head screws that attach the D-Control units to the front and rear rails from below.

9. Remove the nylon strap.
Installing the Plastic Side Caps

With the D-Control units in place and attached to the stand rails, you are now ready to install the plastic side caps.

⚠️ Do not use a power screwdriver or similar high-torque device to attach the plastic side caps, as it may distort or damage the caps.

To install the plastic side caps:

1. On each side of the system, locate the pair of #6-32 machine screws, arranged one above the other, near the front of each unit. Remove the lower of the two screws from each side of the unit.

2. Locate the two small blue rubber meter break caps and install them in the inside of the plastic side caps.

3. Place the plastic side caps over each side of the unit, starting by hooking the front of each cap around the front part of the stand leg, then sliding the cap backward into place. The holes on the cap should line up with holes on the stand.

4. Attach each plastic side cap with the screws indicated in Figure 32. Leave the screws loose until you have placed all of the screws, then go back and tighten all of the screws carefully.

![Figure 29. Removing the machine screw from a unit](image)

![Figure 30. Installing a meter break cap in a plastic side cap](image)

![Figure 31. Placing a plastic side cap on the stand](image)

![Figure 32. Attaching the plastic side caps](image)

- (6) #10-32 x 1-inch socket head cap screws
- (1) #6-32 x 7/16-inch Phillips pan head machine screw
- (3) #10 x 3/4-inch Phillips pan head screws

*Note: Use caution when handling the machine screws to avoid damaging the caps.*
Installing the Plastic Leg Caps

You can install the D-Control plastic leg caps at any time.

To protect the plastic leg caps from damage, install them last, after you have finished installing and configuring any other D-Control components and moved the system into place. If necessary, continue with other installations and return to these steps when you are finished.

1 Place the front leg caps over each leg. Attach each front cap with the screws indicated in Figure 34.

2 Place the rear leg caps over each leg. Attach each rear cap with the screws indicated in Figure 35.

Installing a Video Display

D-Control gives you two options for using a video display:

Free-Standing Display The display shelf on D-Control can support a free-standing flat screen display.

Arm-Mounted TFT Display Using the video display arm included with the Main Unit, you can mount a TFT-type display on D-Control.

General instructions for installing each display are given in the following sections. For details on setting up a particular display, refer to the manufacturer’s instructions.

Installing a Free-Standing Display

The display shelf on the D-Control Main Unit can support a free-standing flat screen display (such as an Apple Cinema display) up to a 20-inch screen size. (Larger displays may obstruct the view of the meter bridge on the Main Unit.)

To install a free-standing display:

1 Remove the display shelf panel from the Main Unit.
2 Replace the mounting post housing on the underside of the display shelf panel with the provided cover plate.

3 Run the display cabling through the cable port in the display shelf panel.

4 Route the display cabling down through the Main Unit and through the cable port in the bottom of the Main Unit. (You may need to remove a panel covering this cable port.)

5 Replace the display shelf panel on the Main Unit.

6 Place the display on the display shelf.

---

**Installing an Arm-Mounted TFT Display**

The articulated video display arm included with the D-Control Main Unit can support a VESA-style display that weighs up to 20 pounds (9 kg).

> The video display arm is packaged separately and includes hardware that is not needed for D-Control. The arm-mounting hardware is pre-installed in the bottom of the Main Unit.

**To install an arm-mounted TFT display:**

1 Mount the video display on the display arm assembly according to the manufacturer’s instructions.

2 Discard the mounting post included with the monitor arm assembly. A correctly sized replacement post is included with the D-Control Main Unit.

3 Install the new mounting post in the Main Unit. Note the orientation of the post (the side with the longer slot faces the back of the unit).

4 Run the display cabling through the cable port behind the mounting post housing (you may need to remove the display shelf to route any connectors through the port).

5 Route the display cabling down through the Main Unit and through the cable port in the bottom of the Main Unit. (You may need to remove a panel covering this cable port. See Figure 38.)

6 Place the display arm collar over the mounting post assembly. Do not tighten the set screw for the collar.
7 Place the display arm assembly on the mounting post assembly.

8 Adjust the display arm collar so that its stops prevent the arm assembly and video display from hitting the D-Control meter bridge. In most cases, the setscrew should not go into the hole in the mounting post assembly, but should be slightly to the right of the hole and the cable port as shown in Figure 41.

9 Tighten the setscrew to fix the collar in place.

10 Insert the top cap/threaded rod in the mounting post assembly and tighten it with the provided wrench.

Figure 40. Placing the arm assembly on the mounting post

Figure 41. Detail of display arm collar and setscrew

Figure 42. Attaching the arm assembly with the top cap/threaded rod

Figure 43. Installed arm mount assembly and video display
Mounting D-Control Cables (Optional)

Three different kinds of cable ties are provided with D-Control.

**Velcro Rip Ties** These ties can be affixed to the D-Control stand legs. Two pre-drilled holes inside each leg accept #8 x 1/2-inch self-tapping screws.

**Screw-mount Ties** These ties can be affixed to the D-Control stand legs with the #8 x 1/2-inch self-tapping screws.

**Adhesive-backed Ties** These self-sticking tie mounts let you place cable ties anywhere on the D-Control unit, and can be used to dress cables or to mount an Ethernet hub under the unit.

---

Reconfiguring the D-Control Keyboard for a Windows System

The computer keyboard on the D-Control Main Unit ships with a Mac keyboard configuration.

If you will be using D-Control with a Windows-based Pro Tools system, you will need to reconfigure the computer keyboard.

**To reconfigure the D-Control computer keyboard for Windows:**

1. Using a 5/64-inch hex wrench, remove the screws in the computer keyboard panel and detach it from the D-Control Main Unit.

2. Locate the switch on the printed circuit board under the keyboard and move it to the opposite position.

3. Remove the two Apple Command (⌘) keys from either side of the Spacebar on the alpha keyboard.

4. Move the Alt/Option keys inward to replace the Apple Command keys.

5. Install the included Start (or “Windows”) keys to replace the Alt/Option keys.

6. Remove the Equals (=) key, also called “Capture” key, from the numeric keypad.

7. Move the Slash (/) key, also called the “Enter Start End Length” key, to replace the Equals key.

8. Move the Asterisk (*) key, also called the Enter Main Counter key, to replace the Slash key.

9. Move the Minus (–) key to replace the Asterisk key.

10. Remove the Plus (+) key and install the included double-sized plus key to replace the old Plus and Minus keys.

11. Replace the computer keyboard panel on the D-Control Main Unit and reattach its screws.
Moving the Keyboard and Trackball (Optional)

You can move the trackball on the D-Control Main Unit to the left of the computer keyboard.

To move the keyboard and trackball:

1. Using a 5/64-inch hex wrench, remove the screws in the computer keyboard panel and the trackball panel on the D-Control Main Unit.
2. Exchange the position of the trackball and keyboard panels, and carefully rearrange their cables underneath the panels.
3. Reattach the computer keyboard and trackball panels to the Main Unit.

Replacing the Trackball with an External Trackball or Mouse (Optional)

If you prefer to work with your own trackball or mouse, you can remove the D-Control trackball from the D-Control Main Unit and replace it with the provided blank plate, and place your USB-compatible trackball or mouse on top of the plate.

To remove the trackball:

1. Using a 5/64-inch hex wrench, remove the screws in the trackball panel on the D-Control Main Unit.
2. Remove the Molex connector that attaches the trackball to the printed circuit board.
3. Remove the other end of the Molex connector from the P1 connector on the printed circuit board.
4. Remove the screws holding the printed circuit board to the trackball plate. Set the original plate aside.
5. Locate the blank trackball plate and install the printed circuit board on underside of the plate.
6. Locate the USB connector on the printed circuit board, and connect your trackball or mouse to it.
7. Connect the Molex cable you removed in Step 3 to the P2 connector on the printed circuit board. Fit the connector and plug together to maintain polarity of this connection. Make sure the red wire on the end of the cable is directly under the “V” mark on the P2 silk-screen.
8. Route the cable of your trackball or mouse through the slot in the blank plate.
9. Attach the blank plate to the Main Unit.
Chapter 4: Connecting D-Control

D-Control Connections

D-Control units require power, Ethernet and USB connections to operate with Pro Tools. An optional footswitch connection is also available on the Main Unit. The connectors on the back panel of the D-Control Main Unit are shown in Figure 48.

Be sure to make all connections with your D-Control units and computer turned off.

![D-Control Main Unit back panel connectors]

**Power Connections**

Each D-Control unit (Main Unit and Fader Modules) and the XMON Monitor Interface requires its own power connection. D-Control Main Units, Fader Modules, and XMON Interfaces are auto power-selecting (100V to 240V) and automatically work with a standard modular power cord when connected to an AC receptacle in any country. A power cable is provided with each D-Control unit and the XMON interface.

**To make D-Control power connections:**

- For each D-Control unit and the XMON Interface, connect the included AC power cord the unit and to a power source.

**Ethernet Connections**

Each D-Control unit communicates with Pro Tools via Ethernet. An Ethernet cable is included with each D-Control unit. A 10-BaseT Ethernet hub (not included) is required to connect D-Control units to the host computer.

**To make D-Control Ethernet connections:**

1. Install the Ethernet hub according to its instructions, apply power to it, and verify that it is functioning properly.
2. Connect the Ethernet hub to the Ethernet port on your computer.
3. For each D-Control unit, connect one end of the supplied Ethernet cable to a port on the Ethernet hub, and the other end to the Ethernet port on the back of the unit. Do not use any port labelled for LAN connections.

*Connection sequence to the Ethernet hub does not matter, because the order of the units can be configured from within Pro Tools.*
Using D-Control on an Ethernet Network

You can purchase a combined 10/100-BaseT Ethernet hub that can simultaneously support D-Control over 10-BaseT and other network traffic over 100-BaseT. This will allow you to use D-Control over a local area network.

Moderate network traffic (such as e-mail) should not affect communication between D-Control and the computer. If your network experiences heavy traffic, you may want to create a dedicated Ethernet network for D-Control.

Controlling Pro Tools Systems Over a Network

When D-Control is connected to an Ethernet network, it will be available to be declared by any Pro Tools system on that network. This lets you control different Pro Tools systems on the network with a single D-Control console. (You can only control one Pro Tools system at a time.)

USB Connections

The computer keyboard and trackball on the D-Control Main Unit use a USB connection to communicate with the host computer. A USB cable is required (not included).

The D-Control USB connection supports the use of a USB hub, if your system has one. A powered USB hub is not required.

To make the D-Control USB connection:

- Connect one end of a USB cable to the USB port on the back panel of the D-Control Main Unit, and the other end to the USB port on the computer or USB hub.

Footswitch Connections

You can connect two SPST (single-pole, single-throw) footswitch units to the D-Control Main Unit to control any of the following functions:

- Starting and stopping Pro Tools playback
- Starting Pro Tools recording
- Toggling Talkback on and off

The footswitch connector is a single 1/4-inch TRS jack on the back panel of the D-Control Main Unit.

To wire a TRS connector for the D-Control footswitch jack:

- Use the following wiring convention: Tip = Footswitch 2, Ring = Footswitch 1, Sleeve = Ground.
Audio Connections

D-Control monitoring is based on the XMON analog interface, which is remotely controlled from the D-Control monitoring section. All external analog audio inputs and outputs for control room monitoring and studio communication are connected to the XMON interface.

XMON provides 18V phantom for its three external mic inputs (External Talkback Mic, Listen Mic 1, Listen Mic 2).

All audio connections are made with standard DB-25 connectors. The back panel of the XMON is shown in Figure 49.

**XMON Monitoring System Connection**

D-Control connects to XMON with a single 15-pin cable. A 50-foot (15.25 m) cable is included with the D-Control Main Unit. The system supports up to an 80-foot (24.5 m) cable.

**To connect the XMON to D-Control:**

1. Connect the included AC power cord to the back panel of the XMON and to a power source. A surge protected power source is highly recommended.

2. Connect one end of the included XMON cable to the XMON unit, and the other end to the 15-pin Control port on the back panel of the D-Control Main Unit.
Control Room Monitoring Connections

**Inputs**
- Main Inputs (8 channels), balanced, +4 dBu (from Pro Tools)
- Surround Inputs (8 channels), balanced, +4 dBu
- Stereo 1 Inputs (2 channels), balanced, +4 dBu/–10dBV
- Stereo 2 Inputs (2 channels), balanced, +4 dBu/–10dBV
- Stereo 3 Inputs (2 channels), balanced, +4 dBu/–10dBV
- Stereo 4 Inputs (2 channels), balanced, +4 dBu/–10dBV
- AFL/PFL Inputs (2 channels), balanced, +4 dBu
- Listen Mic 1 (external), mic level (XMON provides 18V phantom power)
- Listen Mic 2 (external), mic level (XMON provides 18V phantom power)

**Outputs**
- Main Control Room Outputs (8 channels), balanced or unbalanced, +4 dBu
- Alt Control Room Outputs (8 channels), balanced or unbalanced, +4 dBu
- Mini Control Room Outputs (2 channels), balanced or unbalanced, +4 dBu
Headphone/Cue System Connections

Figure 51. Headphone/Cue system block diagram

**Inputs**
- Main Monitor Input (2 channels)
- Cue 1 Input (2 channels), balanced, +4 dBu
- Cue 2 Input (2 channels), balanced, +4 dBu
- Cue 3 Input (2 channels), balanced, +4 dBu
- Internal Talkback Mic (from internal mic)
- External Talkback Mic, mic level (XMON provides 18V phantom power)

**Outputs**
- Cue 1 (2 channels), +4 dBu
- Cue 2 (2 channels), +4 dBu
- Cue 3 (2 channels), +4 dBu
- Headphone (2 channels), to internal headphone jack
- Studio Loudspeaker (2 channels)
- Talkback/Slate Output (1 channel)
Chapter 5: Configuring D-Control

Starting Up and Shutting Down the System

Your D-Control-based system must be started up and shut down in a specific order.

Start your D-Control-based system in this order:
1. Turn on external hard drives first. Wait 10 to 15 seconds for them to come up to speed.
2. Turn on the D-Control units.
3. If you plan to work with MIDI equipment, turn on MIDI interfaces and other MIDI devices.
4. Turn on all Pro Tools audio interfaces.
5. Turn on the computer.
6. Turn on the XMON interface.
7. Turn on monitor amplifiers or self-powered speakers.

Shut down your D-Control-based system in this order:
1. Turn off monitor amplifiers or self-powered speakers.
2. Turn off the XMON interface.
3. Turn off all Pro Tools audio interfaces.
4. Shut down the computer.
5. If using MIDI equipment, turn off MIDI interfaces or controllers.
6. Turn off the D-Control units.
7. Turn off external hard drives.

Software Configuration

All D-Control software is included when Pro Tools software is installed. The Pro Tools software installer places the D-Control Personality folder on the system drive.

Refer to the Getting Started Guide that came with your system for instructions on installing or updating Pro Tools software.

Updating System Firmware

Each release of Pro Tools software includes the most current D-Control firmware. When you declare a D-Control unit in the Pro Tools Peripherals dialog, Pro Tools compares the firmware of all connected units to the version available in Pro Tools software, and prompts you if an update is available.

If you are prompted to update firmware, follow the on-screen instructions to load the latest firmware to each D-Control unit.

Declaring D-Control Units in Pro Tools

Communication between D-Control and Pro Tools is configured from Pro Tools.

To declare D-Control units in Pro Tools:
1. Choose Setups > Peripherals, and click Ethernet Controllers.

   Ethernet Controllers display in the Peripherals dialog

   2. Select Enable. Pro Tools scans the Ethernet connection for any ProControl units connected to the system.

   3. Select the units in order as you want them arranged left to right.

   It is not necessary to declare units in the same sequence as they are physically arranged in the D-Control stand. You can set a Pro Tools system to use D-Control units in any order, to fit your workflow.
As each unit is selected, Pro Tools scans and brings it online. The current status of each unit is indicated in the Peripherals dialog in the following ways:

- Bold indicates a connected unit.
- Italics indicate an offline or disconnected unit.
- Underlining indicates that the selected unit is in use by another Pro Tools system.

After enabling all units, click OK to close the Peripherals window.

When communication is established, Pro Tools displays colored outlines identifying each bank of Pro Tools tracks.

The colors in each unit row are used to identify controller focus on-screen in Pro Tools. The bank, track, insert, send, or other element currently the focus of D-Control is outlined in the color associated with each unit.

Naming D-Control Units in Pro Tools

You can set the names for D-Control units from Pro Tools.

To name D-Control units in Pro Tools:

1. Choose Setup > Peripherals, and click Ethernet Controllers.
2. Click Name Units.
3. Enter the names for the units and click OK.

You can also set the names for D-Control Main Units and Fader Modules directly from the units themselves, by using Utility mode. For details on naming D-Control units in Utility mode, see “D-Control Name Page” on page 130.

Fader, Encoder and Switch Preferences

The following settings and preferences affect operation of the faders, encoders, and switches on D-Control.

Fader Bank Justification

The Bank Justification preference determines whether banks of channels in Normal mode are justified at the left, left center (to the left of the Main Unit), right center, (to the right of the Main Unit) or right side of the control surface.

To set bank justification:

1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes Bank Justification (“BnkJus”).
2. Press the Soft Key that corresponds to “BnkJus” to choose between the “Left,” “CenterL,” “CenterR,” and “Right” settings.
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.

Faders On/Off

The Faders On/Off preference lets you temporarily turn off D-Control faders to prevent fader movement when monitoring a mix.

To toggle D-Control faders on and off:

1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Faders On/Off preference (“Faders”).
2. Press the Soft Key that corresponds to “Faders” to toggle all faders on and off.
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.

Touch Value

The Touch Value preference determines whether faders and encoders, when touched, temporarily show the value of the parameter they are controlling.

To toggle display of values on or off:

1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes Touch Value (“TchVal”).
2. Press the Soft Key that corresponds to “TchVal” to toggle value display On and Off.
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.

Setting D-Control Preferences

This section describes the settings and preferences for D-Control that are set directly from the control surface. For details on preferences that are set from Pro Tools, see the Pro Tools Reference Guide.
Rotary Encoder Velocity Mode

The Rotary Encoder Velocity mode affects responsiveness of rotary encoder knobs. Fixed mode is at normal resolution. In Velocity Sensitive mode, acceleration can be set to slow, medium or fast. In Fine mode, response is fixed at fine resolution.

To set the Rotary Encoder Velocity mode:
1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Rotary Encoder Velocity Mode preference (“Rotary”).
2. Press the Soft Key that corresponds to “Rotary” to choose between the “Fixed,” “Vel-Sl” (velocity-sensitive slow) “Vel-Md” (velocity-sensitive medium) “Vel-Fa” (velocity-sensitive fast) and “Fine” settings.
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.

Pan on Lower Encoder

The Pan on Lower Encoder preference determines whether Pan controls are displayed on the bottom encoder of each channel, even when another type of controls is displayed on the upper encoders.

To set the Pan on Lower Encoder preference:
1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Pan on Lower Encoder preference (“PanBot”).
2. Press the Soft Key that corresponds to “PanBot” to toggle the setting between “Yes” and “No.”
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.

Encoder Order

The Encoder Order preference determines whether inserts, sends, and pan controls will be displayed in order from top-to-bottom or bottom-to-top on D-Control rotary encoders.

To set the Encoder Order preference:
1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Encoder Order preference (“Encod”).
2. Press the Soft Key that corresponds to “Encod” to toggle the setting between “Bot-Tp” (bottom-to-top ordering) and “Tp-Bot” (top-to-bottom ordering).
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.

Select Switch Latch Mode

The Select Switch Latch mode determines whether channel Select switches follow latching or exclusive-or (non-latching) behavior when in Select mode.

To set the Select switch mode:
1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Select Switch Latch mode preference (“Select”).
2. Press the Soft Key that corresponds to “Select” to toggle the setting between the “Latch” and “ExclOr” (unlatched) settings.
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.

Custom Fader Preferences

The following settings and preferences affect display of Custom Faders on D-Control.

Maximum Custom Fader Bank Size

The Maximum Custom Fader Bank Size preference determines the number of channels to be used when displaying tracks in the Left or Right Custom Fader bank. Options are multiples of 8 channels, from zero (no Custom Fader Bank) up to the total number of channels on the D-Control system.

To set the maximum Custom Fader bank size:
1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Custom Fader Bank Size preferences (“LMax CF” or “RMax CF”):
   - **Left Maximum Custom Fader Bank Size** Determines the number of channels to be used when displaying channels in the Left Custom Fader Bank.
   - **Right Maximum Custom Fader Bank Size** Determines the number of channels to be used when displaying channels in the Right Custom Fader Bank.
2. Do one of the following:
   - To increment the number of channel strips, press the Soft Key that corresponds to “LMax CF” or “RMax CF.”
   - or –
   - To decrement the number of channel strips, hold Shift and press the Soft Key that corresponds to “LMax CF” or “RMax CF.”
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.
**Custom Fader Bank Justification**

The Custom Fader Bank Justification preference determines the distribution of the two available Custom Fader banks on the control surface.

**Left Custom Fader Justification** Determines whether the Custom Faders controlled by the left Custom Faders section are placed at the left, left center, right center, or right of the Main Unit.

**Right Custom Fader Justification** Determines whether the Custom Faders controlled by the right Custom Faders section are placed at the left, left center, right center, or right of the Main Unit.

**To set Custom Fader bank justification:**

1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes Custom Fader Tracks (“CFTrks”).
2. repeatedly to display the page that includes the Custom Fader Bank Justification preferences (“LCFJst” or “RCFJst”):
3. For each bank of Custom Faders, choose between the “Left,” “CenterL,” “CenterR,” and “Right” settings.
4. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.

**Display Preferences**

The following preferences affect the interaction of D-Control with on-screen display of elements in Pro Tools.

**Target Track from Application**

The Target Track from Application preference determines whether selecting an Insert or Send on-screen makes its track the focused track on the D-Control Main Unit. For details on focusing a track on D-Control, see “Focusing a Track” on page 117.

**To set the Target Track from Application preference:**

1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Application Target preference (“APTrgt”).
2. Press the Soft Key that corresponds to “ApTrgt” to toggle the setting between “Yes” and “No.”
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.

**Channel Window Display**

The Channel Window display preference determines whether displaying plug-in or send pan parameters (by pressing an encoder Select switch) on D-Control opens the corresponding plug-in or send window on-screen in Pro Tools. This preference also determines whether the Channel Select switches (in the Dynamics or EQ sections) change the channel display of multi-mono plug-ins.

- When this preference is set to “Yes,” the on-screen display of plug-in and send windows changes to reflect the state of the control surface.
- When this preference is set to “No,” the on-screen display of plug-in and send windows does not change to reflect the state of the control surface.

**To set the Channel Window display preference:**

1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Channel Window display preference (“ChanWn”).
2. Press the Soft Key that corresponds to “ChanWn” to toggle this setting between “Yes” and “No.”
3. Hold Control (Windows) or Command (Mac) and press the Operation switch to exit.
**Meter Preferences**

The following preferences affect operation of the meters on D-Control.

**Send Meters On/Off**

The Send Meters On/Off preference toggles send metering on and off. This preference applies when sends are displayed on the D-Control rotary encoders. This metering follows Send pre- or post-metering settings in Pro Tools.

To toggle send meters on and off:

1. In the Soft Keys section, press the Meter switch repeatedly to display the page that includes the Send Meters On/Off preference (“SndMtr”).
2. Press the Soft Key that corresponds to “SndMtr” to toggle the setting On and Off.
3. Hold Control (Windows) or Command (Mac) and press the Meter switch to exit.

**Insert Meter On/Off**

The Insert Meters On/Off preference toggles insert metering on and off. This preference applies when inserts are displayed on the D-Control rotary encoders.

To toggle insert meters on and off:

1. In the Soft Keys section, press the Meter switch repeatedly to display the page that includes the Insert Meters On/Off preference (“InsMtr”).
2. Press the Soft Key that corresponds to “InsMtr” to toggle the setting On and Off.
3. Hold Control (Windows) or Command (Mac) and press the Meter switch to exit.

**Meters Pre/Post Fader**

The Meters Pre/Post Fader preference toggles channel metering between pre- and post-fader modes.

To toggle channel meters between pre- and post-fader metering:

1. In the Soft Keys section, press the Meter switch repeatedly to display the page that includes the Meters Pre/Post Fader preference (“Meters”).
2. Press the Soft Key that corresponds to “Meters” to toggle the setting between “PreFad” (pre-fader metering) and “PostFd” (post-fader metering).
3. Hold Control (Windows) or Command (Mac) and press the Meter switch to exit.

**Center Meters Track/Output**

The Center Meters Track/Output preference toggles the 8-channel meter display on the Main Unit meter bridge between main output levels and the focused track. When set to meter the focused track, you can view levels for multichannel tracks up to 8 channels (7.1 surround).

To toggle the center meters between output and track metering:

1. In the Soft Keys section, press the Meter switch repeatedly to display the page that includes the Center Meters Track/Output preference (“CtrMtr”).
2. Press the Soft Key that corresponds to “CtrMtr” to toggle the setting between “Output” and “Track.”
3. Hold Control (Windows) or Command (Mac) and press the Meter switch to exit.

**Gain Reduction Priority**

When encoder LED rings and channel meters are set to display dynamics plug-in gain reduction, you can set which function has priority when multi-function Compressor/Gate plug-ins are used.

To set the gain reduction metering priority:

1. In the Soft Keys section, press the Meter switch repeatedly to display the page that includes the Gain Reduction Priority preference (“GRPrio”).
2. Press the Soft Key that corresponds to “GRPrio” to toggle the setting between Compressor/Limiter (“CompLm”) and Expander/Gate (“ExpGat”).
3. Hold Control (Windows) or Command (Mac) and press the Meter switch to exit.
System Calibration

Recalibrating D-Control Faders

If a fader on a D-Control Unit shows response problems, you can recalibrate the faders with the Recal command in Utility mode. See “Recal” on page 133 for details.

Calibrating the Output Meters

You can calibrate the output meters on the Main Unit meter bridge from XMON, in order to match metering levels in Pro Tools with metering levels of external sources. The example below uses a Digidesign 192 I/O as the reference source.

To calibrate the D-Control output meters:

1. Set the reference level of your 192 I/O according to the instructions in the 192 I/O Guide.

2. With the 192 I/O analog output connected to the XMON Main Input, send a calibration tone to the D-Control Main Outputs, and note the output level on the D-Control meters.

3. Disconnect the 192 I/O analog output from the XMON Main Input and connect it to the XMON Alt Input.

4. Activate the Alt Output.

5. Adjust the trim pots on the back panel of the XMON until the output level for each channel on the D-Control matches the level displayed for the Main Output.

6. When you are finished, reconnect the 192 I/O analog output to the XMON Main Input.

Calibrating SPL Indication on the Monitor Section

The D-Control Monitor section lets you display output level in dB or dB SPL. You can calibrate the SPL display to reflect the sound pressure level at the mix position. See “Calibration Mode Switch” on page 105.
Part III: Reference
Chapter 6: Channel Strip Controls

Channel Strips

The D-Control Main Unit has one central channel strip, called the Focus Channel Strip, and each D-Control Fader Module has 16 channel strips. Each channel strip (Figure 1) has identical controls, including six touch-sensitive rotary encoders, display and mode controls, and a touch-sensitive fader.

Rotary Encoder Section

Each channel strip has six touch-sensitive rotary encoders with LED ring, display, mode switches, and status indicators. Rotary encoders control channel input, insert, send, pan, and mic pre parameters.

Encoder Knob

The encoder knobs on D-Control channel strips are touch-sensitive. When you touch the encoder, the encoder display switches from the parameter name to the parameter value. Touch display of parameter values can be turned off.

When you are automating a parameter controlled by an encoder, touching the encoder knob starts writing automation.

When assigning a channel input or output, or an insert or send, the encoder knob is used to scroll through available inputs, outputs, inserts, or sends. When adjusting the phantom power on a remote-controlled mic preamplifier (such as the Digidesign PRE), the encoder knob can be used to toggle phantom power on and off.

Encoder LED Ring

Each encoder has a ring of 15 three-color LEDs. Discrete or stepped information is shown by single LEDs, and continuously variable information is shown by an expanding series of LEDs.

In Normal mode, encoder LED rings can show send level, pan position, plug-in parameter values, and mic pre settings. In Flip mode, they show track level.
Encoder Automation Mode Indicator

Below each encoder knob is an LED marked “auto,” which lights when the corresponding parameter is enabled for automation. The indicator lights green for Read mode, yellow when armed for automation in any of the Write modes, and red when writing automation in any of the Write modes.

Encoder Display

Each encoder has a six-character display that shows parameter names. When the corresponding encoder knob is touched or moved, the display shows parameter values.

Encoder displays use colors and backlighting to indicate the following:
- Green: Default color for input, insert, send, pan, and mic pre parameter names and values
- Inverted green: Inactive input, inactive output, inactive plug-in or inactive send names
- Yellow: Assignment options in Assign mode, any parameters in Flip mode
- Red: Clipped plug-in, send or channel

Dynamics and EQ Plug-in Indicators

When viewing inserts on an encoder, these LEDs light to indicate the presence of a Dynamics plug-in (yellow LED) or EQ plug-in (green LED).

Mute and Pre Indicators

When viewing sends on an encoder, these LEDs light to indicate that the send is muted (red LED) or set to pre-fader operation (green LED).

Encoder Select Switch

Each encoder has a Select switch that is used to assign an insert or send to that encoder, or to display insert or send parameters for editing.

Inserts

When assigning an insert, the encoder Select switch is used to confirm the selection of the following elements on each level:
- Insert type (TDM plug-in, RTAS plug-in, Multi-Mono TDM plug-in, Multi-Mono RTAS plug-in, or Hardware Insert)
- Plug-in subfolder (such as EQ, Dynamics, Pitch Shift, Reverb, or Delay)
- Individual insert or plug-in

When viewing a plug-in, the encoder Select switch is used to display and edit plug-in parameters on that channel’s rotary encoders.

Sends

When assigning a send, the encoder Select switch is used to confirm the selection of the following:
- Send type (interface or bus)
- Send assignment

When viewing a send, the encoder Select switch is used to display and edit send parameter names and values on that channel's rotary encoders.

Bypass/Mute/Pre Switch

Each encoder has a Bypass/Mute/Pre (B/M/P) switch whose function depends on what is currently displayed on the encoder. With Sends, the function of the B/M/P switch also depends on the current Switch Mode setting.

See “Switch Mode Switch” on page 57 for more information on changing the Switch mode and viewing the current function of the B/M/P switch.

Inserts

- When a plug-in name is displayed on an encoder (in the top level Inserts display), the B/M/P switch bypasses the corresponding plug-in. The B/M/P switch lights when the plug-in is bypassed.
- When a plug-in parameter is displayed on an encoder (by pressing its Select switch) the B/M/P switch affects certain parameters (such as polarity or channel linking) that can be toggled on and off.

Sends

When a send name is displayed on an encoder, the B/M/P switch does one of the following:
- If the Switch Mode is set to Mute, the B/M/P switch mutes the corresponding send. The red Mute LED lights to indicate that the send is muted.
- If the Switch Mode is set to Pre, the B/M/P switch toggles the corresponding send between pre- and post-fader operation. The green Pre LED lights to indicate that the send is set for pre-fader operation.

Mic Pre

When mic pre parameters are displayed on a channel strip’s encoders (in the top level Mic Pre display), the B/M/P switches do the following:
- Top encoder B/M/P: toggles phantom power on and off
- Gain encoder B/M/P: toggles mic pre HPF on and off
- Source encoder B/M/P: toggles mic pre Insert on and off
- Pad encoder B/M/P: toggles mic pre Pad on and off
- Polarity encoder B/M/P: toggles mic pre Polarity
Chapter 6: Channel Strip Controls

Channel Strip Mode Controls

Each channel strip has a set of Channel Strip Mode controls for displaying and editing pan, plug-in, mic pre, insert, or send parameters on the encoder section of the D-Control channel strip.

Page Up and Page Down Switches

Control parameters are arranged on channel strip rotary encoders in pages, or groups of up to six parameters at a time.

The Page Up and Page Down switches light to indicate the presence of additional pages of sends, pan, plug-in, or mic pre parameters in the corresponding direction on each channel strip. If no additional pages are available, neither switch is lit.

To move the page display of parameters on the encoders up or down:
- Press a lit Page Up or Page Down switch.

Dynamics and EQ Switches

The Dynamics and EQ switches light to indicate the presence of the corresponding type of plug-in on a channel strip.

To display a channel strip’s first Dynamics or EQ plug-in on the rotary encoders for editing:
- Press a lit Dynamics or EQ switch.

To cycle through all the Dynamics or EQ plug-ins on a channel:
- Repeatedly press the corresponding switch.

Input Switch

With Audio and Auxiliary Input tracks, the Input switch is used to put channels into Inline mode. See “Inline Console Mode” on page 120.

With Instrument tracks, the Input switch is used to display that track’s MIDI controls on the rotary encoders. See “MIDI Controls on Instrument Tracks” on page 50.

Mic Pre Switch

When you press the Mic Pre switch, the controls for an available remote-controlled microphone preamplifier (such as the Digidesign PRE) are displayed on the channel strip’s rotary encoders for editing. Microphone preamplifiers are declared in the Pro Tools peripherals dialog, and assigned to channels in the Pro Tools I/O Setup dialog.

Inserts Switch

When you press the Inserts switch, the plug-in names on that channel strip are displayed on the encoder displays.

To view the parameters for an individual plug-in:
- Press the Select switch on the corresponding encoder.

To return to the top level display of plug-ins on the channel strip:
- Press the Inserts switch again.

The Inserts switch flashes when a plug-in on that channel has clipped. To clear a clip, press the Clear Clip switch in the Session Management section. See “Clear Clip Switch and Plug-in Clip Indicator” on page 92 for more information.

Pan Switch

When you press the Pan switch, the pan controls for the channel strip are displayed on the encoder displays. If there are additional pages of pan controls for a multichannel track, its Page Up switch lights.

Bypass/Mute Switch

The function of the Bypass/Mute switch depends on what is currently displayed on the channel strip’s encoders.

Inserts
- In the top level Inserts view (when plug-in names are displayed on a channel strip’s encoders), the Bypass/Mute switch bypasses all plug-ins on that channel.
- When a single plug-in’s parameters are displayed on a channel strip’s encoders, the Bypass/Mute switch bypasses that plug-in only.

Sends
- In the top level Sends view (when send names are displayed on a channel strip’s encoders), the Bypass/Mute switch mutes all sends on that channel.
- When a single send’s parameters are displayed on a channel strip’s encoders, the Bypass/Mute switch has no effect.
Sends Switch

When you press the Sends switch on a channel strip, sends are show in two groups of five (Sends A–E or Sends F–J) on the encoder displays. The rotary encoders control Send level.

To toggle display of Sends A–E and F–J on a channel strip:
1. Press the Sends switch in the Channel Strip Mode controls section of the channel strip to show the top level Send display.
2. Press the Page Up and Page Down switches to toggle the top level Send display between the two sets of five sends (A–E and F–J).

Send Pan Mode

Send Pan mode allows you to adjust send panning and level at the same time. Send Level is controlled by the channel fader and Send Pan is controlled by the encoder.

To enter Send Pan mode:
1. Press the Sends switch to display sends on the channel’s encoders.
2. Press the encoder Select switch that corresponds to the send you want to display. The channel’s Send and Pan switches light to indicate that it is in Send/Pan mode.

To return to the top level display of sends on the channel strip:
- Press the Sends switch again.

The Sends switch flashes when a send on that channel has clipped. To clear a clip, press the Clear Clip button in the Session Management section. See “Clear Clip Switch and Plug-in Clip Indicator” on page 92 for more information.

MIDI Controls on Instrument Tracks

The Instruments View in Pro Tools contains MIDI controls that can be displayed on the bottom encoder of D-Control channel strips.

To display MIDI volume and mute controls on an Instrument track:
- Press the Input switch in the Channel Strip Mode controls section of the Instrument channel strip.

The MIDI controls appear on the bottom encoder (Encoder 6) as follows:
- Encoder knob: MIDI Volume
- B/M/P switch: MIDI Mute
- Encoder LED ring: MIDI Velocity Meter

To display MIDI pan controls:
- Hold the Input switch and press the Pan switch in the Channel Strip Mode controls section of the channel strip.

The bottom encoder (Encoder 6) knob controls MIDI Pan.

To exit display of MIDI controls:
- Press another switch in the Channel Strip Mode section.

Instrument Tracks and Flip Mode

When MIDI controls for Instrument tracks are displayed on the bottom row of encoders, they can be transferred (or “flipped”) to the channel faders, allowing control of MIDI Volume or MIDI Pan from the channel faders.

To transfer controls from the bottom row of rotary encoders to the channel faders:
- Press the Flip switch that corresponds to the bottom row of encoders (Encoder 6).

In Flip mode, Instrument track controls are transferred as follows:
- The fader on each channel controls the parameter (MIDI Volume or MIDI Pan) that was assigned to the bottom encoder, and the bottom encoder controls track Volume.
- The channel Mute switch controls the MIDI Mute function, and the B/M/P switch on the bottom encoder controls channel mute.

To exit Flip mode:
- Press a lighted Flip switch.

Channel Strip Function Controls

Each channel strip has a set of Channel Strip Function controls for controlling channel selection and focus, mute, solo, and record enable status, input monitor mode, and automation mode.
Input Monitor Mode Switch
The Input Monitor Mode switch toggles the input monitoring mode for that channel between Auto Input and Input Only mode. The switch lights when the channel is in Input Only mode.

Record Enable Switch
The Record Enable switch toggles record enable status for the channel. When the channel is record-enabled and the Pro Tools transport is stopped, the switch flashes. During recording, the switch lights continuously.

Record Safe Mode To record safe a track from D-Control, hold Control (Windows) or Command (Mac) and press the track’s Record Enable switch.

Channel Select Switch
The function of the Channel Select switch depends on the Select/Focus Mode setting. See “Select/Focus Mode Switch and Indicators” on page 61 for more information on changing the Select/Focus mode.

Select Mode If the Select/Focus Mode is set to Select, the Channel Select switch selects the channel in Pro Tools. The switch lights when the channel is selected. In this mode, the Channel Select switch can be set to follow latching or exclusive-or (non-latching) behavior.

Focus Mode If the Select/Focus Mode is set to Focus, the Channel Select switch focuses that channel’s controls on the Focus Channel Strip on the Main Unit. The switch lights when the channel is focused. In this mode, because only one track can be focused at a time, the Select switch follows exclusive-or (non-latching) behavior only.

Solo Switch
The Solo switch toggles solo status for the channel. When a channel is soloed, the Solo switch lights, and the Mute switches on other channels in the session flash. The Solo switch function follows the Pro Tools Operation preference for latched operation.

Solo Safe Mode To solo safe a track, hold Control (Windows) or Command (Mac) and press the track’s Solo switch.

Mute Switch
The Mute switch toggles mute status for the channel. When a channel is muted, the Mute switch lights continuously.

Channel Display
Each channel display shows the channel information in the following display modes. In each mode, when the channel fader is touched, the display shows the channel volume in dB.

Track Name Mode Shows the track name only.

Group/Name Mode Shows the group membership of the track (by group letter) and an abbreviated track name.

Track Position Number/Name Mode Shows the track position number and an abbreviated track name.

Headroom Mode Shows the abbreviation “HR” followed by the remaining headroom in dB.

Level Mode Shows the track volume level in dB only.

Channel displays use colors and backlighting to indicate the following:
- Green: Channel names and values
- Inverted green: Inactive channel
- Red: Clipped channel

Automation Mode Switch
The Automation Mode switch cycles the channel through the Pro Tools automation modes (Write, Latch, Touch, Read and Off). The active mode is shown by the Automation Mode LED indicators to the left of each channel’s fader. When in Off mode, none of the indicators is lit.

The Automation Mode switch lets you cycle the channel through Touch, Latch, and Read modes during playback, but it prevents you from entering Write or Off mode during playback. To directly enter Write or Off mode during playback, use the Automation Mode controls in the lower left and right of the Main Unit. (See “Automation Mode Controls” on page 63.)

Automation Trim Switch
The Automation Trim switch toggles the channel into the corresponding Trim mode for Write, Latch, Touch, and Read modes. Active Trim mode is shown by the yellow Trim mode LED indicator to the left of each channel’s fader. The Automation Trim switch has no effect while the channel is in Off mode.
Fader Section

Fader

The touch-sensitive faders on D-Control channel strips control channel volume in Normal mode, and a wide range of parameters in Flip mode or the Custom Fader modes. When you touch a fader, its channel strip display changes from track name to track volume level (in Normal mode), or from parameter name to parameter value (in Flip modes or Custom Fader modes). When you are automating a parameter on a fader, touching the fader starts writing automation.

Automation Mode Indicators

The Automation Mode indicators, located to the left of each channel’s fader, indicate the active automation mode. WR (Write), TC (Touch) and LT (Latch) are red LEDs; TM (Trim) is a yellow LED; and RD (Read) is a green LED.

When in Write, Touch or Latch modes, the corresponding indicator flashes until automation writing begins. When automation writing begins, the indicator lights solid.

If automation is turned off for the channel (Off), none of the indicators is lit.

Group Status Indicator

The Group Status indicator (a green LED marked GRP), located to the left of each channel’s fader, lights to indicate that the channel is a member of an active Mix or Edit group in Pro Tools.

If the channel is a member of an inactive group, or if groups are suspended, this indicator is off.

Custom Fader Mode Indicator

The Custom Fader Mode indicator (a blue LED marked CF), located to the left of each channel’s fader, lights to indicate that the channel is currently in Custom Fader Mode.

AutoMatch Indicators

The AutoMatch indicators (green arrow-shaped LEDs), located to the left of each channel’s fader, light to indicate the direction you need to move the fader in order to match the automation level previously written for that track. This is especially useful when editing fader automation.

Modifier Key Switches

Each D-Control Fader Module has a set of four switches in its lower left corner that duplicate the function of the Pro Tools computer keyboard modifiers.

Modifier Keys (Fader Module)

Shift Switch (Windows and Mac)

The Shift switch duplicates the function of the Shift key on the D-Control computer keyboard.

Control Switch (Windows and Mac)

The Control switch duplicates the function of the Control key on the D-Control computer keyboard.

Win Switch (Windows) or Option Switch (Mac)

The Win/Option switch duplicates the function of the Windows key (also called the Start key) or the Option key (Mac) on the D-Control computer keyboard.

Alt Switch (Windows) or Command Switch (Mac)

The Alt/Command switch duplicates the function of the Alt key (Windows) or the Command key (Mac) on the D-Control computer keyboard.

The order of the modifier keys on the Fader Module reflects the order of the corresponding keys on a Windows or Mac keyboard, from left to right.
Channel Strip Master Section

The Channel Strip Master section (Figure 2) is a set of channel-related controls that appears on both the left and right sides of the D-Control Main Unit, allowing easy access to these controls from any mixing position. The operation of each control in this section is mirrored on both sets of controls at all times.

Flip Switches

The six yellow Flip switches in the Channel Strip Master section correspond to the six horizontal rows of rotary encoders on the D-Control channel strips.

Flip Mode

The Flip switches invoke Flip mode, which transfers controls from the corresponding rotary encoder to the fader on each channel strip, allowing convenient editing and automation of send, pan, plug-in, and mic pre parameters directly from the channel faders.

In Flip mode, the rotary encoder control swaps with the channel fader; the encoder Select switch swaps with the channel Select switch; the encoder Bypass/Mute/Pre switch swaps with the channel Mute switch; and the encoder display swaps with the channel display.

In Flip mode, the Flip switch for the affected row of encoders is lit, and the affected encoder displays appear in yellow.

To transfer controls from a row of rotary encoders to the channel faders:

- Press the Flip switch that corresponds to the encoder row.

To exit Flip mode:

- Press a lighted Flip switch.

💡 When D-Control is in Flip mode and you enter Make Inactive mode or Assign mode, it is temporarily taken out of Flip mode, but the Flip switch remains lit.

💡 When you exit Make Inactive mode or Assign mode, controls return to their flipped positions.

Flop Mode

A variation of Flip mode, Flop mode transfers controls from any of the top five rows of rotary encoders to the bottom row of rotary encoders, allowing you to bring any encoder control within easy reach from the mix position.

In Flop mode, the affected row of encoders moves to the bottom row of encoders, the Flip switches for both affected rows are lit, and the encoder displays for both rows appear in yellow.

Figure 2. Channel Strip Master section
To transfer controls from any of the top five rows of encoders to the bottom row of encoders:

- Hold the Start key (Windows) or Control key (Mac) and press the Flip switch that corresponds to the encoder row.

To exit Flop mode:

- Press either of the lighted Flip switches.

When D-Control is in Make Inactive mode or Assign mode, it is temporarily taken out of Flop mode, but the Flip switches remains lit. When you exit Make Inactive mode or Assign mode, controls return to their flopped positions.

Make Inactive Controls

The Make Inactive controls are used to make tracks, inputs, outputs, sends, or plug-ins inactive. Each switch puts D-Control into a temporary Make Inactive mode in which elements are made inactive or reactivated. The switch flashes while Make Inactive mode is in effect.

Make Inactive Controls

Making a Track Inactive

In Make Inactive mode, channel Select switches are lit on all tracks.

To toggle a track inactive/active:

1. Press any of the Make Inactive switches.

2. Press the channel strip Select switch for each track you want to deactivate or activate.

3. Press the flashing Make Inactive switch to exit Inactive mode.

Inputs Inactive Switch

The Inputs switch invokes Inputs Inactive mode and displays channel inputs in the bottom row of encoders. The Bypass/Mute/Pre switch on the bottom encoder toggles the input inactive and active.

Outputs Inactive Switch

The Outputs switch invokes Outputs inactive mode and displays the main channel outputs in the bottom row of encoders. The Bypass/Mute/Pre switch on the bottom encoder toggles the output inactive and active.

Sends Inactive Switch

The Sends switch invokes Sends Inactive mode and displays the channel’s sends on its encoders. The Bypass/Mute/Pre switch on each encoder toggles the corresponding send inactive and active.

Plug-ins Inactive Switch

The Plug-ins switch invokes Plug-ins Inactive mode and displays a channel’s inserts on its encoders. The Bypass/Mute/Pre switch on each encoder toggles the corresponding insert inactive and active.

To toggle an input, output, send, or plug-in active/inactive:

1. Make sure the channel is showing the top-level view for the element you want to make active/inactive.

2. Press a Make Inactive switch to enter the appropriate Make Inactive mode.

3. Press the Bypass/Mute/Pre switches on encoders to deactivate or reactivate their corresponding track elements.

4. Press the flashing Make Inactive switch to exit Inactive mode.

Plug-in Automation Controls

The Plug-in Automation controls are used to enable parameters for automation and to place them in automation safe mode.

Enable Parameters Switch

The Enable Parameters switch lets you enable parameters for automation by touching or pressing their controls.

In Enable Parameters mode, the Enable Parameters switch is lit. While in this mode, the Auto LED for any rotary encoder enabled for automation is lit red, and the switch for any parameter enabled for automation is lit.
To toggle automation on and off for plug-in parameters:

1. Press the Enable Parameter switch.
2. Touch the rotary encoders or press the switches for the controls whose automation you want to toggle on or off.
3. Press the Enable Parameter switch again to exit Enable Parameters mode.

You can also toggle automation for a plug-in parameter by holding Control+Start+Alt (Windows) or Command+Control+Option (Mac) and touching the rotary encoder for the parameter.

Automation Safe Switch

The Automation Safe switch invokes a mode in which the Bypass/Mute/Pre switch for each plug-in or send and the channel Select switch for each track become Safe switches.

Plug-ins and Sends

While in Automation Safe mode, pressing a Bypass/Mute/Pre switch on a plug-in or send protects any automation on that plug-in or send from being overwritten. The Bypass/Mute/Pre switch for any protected plug-in or send is lit, reflecting the state of the Safe button in the on-screen plug-in or send output window.

Tracks

While in Automation Safe mode, pressing a channel Select switch protects volume, pan and mute parameters on that track from being overwritten. The channel Select switch for any protected track is lit, reflecting the state of the Safe button in the on-screen track output window.

To toggle automation safe on and off:

1. Press the Automation Safe switch.
2. Press the channel Select switch on the tracks for which you want to toggle automation safe status. The automation safe status of the track is reflected by the Safe button in the track’s on-screen output window.
3. Press the Bypass/Mute/Pre switch for the plug-ins or sends for which you want to toggle automation safe status.
4. Press the Automation Safe switch again to exit Automation Safe mode.

Assign Controls

The Assign controls are used to assign inputs, outputs, inserts, and sends to channels. Each switch puts D-Control into a temporary Assign mode in which elements are assigned or removed from channels. The switch flashes while Assign mode is in effect.

You can enter Assign mode while Pro Tools is playing back. To confirm the assignment of inputs, outputs, and sends, the transport must be stopped. You can, however, confirm the assignment of inserts during playback.

Assign Inputs Switch

The Inputs switch invokes Assign Inputs mode, in which the bottom row of encoders shows channel inputs.

When assigning an input, the Select switch on the bottom encoder is used to navigate down through Input menu levels, and the encoder knob is used to scroll through available choices at each level:

- Input type (Interface or Bus), shown in yellow
- Individual inputs, shown in green

Press the Bypass/Mute/Pre switch on the bottom encoder to navigate back up the Input menu levels.

Assign Outputs Switch

The Outputs switch invokes Assign Outputs mode, in which the bottom row of encoders shows channel outputs.

When assigning an output, the Select switch on the bottom encoder is used to navigate down through Output menu levels, and the encoder knob is used to scroll through available choices at each level:

- Output type (Interface or Bus), shown in yellow
- Individual outputs, shown in green

Press the Bypass/Mute/Pre switch on the bottom encoder to navigate back up the Output menu levels.
**Assign Sends Switch**

The Sends switch invokes Assign Sends mode, in which the channel encoders shows the sends on a channel.

When assigning a send, the encoder Select switch is used to navigate down through Send menu levels, and the encoder knob is used to scroll through available choices at each level:

- Send type (Interface or Bus), shown in yellow
- Individual sends, shown in green

The Bypass/Mute/Pre switch on each encoder is used to navigate back up the Send menu levels.

**Assign Inserts Switch**

The Inserts switch invokes Assign Inserts mode, in which the channel encoders show the inserts on a channel. When assigning an insert, the encoder Select switch is used to navigate down through Insert menu levels, and the encoder knob is used to scroll through available choices. The Bypass/Mute/Pre switch on the bottom encoder is used to navigate back up the Insert menu levels.

The order in which plug-ins appear in the Insert menu is determined by the Pro Tools Display preference for plug-in organization.

If the Organize Plug-in Menus by Category option is selected, menu levels and choices include:

- Insert type (TDM plug-in, RTAS plug-in, Multi-Mono TDM plug-in, Multi-Mono RTAS plug-in, or Hardware Insert), shown in yellow
- Plug-in subfolder (such as EQ, Dynamics, Pitch Shift, Reverb, and Delay), shown in yellow
- Individual insert or plug-in, shown in green

If the Organize Plug-in Menus by Category option is not selected, the plug-in subfolder level is not present.

**To assign an input, output, send or insert:**

1. Press an Assign switch to enter the corresponding Assign mode.
2. On the channel where you want to make the assignment, turn an encoder knob to select from the first level of menu choices.
3. Press the encoder Select switch to move down and the Bypass/Mute/Pre switch to move up through menu levels.
4. Do one of the following:
   - Press the flashing encoder Select switch or press the flashing Assign switch to confirm the assignment.
   - or –
   - Press the flashing Escape switch to cancel the assignment.

**To assign multiple inputs, outputs, sends, or inserts:**

1. Press an Assign switch to enter the corresponding Assign mode.
2. Turn the encoder knobs and use the encoder Select and Bypass/Mute/Pre switches to select each assignment.
3. Do one of the following:
   - Press the flashing Assign switch to confirm all the assignments at once.
   - or –
   - Press the flashing Escape switch to cancel all the assignments.

**To remove an input, output, send or insert:**

1. Press an Assign switch to enter the corresponding Assign mode.
2. For the assignment you want to remove, press the encoder Bypass/Mute/Pre switch repeatedly until you reach top level menu for the assignment.
3. Turn the encoder knob counter-clockwise until no assignment is visible.
4. Do one of the following:
   - Press the flashing encoder Select switch or press the flashing Assign switch to confirm the removal.
   - or –
   - Press the flashing Escape switch to cancel the removal and restore the assignment.

**Removing Plug-in Assignments**

You can use the Set to Default switch to quickly remove plug-in assignments from tracks, without having to go into Assign mode.

⚠️ This method removes the assignments immediately, and cannot be canceled.

**To quickly remove plug-in assignments:**

1. Press the Set to Default switch.
2. Press the encoder Select switch for each plug-in assignment you want to remove.
3. Press the flashing Set to Default switch.
MIDI Inputs and Outputs on Instrument Tracks

The Assign Inputs and Assign Outputs switches can be used to assign the MIDI Inputs and Outputs on Instrument tracks.

To assign a MIDI Input or Output on an Instrument track:

1. Press the Assign Inputs or Assign Outputs switch to enter the corresponding Assign mode. Encoder row #5 shows MIDI inputs/outputs.

2. On each channel where you want to make an assignment, turn the encoder knob in encoder row #5 to select from the first level of MIDI menu choices.

3. Press the encoder’s Select switch to move down and the Bypass/Mute/Pre switch to move up through MIDI menu levels.

4. Do one of the following:
   - Press the flashing encoder Select switch or press the flashing Assign switch to confirm the assignments.
   - or –
   - Press the flashing Escape switch to cancel the assignments.

Switch Information Controls

The Switch Information controls are used to change the mode and display of encoder Bypass/Mute/Pre switches, and globally show encoder parameter values.

Switch Information controls

**Switch Mode Switch**

The Switch Mode switch toggles the function of encoder Bypass/Mute/Pre switches between Mute and Pre-Fader functions when displaying sends on the encoders.

- When the Switch Mode is set to Bypass, the encoder B/M/P switch mutes the corresponding send.
- When the Switch Mode is set to Pre, the encoder B/M/P switch toggles the corresponding send between pre- or post-fader operation.

To set the Switch Mode:

- Press the Switch mode switch repeatedly until the appropriate indicator lights (Mute or Pre).

**Show Values Switch**

The Show Values switch can follow toggling or momentary behavior. If pressed briefly, it toggles encoder display between parameter name and parameter value. If held, parameter value is shown until the switch is released.

**Automation Enable Controls**

The Automation Enable controls are used to enable or suspend writing of each type of automation on all channels. When writing is enabled for a type of automation, its corresponding switch is lit.

These Automation Enable controls mirror the function of the corresponding buttons in the Pro Tools Automation Enable window.

**Plug-in Switch**

The Plug-in switch enables and suspends writing of automation for any automation-enabled plug-in parameters on all tracks in the session.

**Volume Switch**

The Volume switch enables and suspends writing of channel volume automation on all tracks in the session.

**Pan Switch**

The Pan switch enables and suspends writing of channel pan automation on all tracks in the session.

**Mute Switch**

The Mute switch enables and suspends writing of channel mute automation on all tracks in the session.
Send Level Switch

The Send Level switch enables and suspends writing of send level automation on all tracks in the session.

Send Pan Switch

The Send Pan switch enables and suspends writing of send pan automation on all tracks in the session.

Send Mute Switch

The Send Mute switch enables and suspends writing of send mute automation on all channels.

Automation Write Controls

The Automation Write controls invoke the manual “Write to Start/End/All” commands, the automatic “Write to Start/End/All on Stop” automation commands, and the “Write to Current Parameter” and “Write to All Enabled Parameters” snapshot automation commands in Pro Tools.

The “Write to Start/End/All” commands and the “Write to Next” command can also be invoked from the Soft Keys section of D-Control.

All Switch

The All switch writes the current automation value of all write-enabled parameters to an entire selection or track when performing an automation pass.

To manually Write to All:

- Press the All switch during playback.

To enable automatic Write to All on Stop:

- Hold the Start key (Windows) or the Control key (Mac) and press the All switch.

To disable automatic Write to All on Stop:

- Press the flashing All switch.

End Switch

The End switch writes the current automation value of all write-enabled parameters to the end of a selection or track when performing an automation pass.

To manually Write to End:

- Press the End switch during playback.

To enable automatic Write to End on Stop:

- Hold the Start key (Windows) or the Control key (Mac) and press the End switch.

To disable automatic Write to End on Stop:

- Press the flashing End switch.

Current Switch

The Current switch writes a snapshot of the current parameter value to the currently displayed automation parameter.

All Enabled Switch

The All Enabled switch writes a snapshot of all current parameter values to all enabled automation parameters.

Global Controls

The Global controls are used to apply commands that affect multiple channels in various ways.
Do To All and Do To Selected Switches

The Do To All and the Do To Selected switches on D-Control can be used in two different ways: to apply actions to multiple tracks in a Pro Tools session, and to change the display mode of multiple channel strips on D-Control.

The Do To All and Do To Selected switches can follow toggling or momentary behavior. If pressed briefly, they latch on and flash until pressed a second time. If held, they apply to all controls moved until released.

⚠️ The Do to All and Do to Selected switches can latch on, and are not cleared by the Escape switch. Use them carefully.

Applying Actions to Multiple Tracks in Pro Tools

The Do To All and Do To Selected switches are convenient for performing tasks such as muting, soloing, assigning sends, or assigning the same plug-in across multiple tracks in a session.

To apply actions to multiple tracks in a Pro Tools Session:

1. Press the Do To All or the Do To Selected switch.
2. Press any of the following switches to apply the corresponding action to all tracks or all selected tracks in the current session:
   - Channel Mute switch
   - Channel Solo switch
   - Channel Solo Safe: Control (Windows) or Command (Mac) + Solo switch
   - Automation Mode switch
   - Automation Trim switch
   - Channel Select switch (in Select mode)
   - Record Enable switch
   - Record Safe: Control (Windows) or Command (Mac) + Record Enable switch
   - Input Monitor Mode switch
3. Depending on the current channel strip display mode, you can apply the following across all tracks or all selected tracks in the session:
   - Mic Pre Controls: Polarity, Pad, Impedance, Source, Gain
   - Send Pre/Post: B/M/P switch in Send Pre/Post mode
   - Send Mute: B/M/P switch in Send Mute mode
   - Plug-in Bypass: B/M/P switch in Inserts mode
4. You can also carry out any of the following tasks across all tracks or all selected tracks in the session:
   - Assigning Inputs, Outputs, Inserts and Sends
   - Deactivating Inputs, Outputs, Inserts, Sends and Tracks
   - Resetting controls with the Set to Default switch
   - Changing panner linkage
   - Changing panner editor choice
5. When you are finished, press the flashing Do To All or Do To Selected switch to exit the corresponding mode.

Changing Parameter Display on D-Control Channel Strips

The Do To All and Do To Selected switches can be used to display and edit pan, mic pre, insert, or send parameters across all tracks or all selected tracks in a session.

The Do To All and Do To Selected switches are applied independently to channel strips in Normal mode and channel strips in Custom Fader mode. The display mode of the Focus Channel Strip is not affected by Do To All or Do To Selected operations.

This independent operation lets you put banks of channels in several display modes at once (for example, pan on channels in Normal mode, plug-ins on channels in Custom Fader mode, and sends on the Focus Channel Strip).

To change the display mode of D-Control channel strips:

1. Press the Do To All or the Do To Selected switch.
2. Press any of the following Channel Strip Mode switches on any individual channel to apply the corresponding action to all or all selected channels on D-Control:
   - Dynamics switch
   - EQ switch
   - Input switch
   - Microphone Preamplifier switch
   - Inserts switch
   - Pan switch
   - Bypass/Mute switch
   - Sends switch
3. When you are finished, press the flashing Do To All or Do To Selected switch to exit the corresponding mode.
Set To Default Switch

The Set to Default switch is used to reset parameters on the D-Control surface to their default values. This switch works in both Normal and Custom Fader modes.

Instead of using the Set To Default switch, you can also hold the Alt key (Windows) or the Option key (Mac) and press the corresponding switch to reset parameters to their default values.

The Set to Default switch can follow latching or momentary behavior. If pressed briefly, it latches on and flashes until pressed a second time. If held, its effect applies until released.

You can also use the Set to Default switch to remove plug-in assignments from channels. See “Removing Plug-in Assignments” on page 56.

While the Set to Default switch is pressed or latched on, the following parameters can be reset:

To reset a channel’s track volume to 0 dB:
- Press Set to Default + the channel Select switch.

To reset a channel’s pan control to 0 (center)
- Press Set to Default + the pan encoder Select switch.

To reset a send’s level to 0 dB:
- Press Set to Default + the send encoder Select switch. This sets the send level to 0 dB, regardless of the Send default setting in Pro Tools Operation preferences.

To reset a channel’s mic pre gain to 0 dB:
- Press Set to Default + the mic pre gain encoder Select switch

To reset an LFE channel’s gain to 0 dB:
- Press Set to Default + the encoder Select switch for the LFE channel.

To set a plug-in’s parameters to their default values:
- Press Set to Default + the Compare switch for the plug-in. (The Compare switch appears in the D-Control Dynamics and EQ sections, and in Custom Fader Expanded Plug-in mode.)

Suspend Groups Switch

The Suspend Groups switch suspends all groups in the session.

The Suspend Groups switch follows latching behavior, and flashes to indicate groups are suspended. To exit Suspend Groups mode, press the Suspend Groups switch again.

Global Channel Strip Mode Controls

The Global Channel Strip Mode controls are used to display and edit pan, mic pre, insert, or send parameters across all tracks in a session. These controls do not affect channel strips in any of the Custom Fader modes.

Global Page Up and Page Down Switches

The Global Page Up and Page Down switches change the page display on all channel strips.
- To move the page display of parameters on all rotary encoders up or down, press the Global Page Up or Page Down switch.

Global Dynamics and EQ Switches

The Global Dynamics and EQ switches display the first plug-in of the corresponding type on the rotary encoders across all channels. To cycle through all the Dynamics or EQ plug-ins across all channels, repeatedly press the corresponding switch.

Global Input Switch

The Global Input switch toggles all applicable channels into Inline mode (Audio and Auxiliary Input tracks) or to display MIDI controls on the rotary encoders (Instrument tracks).

See “Inline Console Mode” on page 120 and “MIDI Controls on Instrument Tracks” on page 50.

Global Mic Pre Switch

The Global Mic Pre switch displays the controls for remote-controlled microphone preamplifiers on the rotary encoders across all channels.
Global Inserts Switch

The Global Inserts switch displays inserts on the rotary encoders across all channels.

Global Pan Switch

The Global Pan switch displays the channel pan controls on the rotary encoders across all channels.

Global Sends Switch

The Global Sends switch displays the send controls on the rotary encoders across all channels.

Channel Strip Master Function Controls

The Channel Strip Master Function controls are used to change modes for the channel Select switches, channel displays, clear Solo and Mute states, and globally suspend automation.

Select/Focus Mode Switch and Indicators

The Select/Focus Mode switch toggles the function of channel Select switches between Select and Focus mode. In Select mode, channel Select switches are used to select channels in Pro Tools. In Focus mode, channel Select switches are used to focus a channel’s controls on the Focus Channel Strip on the Main Unit.

The LEDs on either side of this switch indicate the current mode.

Solo Clear Switch

The Solo Clear switch clears all latched Solo switches in the session. This switch flashes when any channel is soloed.

Mute Clear Switch

The Mute Clear switch clears all mutes for all tracks in the session. This switch lights when any channel is muted.

Display Mode Switch

The Display Mode switch toggles the channel display between the five display modes: Track Name, Group/Name, Channel Number/Name, Headroom Value, and Level modes. See “Channel Display” on page 51 for more information.

Automation Suspend Switch

The Automation Suspend switch suspends reading and writing of all automation on all tracks in the session. All channels are left in their current automation mode, but automation operations are temporarily suspended.

The Automation Suspend switch flashes while automation is suspended.

Escape Switch

The Escape switch is used to exit modes and to cancel operations or on-screen dialogs. When an action has occurred that can be exited or canceled with the Escape switch, the switch flashes.
Custom Fader Controls

The Custom Fader controls invoke a special set of D-Control modes, called Custom Fader modes, which let you set aside and customize channel strips for display and editing of a variety of functions. The Custom Fader modes are Custom Groups mode, Mix/Edit Groups mode, Tracks mode, and Plug-in mode. See “Custom Fader Modes” on page 120 for complete information on Custom Fader modes.

Custom Faders Display

- When a Custom Fader mode is active, the Custom Faders display shows the name of the Custom Group, Mix/Edit Group, or the plug-in displayed on the Custom Fader channels.
- When no Custom Fader mode is active, the Custom Faders display shows the name of one of the plug-ins on the focused channel. (When you enter Custom Fader Plug-in mode, this plug-in will be displayed on the Custom Fader channels.)

Custom Switch

The Custom switch invokes Custom Groups mode, which lets you create a custom collection of channels and arrange them in any order in the Custom Fader channels. Custom Groups are unique to D-Control and are not reflected on-screen in Pro Tools.

Groups Switch

The Groups switch invokes Mix/Edit Groups mode, which lets you create, edit, and recall Pro Tools Mix and Edit groups to the Custom Fader channels.

Tracks Switch

The Tracks switch invokes Track Type mode, which lets you call any of the following track types to the Custom Fader channels: Master Faders, Audio Tracks, Auxiliary Inputs, MIDI Tracks, Instrument Tracks, or Hidden Tracks.

Plug-in Switch

The Plug-in switch invokes Plug-in mode, which lets you call the currently focused channel’s plug-in controls to the Custom Fader channels.

Map Switch

The Map switch works with Custom Groups mode, Mix/Edit Groups mode, and Plug-in mode. While in these modes, the Map switch lets you further customize the control layout by mapping individual rotary encoder controls to faders within the Custom Fader channels.

The Map switch has no effect on other D-Control channels in Normal mode.

Flip Switch

The Custom Fader Flip switch works with Custom Groups mode, Mix/Edit Groups mode, and Plug-in mode. While in these modes, pressing the Flip switch transfers controls from the top row of encoders to the faders in the Custom Fader channels. Pressing the Flip switch additional times flips subsequent rows of encoders to the faders. The Custom Fader Flip switch has no effect on other D-Control channels in Normal mode.

Lock Switch

The Lock switch applies to Custom Fader Plug-in mode only. This switch locks the plug-in that is currently displayed in the Custom Faders display, so that it does not change when you focus a different channel in the Focus Channel strip. The Lock switch lights when the plug-in is locked.

- When Custom Fader Plug-in mode is active, the locked plug-in appears in the Custom Fader channels, so you can focus a different channel on the Focus Channel Strip and keep the locked plug-in in the Custom Fader channels.
- When Custom Fader Plug-in mode is not active, the locked plug-in appears in the Custom Faders display, so you can focus a different channel on the Focus Channel Strip and keep the locked plug-in in the Custom Faders display. (When you enter Custom Fader Plug-in mode, this plug-in will be displayed on the Custom Fader channels.)

Window Switch

The Window switch opens and closes the plug-in window on-screen for any plug-in whose name is displayed in the Custom Faders display.
Bank/Cycle Switch

◆ While in Custom Groups or Mix/Edit Groups mode, the Bank/Cycle switch is used to bank faders within the Custom Fader channels, if there are more channels than can be displayed at one time.

◆ While in Custom Fader Plug-in mode, the Bank/Cycle switch cycles through the plug-ins on the focused channel, displaying their controls on the Custom Fader channels.

◆ When no Custom Fader mode is active, the Bank/Cycle switch cycles through the plug-ins on the focused channel, displaying their names in the Custom Faders display.

Automation Mode Controls

The Automation Mode controls are used to display and set automation modes. These switches light to indicate that at least one channel is in that automation mode. If multiple channels are selected and set to different automation modes, all applicable mode switches are lit.

These Automation Mode controls mirror the function of the on-screen Automation Mode selector for each track, and let you change automation modes during playback.

Automation Mode controls

To set the automation mode of one or more channels:

1. Hold an Automation Mode switch (Write, Touch, Latch, Trim, Read, or Off).

2. Press the Select switches on the channels whose automation mode you want to set.

To set the automation mode of one or more selected channels:

1. Press the Do To Selected switch.

2. Press the Select switches on the channels whose automation mode you want to set.

3. Press an Automation Mode switch (Write, Touch, Latch, Trim, Read, or Off).

4. Press the flashing Do To Selected switch.

To set the automation mode of all channels:

1. Press the Do To All switch.

2. Press an Automation Mode switch (Write, Touch, Latch, Trim, Read, or Off).

3. Press the flashing Do To All switch.

Write Switch

The Write switch indicates or sets the automation mode for the selected tracks to Write mode.

Touch Switch

The Touch switch indicates or sets the automation mode for the selected tracks to Touch mode.

Latch Switch

The Latch switch indicates or sets the automation mode for the selected tracks to Latch mode.

Trim Switch

The Trim switch indicates or sets the automation mode for the selected tracks to Trim mode.

Read Switch

The Read switch indicates or sets the automation mode for the selected tracks to Read mode.

Off Switch

The Off switch indicates or sets the automation mode for the selected tracks to Off.

Talkback Switch

Two Talkback switches, located at the bottom of each Channel Strip Master section on the Main Unit, provide mirrored control of the D-Control Talkback function.

Talkback switch

The Talkback switches can follow momentary or latched behavior. If held, the switch is active only when pressed down.

If rapidly double-pressed, the switch latches on and flashes to indicate that talkback is active. Press the switch again to turn off talkback.

Talkback can be activated automatically. See “Auto Talkback Switch” on page 111 for more information.

Talkback level is set with the Talkback controls in the Monitor section. See “Talkback/Listen System” on page 110 for more information.
Chapter 7: Plug-in Controls

Plug-ins and D-Control

D-Control provides dedicated Dynamics and EQ sections for plug-ins that support Dynamics and EQ plug-in mapping. These sections include encoders and switches that map to standard controls for each plug-in type.

Plug-ins of all types can be focused across multiple D-Control channels using Custom Fader Plug-ins mode. See “Plug-In Mode” on page 124.

Plug-in Channel Formats

D-Control supports mono, stereo, multichannel and multi-mono plug-in channel formats. Multi-mono plug-ins comprise up to eight individual mono channels that can be linked in any combination.

With D-Control, you can display, edit, and link specific channels of multi-mono Dynamics and EQ plug-ins directly from the Channel Select switches in the corresponding section.

Assigning and Removing Plug-ins

You can make plug-in assignments directly from D-Control in several ways. In Inserts mode, plug-ins can be added on an insert-by-insert basis. In Assign Inserts mode you can assign plug-ins to insert positions on multiple tracks.

To assign a plug-in in Inserts mode:

1. Press the Inserts switch to display inserts on the channel where you want to assign the plug-in.

2. Do one of the following:
   - If the insert location you want to use is empty, press the corresponding encoder Select switch.
   - or –
   - If a plug-in is already present in the insert location you want to use, press and hold the corresponding encoder Select switch.

3. At the insert position where you want to make the assignment, turn the encoder knob to select from the first level of menu choices.

4. Press the encoder Select switch to move down and the Bypass/Mute/Pre switch to move up through menu levels.

5. When the plug-in you want to assign is displayed, press the encoder Select switch to confirm your selection.

To assign plug-ins to multiple tracks:

1. Press the Assign Inserts switch to enter Inserts Assign mode. The first two send or insert positions will show on the encoder displays by default.

2. At the insert position where you want to make the assignment, turn the encoder knob to select from the first level of menu choices.

3. Press the encoder Select switch to move down and the Bypass/Mute/Pre switch to move up through menu levels.

4. When the plug-in you want to assign is displayed, press the encoder Select switch to confirm your selection.

5. Repeat steps 2–4 to make additional insert assignments.

6. Press the flashing Assign switch to confirm the assignments and exit Inserts Assign mode.

To remove a plug-in:

1. Press the Set to Default switch.

2. Press the encoder Select switch for each plug-in you want to remove.

3. Press the flashing Set to Default switch to exit Set to Default mode.

Focusing Plug-ins on D-Control

A plug-in is focused when its controls are mapped to the knobs, switches or faders on D-Control. Its parameters can then be edited and automated from the control surface. D-Control lets you focus a plug-in with or without displaying its window on-screen.

You can focus plug-ins in multiple locations on D-Control: on any channel strip in Normal mode, in the Dynamics section, in the EQ section, and in the Custom Faders section.

When a plug-in is focused on D-Control and displayed on-screen, a colored outline appears in the plug-in window header.
To focus a plug-in on a channel strip:
1. Press the Inserts switch for the channel to display plug-in names on the channel’s encoders.
2. Press the encoder Select switch for the plug-in you want to focus.

The controls of the focused plug-in appear on the channel’s encoders. You can page through the plug-in’s controls by pressing the Page Up and Page Down switches on the channel.

To focus a plug-in in the Dynamics or EQ section:
1. Focus the plug-in’s track on the Focus Channel Strip by pressing the track’s Select switch. The first dynamics and EQ plug-ins on that track are automatically focused in the corresponding D-Control section.
2. Press the Cycle switch in the Dynamics or EQ section to focus successive dynamics or EQ plug-ins on that channel. (The No Insert option is always available.)

To focus a plug-in in the Custom Faders section:
1. Focus the plug-in’s track on the Focus Channel Strip by pressing the track’s Select switch. The name of the first plug-in that is not a Dynamics or EQ plug-in appears in the Custom Faders display.
2. In the Custom Faders section, press the Bank/Cycle switch to cycle through the plug-ins on the focused channel. (The No Insert option is always available.)

The plug-in whose name appears in the Custom Faders display is then available for Custom Fader Plug-in mode. See “Plug-In Mode” on page 124.

Opening Plug-in Windows On-Screen

There are several ways to open plug-in windows on-screen from D-Control.

To open a plug-in window from any channel on D-Control:
- Hold Start (Windows) or Control (Mac) and press the encoder Select switch for the plug-in.

To open a plug-in window on a focused track:
1. Focus a track in the Focus Channel Strip by pressing its Select switch.
2. In the Custom Faders section, press the Bank/Cycle switch to cycle through the plug-ins on the focused track. Plug-in names are shown in the Custom Faders display.
3. In the Custom Faders section, press the Win switch to open the plug-in whose name is displayed.

To open a focused Dynamics or EQ plug-in window:
- Press the Window switch in the Dynamics or EQ section of D-Control.

To open or close all focused plug-in windows:
- Press the Plug-in switch in the Window Management section.

To close all open plug-in windows:
- Hold Alt (Windows) or Option (Mac) and press the Plug-in switch in the Window Management section. This closes all real-time and AudioSuite plug-in windows.

To set D-Control to automatically open plug-in windows:
1. Press the Operation switch in the D-Control Soft Keys section repeatedly to display the page that includes the Channel Window Display preference (“ChanWn”).
2. Press the Soft Key that corresponds to “ChanWn” until its value is “Yes.”

With this preference set to “Yes,” when you assign a new plug-in, press an encoder Select switch to edit a plug-in, or cycle through plug-ins on the focused track, the plug-in window will automatically open on-screen.

Managing Multiple Plug-in Windows

D-Control lets you open and swap multiple plug-in windows on-screen. This makes it possible keep plug-in windows open while focusing on different tracks (for example, in a session where several tracks have Dynamics and EQ plug-ins).

Targeting Plug-ins

A plug-in is said to be targeted on-screen when its target icon in the plug-in window header is lit red. The first plug-in window to be opened is automatically targeted.
- When a plug-in window is targeted, it is replaced when you open any new plug-in window.
- When a plug-in window is not targeted (when its target icon is grey) the plug-in window will remain on-screen.
To open multiple plug-in windows:

- Hold Shift while opening each new window. The new plug-in windows are not targeted.

To swap multiple plug-in windows while changing track focus:

1. Focus a track with multiple plug-ins (for example, dynamics, EQ and Pitch Shift plug-ins) by pressing the track’s Select switch.
2. Open multiple plug-in windows on the focused track while holding the Shift modifier.
3. Hold Alt (Windows) or Option (Mac) while changing focus to another track with multiple plug-ins by pressing the track’s Select switch.

Focused plug-ins with open windows swap into new plug-in windows on-screen, wherever plug-ins are present in the new track.

Making Plug-ins Inactive or Active

You can toggle the active/inactive status of a plug-in directly from a channel strip without putting D-Control into Make Inactive mode.

To toggle a plug-in active/inactive directly from a channel strip:

1. Press the Inserts switch on a channel strip to display the names of the plug-ins on the channel’s encoders.
2. Hold Control+Start (Windows) or Control+Command (Mac) and press the encoder Select switch for the plug-in.

Changing Plug-in Presets from Channel Strips

You can activate next or previous settings in the Plug-in Librarian menu directly from any channel strip on D-Control. These commands mirror the Next and Previous Setting buttons in the plug-in header.

To enable the next or previous plug-in setting from a channel strip:

1. Focus the plug-in in a channel strip so its controls are visible on the channel strip encoders.
2. Hold Control (Windows) or Command (Mac) and press the Page Up (Next) or Page Down (Previous) switch in that channel strip’s Channel Strip Mode controls.

Copying and Pasting Plug-in Settings

You can copy plug-in settings from a plug-in and paste them into another instance of the same plug-in directly from a channel strip on D-Control, from either the top-level view or the focused view of the plug-in.

To copy and paste plug-in settings from the top level plug-in view:

1. On channel strips where you want to copy and paste the plug-in settings, press the Inserts switches to display the names of the plug-ins on the channel encoders.
2. Copy the settings of a plug-in by holding Shift+Control (Windows) or Shift+Command (Mac) and pressing the encoder Select switch under the name of the plug-in.
3. Paste the settings into another instance of the same plug-in by holding Shift+Control (Windows) or Shift+Command (Mac) and pressing the B/M/P switch under the name of that plug-in.

To copy and paste plug-in settings from the focused plug-in view:

1. On channel strips where you want to copy and paste the plug-in settings, focus the plug-ins on the channels so their controls are visible on the channel strip encoders.
2. Copy the settings of a plug-in by holding Shift+Control (Windows) or Shift+Command (Mac) and pressing the encoder Select switch under the bottom row of encoders of the plug-in’s channel.
3. Paste the settings into another instance of the same plug-in by holding Shift+Control (Windows) or Shift+Command (Mac) and pressing the B/M/P switches under the bottom row of encoders for that plug-in.

Enabling Plug-in Automation

When plug-in names are displayed in top-level view on a D-Control channel strip, you can quickly enable all parameters of a plug-in for automation.

You can also use the Do To All or Do To Selected switches on D-Control to automate multiple plug-ins in the same insert position in a session.
To toggle automation on and off for a parameter of a plug-in:

1. Press the Inserts switch in the Channel Strip Mode controls of a track to show the top level Inserts display. Plug-in names appear in the encoder displays of that track.

2. Press an encoder Select switch to display a plug-in’s parameters on the rotary encoders.

3. Hold Control+Alt+Start (Windows) or Command+Option+Control (Mac) and touch the rotary encoder for the plug-in parameters you want to enable for automation.

To toggle automation on and off for all parameters of a plug-in:

1. Press the Inserts switch in the Channel Strip Mode controls of a track to show the top level Inserts display. Plug-in names appear in the encoder displays of that track.

2. Hold Control+Alt+Start (Windows) or Command+Option+Control (Mac) and touch the rotary encoder for the plug-in whose parameters you want to enable for automation.

To toggle automation on and off for all plug-ins in a given Insert position:

1. Press the Inserts switch in the Channel Strip Mode controls of a track to show the top level Inserts display. Plug-in names appear in the encoder displays of that track.

2. Press the Do To All switch in the Global controls section.

3. Hold Control+Alt+Start (Windows) or Command+Option+Control (Mac) and touch the rotary encoder for any plug-in at the insert position (Insert 1–5) where you want to enable plug-in automation.

To toggle automation on and off for plug-ins in a given Insert position on all selected tracks:

1. Select the tracks containing the plug-ins you want to enable for automation.

2. Press the Inserts switch in the Channel Strip Mode controls of a track to show the top level Inserts display. Plug-in names appear in the encoder displays of that track.

3. Press the Do To Selected switch in the Global controls section.

4. Hold Control+Alt+Start (Windows) or Command+Option+Control (Mac) and touch the rotary encoder for any plug-in at the insert position (Insert 1–5) where you want to enable plug-in automation.

Displaying Dynamics Plug-in Gain Reduction on Channel Meters

You can display gain reduction metering for dynamics plug-ins directly on channel meters in Normal mode. When this metering mode is active, the D-Control channel meters show both track level and compressor gain reduction when you display the plug-in’s parameters on the channel encoders.

Mono Tracks When a mono track is displayed on a D-Control channel strip, the channel’s left meter shows track level, and the channel’s right meter shows plug-in gain reduction.

Multichannel Tracks When a multichannel track is displayed on a D-Control channel strip, the channel’s left meter shows the first channel’s level, and the channel’s right meter shows gain reduction.

Center Meter Display When the 8-channel center meters on the D-Control Main Unit is set to display levels for the focused track, the center meters show levels for up to two output channels, plus input, output, gain reduction, and downward expansion for a dynamics plug-in on the focused track.

To display dynamics plug-in gain reduction on channel meters:

1. In the Soft Keys section, press the Meter switch.

2. Press the Soft Key that corresponds to “GRChan” to turn on display of gain reduction.

3. Press the Meter switch to exit.

4. On a channel with a dynamics plug-in, press the Dynamics switch in the Channel Strip Display controls to display the plug-in’s parameters on the channel strip encoders.

The dynamics plug-in gain reduction is displayed in the channel’s right meter, from the top down.

To display dynamics plug-in gain reduction on the center meters:

1. In the Soft Keys section, press the Meter Prefs 1 switch.

2. Press the Soft Key that corresponds to “CtrMtr” to toggle the display to “Track.”

3. Press the Soft Key that corresponds to “GRChan” to turn on display of gain reduction.

4. Press the Meter Prefs 1 switch to exit.

5. Focus a channel with a dynamics plug-in on the Focus Channel Strip.

6. Press the Dynamics switch in the Focus Channel Strip Display controls to display the plug-in’s parameters on the Focus Channel Strip encoders.

The dynamics plug-in input level, output level, gain reduction, and downward expansion are displayed in the rightmost center meters, from the top down.
Chapter 7: Plug-in Controls

Dynamics Section

The Dynamics section includes standard controls for compressor, gate, and limiter plug-ins, an array of controls for managing the display and editing of plug-in parameters, and selecting or linking channels in multi-mono plug-ins.

Dynamics Plug-in Support

Dynamics processing plug-ins may have widely varying controls, depending on their applications. The D-Control Dynamics Section provides dedicated knobs and switches to accommodate the widest range of plug-ins possible. Not all plug-ins will require all the Dynamics controls, while others may have more parameters than can be displayed in the Dynamics section at one time. To display all controls in any plug-in, you can use Custom Fader Plug-ins mode.

Displaying Dynamics Plug-ins

The D-Control Dynamics section automatically focuses the first dynamics plug-in on the channel displayed in the Focus Channel Strip on the Main Unit.

To display successive dynamics plug-ins that are on the focused channel, press the Cycle switch in the Dynamics section.
Knee/Hysteresis and Ratio/Range Controls

Knee/Hysteresis Control
The top encoder in this section controls the knee shape or the hysteresis value for the current plug-in page, depending on which indicator is lit. The Auto indicator under the encoder knob lights when the displayed parameter is enabled for automation.

Ratio/Range Control
The bottom encoder in this section controls the compression ratio or the range value for the current plug-in page, depending on which indicator is lit. The Auto indicator under the encoder knob lights when the displayed parameter is enabled for automation.

Attack and Release Controls

Attack Control
The top encoder in this section controls the attack value for the current plug-in. The Auto indicator under the encoder knob lights when the parameter is enabled for automation.

Release Control
The bottom encoder in this section controls the release value for the current plug-in. The Auto indicator under the encoder knob lights when the parameter is enabled for automation.
Gain/Hold and Threshold Controls

The top encoder in this section controls the gain (make-up gain) or the hold value for the current plug-in page, depending on which indicator is lit. The Auto indicator under the encoder knob lights when the displayed parameter is enabled for automation.

Threshold Control

The bottom encoder in this section controls the threshold value for the current plug-in page. The Auto indicator under the encoder knob lights when the parameter is enabled for automation.

Low Filter and High Filter Controls

The Dynamics section includes controls for high- and low-frequency EQ filters available on certain dynamics plug-ins.

Filter Frequency Encoders

The top encoders in these sections control the filter frequency for each filter. When the filter is a notch filter, these encoders control the center frequency. When the filter is a high-pass or low-pass filter, these encoders control the cutoff frequency.

Q/Slope Encoders

The bottom encoders in these sections control the Q value (for notch filters) or the slope of the cutoff (for high-pass or low-pass filters).

Notch/Shelf Switch and Indicators

The Notch/Shelf switches in these sections let you switch between the two filter types when they are available. The indicators above the switch light to show which type of filter is active.

Filter In Switches

The Filter In switches in these sections let you engage or bypass each filter independently.
**Dynamics Channel Select Controls**

---

**Dynamics Displays**
The LED displays in the Dynamics section show the name of the focused plug-in by default. When any rotary encoder is touched, these displays show the corresponding parameter name and value.

**Channel Select Switches**

**Multichannel Plug-ins**
When you are working with a multichannel plug-in, all channels are controlled in tandem and the Channel Select switches have no effect.

**Multi-Mono Plug-ins**
When you are working with a multi-mono plug-in, the controls for the channels are usually linked and edited together. However, you can edit plug-in settings for individual channels of a multi-mono plug-in by using the Channel Select switches to unlink all of the channels, or to link specific channels.

There are Channel Select switches for the following channels:
- L (Left)
- Lc (Left Center)
- C (Center)
- Rc (Right Center)
- R (Right)
- Ls (Left Surround)
- Cs (Center Surround)
- Rs (Right Surround)
- LFE

These choices support all possible channel configurations in Pro Tools. A maximum of eight channels (7.1 surround) may be in use at any time.

---

**Master Link Switch**

**Multichannel Plug-ins**
When you are working with a multichannel plug-in, all channels are controlled in tandem, and the Master Link switch has no effect.

**Multi-Mono Plug-ins**
When you are working with a multi-mono plug-in, the Master Link switch toggles the Master Link button in the plug-in window, which links or unlinks all channels of the plug-in. When the Master Link button is enabled, the Link switch is lit.

---

**Select/Link/Bypass Mode Switch**

The Select/Link/Bypass Mode switch determines the function of the Channel Select switches with multi-mono plug-ins.

**Select Mode** In this mode, the Channel Select switches determine which channel of a multi-mono plug-in is the focus of the plug-in controls. When a channel is selected, its switch is lit. If any channels are linked, their switches follow linked behavior.

In Select mode, if the D-Control Channel Window Display preference is set to Yes, the Channel Select switches also change the channel display in the plug-in window.

**Bypass Mode** In this mode, the Channel Select switches determine which channels of a multi-mono plug-in are bypassed. When a channel is bypassed, its switch is lit. If any channels are linked, their switches follow linked behavior.

**Link Mode** In this mode, the Channel Select switches determine which individual channels of a multi-mono plug-in are linked together. Linked channels are indicated by switches that are lit.
Dynamics Edit and Display Controls

Page Switch

With plug-ins that have more than one page of controls, the Page switch lights. Pressing this switch steps through the pages for the currently displayed plug-in.

Active paged controls are shown in the plug-in window by colored outlines.

External Key Switch

The External Key switch turns the Key Input on or off for plug-ins that support side-chain processing with external input. This switch lights when Key Input is on.

Key Listen Switch

The Listen switch turns the Key Listen function on or off for plug-ins that support auditioning the Key Input. This switch lights when Key Listen is on.

Save As Switch

The Save As switch performs the Save As command in the Plug-in settings menu.

To save a Dynamics plug-in setting from D-Control:

1. Press the Save As switch in the Edit and Display controls of the Dynamics section. The Save As switch flashes while the Save Settings dialog is open.
2. Type a name for the plug-in setting.
3. Do one of the following:
   - Click OK to save the settings and close the dialog.
   - Press the flashing Save As switch to save the settings and close the dialog.
   - Press the Escape switch to exit the dialog without saving the settings.
**Lock Switch**
The Lock switch is used to lock the focus of the Dynamics section on the current plug-in. When the plug-in focus is locked, the current plug-in remains in the Dynamics section, even when a different track is focused on D-Control. This switch lights when the plug-in focus is locked.

**Compare Switch**
The Compare switch toggles the Compare button in the plug-in window, which alternates between the currently saved plug-in setting and any changes you have made.

**Automation Switch**
The Automation switch lets you enable Dynamics parameters for automation by touching or pressing their controls in the Dynamics section only.

In Automation mode, the Auto switch is lit. While in this mode, the Auto LED for any rotary encoder enabled for automation is lit red, and the switch for any parameter enabled for automation is lit.

**To toggle automation on and off for individual Dynamics parameters:**
1. Press the Automation switch.
2. Touch the rotary encoders or press the switches in the Dynamics section for which you want to toggle automation.
3. Press the Automation switch again to exit Automation mode.

**To toggle automation on and off for all parameters of a Dynamics plug-in:**
1. Press the Automation switch.
2. Do one of the following:
   - Hold Alt (Windows) or Option (Mac).
   - or –
   - Hold Do to All.
3. Touch any rotary encoder or press any switches in the Dynamics section.
4. Press the Automation switch again to exit Automation mode.

**Safe Switch**
The Safe switch toggles the Safe button in the plug-in window, which protects existing automation for that plug-in from being overwritten.

**Cycle Switch**
The Cycle switch steps through all available Dynamics plug-ins on the focused channel.

**Master Bypass Switch**
The Master Bypass switch bypasses the plug-in.

**Window Switch**
The Window switch is used to open and close the on-screen window for the currently focused plug-in.
Dynamics Gain Controls and Meters

Level controls (left) and meters (right) in the Dynamics section

Input and Output Gain Encoders

The Input and Output Gain encoders control the input gain and output gain for the current plug-in. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

Input and Output Meters and Clip Indicator

The Input and Output meters show the input and output levels for the current plug-in. The Clip indicator lights when a clip is reported by the plug-in, and can be cleared by pressing the Clear Clip switch in the Session Management section.

Gain Reduction Meters

The Gain Reduction meters show the amount of gain reduction for Compressor/Limiter functions (on the left) and Expander/Gate functions (on the right).

You can also display gain reduction metering for dynamics plug-ins directly on channel meters in Normal mode. See “Displaying Dynamics Plug-in Gain Reduction on Channel Meters” on page 68.
EQ Section

The EQ section includes standard controls for a variety of multi-band plug-ins, an array of controls for managing the display and editing of plug-in parameters, and controls for selecting or linking channels in multi-mono plug-ins.

EQ Plug-in Support

EQ processing plug-ins may have widely varying controls, depending on their applications. The D-Control EQ Section provides dedicated knobs and switches to accommodate the widest range of plug-ins possible. Not all plug-ins will require all the EQ controls, while others may have more parameters than can be displayed in the EQ section at one time.

To simultaneously display all controls in any plug-in, you can use Custom Fader Plug-ins mode.

Displaying EQ Plug-ins

The D-Control EQ section automatically displays the first EQ plug-in on the channel that is focused in the Focus Channel Strip on the Main Unit.

To display successive EQ plug-ins that are on the focused channel, press the Cycle switch in the EQ section.
**High-Pass Filter and Low-Pass Filter Controls**

There are similar controls for high-pass and low-pass filters on the extreme left and right sides of the EQ section.

**Q Encoders**

The top encoders for these EQ bands control the Q of each filter. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

**Notch/Shape Switches and Indicators**

The Notch/Shape switches in these EQ bands let you switch between the two filter types when they are available. The indicators on either side of the switch light to show which type of filter is active.

**Frequency Encoders**

The bottom encoders in these EQ bands control the filter frequency for each filter. When the filter is a notch filter, these encoders control the center frequency. When the filter is a high-pass or low-pass filter, these encoders control the cutoff frequency. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

**Band In Switches**

The Band In switches in these EQ bands let you engage or bypass their corresponding EQ band in the plug-in.

---

**Low Shelf/Peak and High Shelf/Peak EQ Controls**

There are similar controls for the low- and high-shelf/peak EQ bands on the left and right sides of the EQ section, just inside the high-pass and low-pass filter controls.

**Q Encoders**

The top encoders for these EQ bands control the Q of each band. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

**Notch/Shelf Switch and Indicators**

The Notch/Shelf switches in these EQ bands let you switch between the two EQ types when they are available. The indicators on either side of the switch light to show which type of EQ is active.

**Frequency Encoders**

The middle encoders in these EQ bands control the frequency for each band. When the EQ is a peaking type, these encoders control the center frequency. When the EQ is a high- or low-shelf type, these encoders control the cutoff frequency. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

**Gain Encoders**

The bottom encoders in these EQ bands control the gain for each band. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

**Band In Switches**

The Band In switches in these EQ bands let you engage or bypass their corresponding EQ band in the plug-in.
Low-Mid, Mid, and High-Mid EQ Band Controls

There are similar controls for low-mid, mid, and high-mid EQ bands in the center of the EQ section.

**Q Encoders**

The top encoders for these EQ bands control Q values for each band. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

**Frequency Encoders**

The middle encoders in these EQ bands control the center frequency for each band. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

**Gain Encoders**

The bottom encoders in these EQ bands control the gain for each band. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

**Band In Switches**

The Band In switches in these EQ bands let you engage or bypass the corresponding EQ band in the plug-in.
Chapter 7: Plug-in Controls

**EQ Channel Select Controls**

![EQ displays](image_url)

**EQ Displays**

The LED displays in the EQ section show the name of the focused plug-in by default. When any rotary encoder is touched, these displays show the corresponding parameter name and value.

**Channel Select Switches**

**Multichannel Plug-ins**

When you are working with a multichannel plug-in, all channels are controlled in tandem and the Channel Select switches have no effect, except with multichannel plug-ins (such as Focusrite d2) that directly support channel selection.

**Multi-Mono Plug-ins**

When you are working with a multi-mono plug-in, the controls for the channels are usually linked and edited together.

However, you can edit plug-in settings for individual channels of a multi-mono plug-in by unlinking all of the channels, or by using the Channel Select switches to link specific channels.

There are Channel Select switches for the following channels:
- L (Left)
- Lc (Left Center)
- C (Center)
- Rc (Right Center)
- R (Right)
- Ls (Left Surround)
- Cs (Center Surround)
- Rs (Right Surround)
- LFE

These choices support all possible channel configurations in Pro Tools. A maximum of eight channels (7.1 surround) may be in use at any time.

**Master Link Switch**

**Multichannel Plug-ins**

When you are working with a multichannel plug-in, all channels are controlled in tandem, so the Master Link switch has no effect, except with multichannel plug-ins (such as Focusrite d2) that directly support channel linking.

**Multi-Mono Plug-ins**

When you are working with a multi-mono plug-in, the Master Link switch toggles the Master Link button in the plug-in window, which links or unlinks all channels of the plug-in. When the Master Link button is enabled, the Link switch is lit.

**Select/Link/Bypass Mode Switch**

The Select/Link/Bypass Mode switch determines the function of the Channel Select switches with multi-mono plug-ins.

**Select Mode** In this mode, the Channel Select switches determine which channel of a multi-mono plug-in is the focus of the plug-in controls. When a channel is selected, its switch is lit. If any channels are linked, their switches follow linked behavior.

In Select mode, if the D-Control Channel Window Display preference is set to Yes, the Channel Select switches also change the channel display in the plug-in window.

**Bypass Mode** In this mode, the Channel Select switches determine which channels of a multi-mono plug-in are bypassed. When a channel is bypassed, its switch is lit. If any channels are linked, their switches follow linked behavior.

**Link Mode** In this mode, the Channel Select switches determine which individual channels of a multi-mono plug-in are linked together. Linked channels are indicated by switches that are lit.
EQ Edit and Display Controls

Save As Switch

The Save As switch performs the Save As command in the Plug-in settings menu, which saves a new settings file for the plug-in.

To save an EQ plug-in setting from D-Control:

1. Press the Save As switch in the Edit and Display controls of the Dynamics section. The Save As switch flashes while the Save Settings dialog is open.
2. Type a name for the plug-in setting.
3. Do one of the following:
   • Click OK to save the settings and close the dialog.
   • Press the flashing Save As switch to save the settings and close the dialog.
   • Press the Escape switch to exit the dialog without saving the settings.

Lock Switch

The Lock switch is used to lock the focus of the EQ section on the current plug-in. When the plug-in focus is locked, the current plug-in remains in the EQ section, even when a different track is focused on D-Control. This switch lights when the plug-in focus is locked.

Compare Switch

The Compare switch toggles the Compare button in the plug-in window, which alternates between the currently saved plug-in setting and any changes you have made.

Automation Switch

The Automation switch lets you enable EQ parameters for automation by touching or pressing their controls in the EQ section only.

In Automation mode, the Auto switch is lit. While in this mode, the Auto indicator for any rotary encoder enabled for automation is lit red, and the switch for any parameter enabled for automation is lit.

To toggle automation on and off for individual EQ parameters:

1. Press the Automation switch.
2. Touch the rotary encoders or press the switches in the EQ section for which you want to toggle automation.
3. Press the Automation switch again to exit Automation mode.

To toggle automation on and off for all parameters of an EQ plug-in:

1. Press the Automation switch.
2. Do one of the following:
   • Hold Alt (Windows) or Option (Mac).
   • Hold Do to All.
3. Touch any rotary encoder or press any switches in the EQ section.
4. Press the Automation switch again to exit Automation mode.
**Safe Switch**

The Safe switch toggles the Safe button in the plug-in window, which protects existing automation for that plug-in from being overwritten.

**Cycle Switch**

The Cycle switch steps through all available EQ plug-ins on the focused channel.

**Master Bypass Switch**

The Master Bypass switch bypasses the plug-in.

**Window Switch**

The Window switch is used to open and close the on-screen window for the currently focused plug-in.

---

**EQ Level Controls and Meters**

**Input and Output Gain Encoders**

The Input and Output Gain encoders control the input gain and output gain for the current plug-in. The Auto indicator under each encoder knob lights when the parameter is enabled for automation.

**Input and Output Meters and Clip Indicator**

The Input and Output meters show the input and output levels for the current plug-in. The Clip indicator lights when a clip is reported by the plug-in, and can be cleared by pressing the Clear Clip switch in the Session Management section.
Chapter 8: Transport and Navigation Controls

Transport Section

The D-Control Transport section includes two complete sets of transport switches, switches for setting the transport mode, scrub/shuttle switches and controls, and advanced audition and locate switches.

Pro Tools Transport

The D-Control Pro Tools Transport switches correspond to the controls in the Pro Tools Transport window.

Rewind Switch Moves backward through the Pro Tools session beginning from the current cursor position.

Fast Forward Switch Moves forward through the Pro Tools session beginning from the current cursor position.

Stop Switch Stops playback of the Pro Tools session.

Play Switch Begins playback of the Pro Tools session from the current cursor position.

Record Switch Arms Pro Tools for recording. Exact function depends on current Pro Tools record mode (QuickPunch, TrackPunch, Wait for Note, Pause).

MIDI Merge Indicator Shows when MIDI Merge is activated.

Machine Transport

This function is currently not implemented for D-Control.
Latching Behavior for Fast Forward and Rewind Switches

You can set Fast Forward or Rewind to follow latched behavior from the D-Control Transport section.

**To set Fast Forward to latch:**
- Hold the Fast Forward switch and momentarily press the Rewind switch.

**To set Rewind to latch:**
- Hold the Rewind switch and momentarily press the Fast Forward switch.

Playback of Timeline Selection and Edit Selection from the Transport

When the Timeline and Edit selections in the Edit window are unlinked, you can set the D-Control Transport to control playback of either the Timeline selection or the Edit selection.

**To focus the D-Control Transport on the Timeline selection:**
- Press the Edit/Timeline Selection switch in the Miscellaneous Controls section so that the Timeline LED is lit.

**To focus the D-Control Transport on the Edit selection:**
- Press the Edit/Timeline Selection switch in the Miscellaneous Controls section so that the Edit LED is lit.

Scrub/Shuttle Controls

The Scrub/Shuttle controls are used for scrubbing, scrubbing while trimming, shuttling, and making selections.

Scrub/Shuttle Wheel

The Scrub/Shuttle wheel is used to control cursor position in Pro Tools and for locating external machines.

Scrub Switch

The Scrub switch places the transport in Scrub mode, which lets you scrub from the cursor position or across a selection.

**To use Scrub mode:**
1. While Pro Tools is stopped, press the Scrub switch.
2. Rotate the Scrub/Shuttle wheel clockwise to scrub audio forward, or counter-clockwise to scrub audio backward.
3. To exit, press the Scrub switch again.

Trim Switch

The Trim switch places the transport in Trim/Scrub mode, which lets you scrub to locate an edit point, then trim to that point.

**To use Trim/Scrub:**
1. Navigate to a region or selection you want to trim.
2. Press the Trim switch.
3. Press the Scrub switch.
4. Rotate the Scrub/Shuttle wheel to move the cursor to the trim location.
5. To trim to the cursor location or to the beginning of the selection, press the Trim switch again.

Shuttle Switch

The Shuttle switch places the transport in Shuttle mode, which lets you locate the cursor in the Edit window.

**To use Shuttle mode:**
1. While Pro Tools is stopped, press the Shuttle switch.
2. Rotate the Scrub/Shuttle wheel clockwise to shuttle forward, or counter-clockwise to shuttle backward.
3. To exit, press the Shuttle switch again.

Scrub, Trim/Scrub and Shuttle modes can be used to create selections and define regions in the Pro Tools Edit window.
Master Record Mode Switches
The Master Record Mode switches are used to change the record enable and the input monitoring mode of all channels in a session.

Master Record Enable Switch
The Master Record Enable switch toggles record enable status for all applicable audio tracks in a session. This switch flashes when channels are record-enabled and the Pro Tools transport is stopped, and lights continuously during recording.

If any tracks in the session are record-enabled, pressing the Master Record Enable switch takes them out of their enabled state. If no channels are record-enabled, pressing the Master Record Enable switch places all applicable audio tracks into record-enabled state.

Master Input Monitor Mode Switch
The Master Input Monitor Mode switch toggles the input monitoring mode for all record-enabled audio tracks in a session. (This is the same as choosing the “Change Record Enabled Tracks to Auto Input” or “Input Only” in Pro Tools.) This switch lights only when there are record-enabled tracks in Input Only mode.

To toggle the input monitoring mode of all audio tracks in a session, hold Alt (Windows) or Option (Mac) while pressing the Master Input Monitor Mode switch.

Transport Mode Switches
The Transport Mode switches are used to put the Pro Tools transport in the various playback and record modes.

Transport Modes

- Pro Tools Online Switch
- 9-Pin Remote Switch
- Loop Playback Switch
- QuickPunch Switch
- TrackPunch Switch

Pro Tools Online Switch
The Pro Tools Online switch toggles the Pro Tools online state. The online state is mirrored in the Online button in the Pro Tools Transport window.

While Pro Tools is online and waiting for time code, this switch flashes. When time code is received, this switch lights continuously.

9-Pin Remote Switch
The 9-Pin Remote switch enables 9-pin Remote Deck Emulation mode with Digidesign MachineControl.

Machine Online Switch
This feature has not been implemented for D-Control.

Loop Playback Switch
The Loop Playback switch toggles Loop Playback mode in Pro Tools. When Loop Playback mode is active, this switch lights. The Loop Playback state is mirrored in the Play button in the Pro Tools Transport window.

QuickPunch Switch
The QuickPunch switch toggles QuickPunch record mode in Pro Tools. When QuickPunch mode is active, this switch lights. The QuickPunch state is mirrored in the Record button in the Pro Tools Transport window.

TrackPunch Switch
The TrackPunch switch toggles TrackPunch record mode in Pro Tools. When TrackPunch mode is active, this switch lights. The TrackPunch state is mirrored in the Record button in the Pro Tools Transport window.
Audition Switches

The Audition switches are used to activate pre-roll and post-roll in playback, define selection in and out points, and trigger automatic playback of ranges.

Audition Switch

The Audition switch toggles Audition mode on and off. When Audition mode is on, this switch lights.

When Audition mode is on, you can quickly listen to either the start or end of a selection, with or without pre-roll or post-roll, by pressing the following switches:

- **Pre-Roll Switch** Plays audio starting at the pre-roll point up to the beginning of the selection.
- **Mark In Switch** Plays audio starting at the selection start through the length of the post-roll amount.
- **Mark Out Switch** Plays audio back-timed from the selection end by the pre-roll amount.
- **Post-Roll Switch** Plays audio starting at the end of a selection through the post-roll amount.

**Pre-Roll and Post-Roll Switches**

When Audition mode is off, the Pre-Roll and Post-Roll switches toggle pre-roll and post-roll playback on and off in Pro Tools. When pre-roll or post-roll is active, the corresponding switch lights.

When Audition mode is on, the Pre-Roll and Post-Roll switches play a range of audio around the current Edit selection.

**Mark In and Mark Out Switches**

When Audition mode is off, the Mark In and Mark Out switches are used to define selection start and end during playback, or when using the Scrub/Shuttle wheel.

When Audition mode is on, the Mark In and Mark Out switches play a range of audio around the current Edit selection.

To move the selection start:

With the transport stopped, hold the Mark In switch and turn the Scrub/Shuttle wheel.

To move the selection end:

With the transport stopped, hold the Mark In switch and turn the Scrub/Shuttle wheel.

To move the entire selection:

With the transport stopped, hold both the Mark In and Mark Out switches and turn the Scrub/Shuttle wheel.

**Locate Switches**

The Locate switches move the Pro Tools transport to the designated location.

- **Go To Start Switch** The Go To Start switch returns the playback cursor to the beginning of the session.
- **Go to End Switch** The Go To End switch moves the playback cursor to the end of the session.
- **Back Switch** The Back switch moves the playback location backward by the Back/Forward Amount.

**To move the playback location forward:**

- Hold Alt (Windows) or Option (Mac) and press the Back switch in the Transport section.

**Back & Play Switch**

The Back and Play switch moves the current playback location backward by the Back/Forward Amount and automatically begins playback.

**Forward & Play Mode**

Forward & Play mode can be invoked by doing the following:
To move the playback location forward and begin playback:
- Hold Alt (Windows) or Option (Mac) and press the Back and Play switch in the Transport section.

**Instant Playback**

The Instant Playback switch primes Pro Tools for playback, so that pressing Play will begin playback instantaneously. This switch can also be used during recording to put Pro Tools in Record Pause mode.

**External Machines Switches**

The External Machines switches allow direct access to remote machine track arming functions of Digidesign Machine-Control™. These functions are available when Machine-Control is enabled and a track arming profile is declared. For details on remote track arming functions and record modes, refer to the [MachineControl Guide](#).

**Track Arm from Channel Strips Switch**

The Track Arm from Channel Strips switch displays track arming controls for the currently enabled external machine on Custom Fader channels. Track names appear in the Custom Fader channel displays and the tracks can be record enabled with the corresponding Record Enable switch.

If more machine tracks are available for arming than can be displayed, the Bank/Cycle switch allows banking of the channels.

**Machine Insert Switch**


**Auto Insert/Punch Switch**

The Auto Insert/Punch switch toggles the MachineControl record protocol between Auto Edit and Punch In/Out modes, as displayed in the Pro Tools Track Arming window.

**Insert/Assemble Switch**

The Insert/Assemble switch toggles the MachineControl record mode between Insert and Assemble modes, as displayed in the Pro Tools Track Arming window.

**External Machine Online Switches**

- **Machine 1 Online Switch**
  - This function is currently not implemented for D-Control.

- **Machine 2 Online Switch**
  - This function is currently not implemented for D-Control.

- **Machine 3 Online Switch**
  - This function is currently not implemented for D-Control.

- **Machine 4 Online Switch**
  - This function is currently not implemented for D-Control.
**Zoom/Navigate Section**

The Zoom/Navigate section is used to control navigation, display, and selections in the Pro Tools Edit window.

---

**Zoom Mode Switch**

The Zoom Mode switch puts the arrow switches in Zoom mode.

**Navigate Mode Switch**

The Navigate Mode switch puts the arrow switches in Navigate mode.

---

**Arrow Switches (Up, Down, Previous, Next)**

The function of the Arrow switches depends on the current mode.

- **Zoom Mode** When set to Zoom Mode, the Up and Down Arrow switches change the vertical zoom and the Previous (Left) and Next (Right) Arrow switches change the horizontal zoom.

- **Navigate Mode** In Navigate mode, the Up and Down Arrow switches move the edit cursor up and down among tracks, and the Previous (Left) and Next (Right) Arrow switches move the edit cursor left and right among region boundaries or transients (according to the Tab to Transients setting).

- **Text Entry** In both Zoom or Navigate modes, the Arrow switches can be also used to navigate on-screen text fields and enter numerical values in the on-screen Main and Sub Counters, Start/End/Length fields, and Pre/Post Roll fields in the Edit and Transport windows. The Previous (Left) and Next (Right) Arrow switches move between fields, and the Up and Down Arrow switches change the value.

---

**Zoom Preset Switches**

The Zoom Preset switches recall the five horizontal Zoom presets in Pro Tools.

**To store a Zoom Preset:**

1. Using either the Horizontal Zoom buttons or the Zoomer tool, set the zoom level that you want to store.
2. While pressing Control (Windows) or Command (Mac), press a Zoom Preset switch.

**To recall a Zoom Preset:**

- Press the corresponding Zoom preset switch.
Bank/Nudge Section

The Bank/Nudge section controls the display of any channels in Normal mode on the D-Control surface. They are also used to nudge the display of the Focus Channel Strip forward or backward in 1-channel or 8-channel increments.

If any channels are in any of the Custom Fader modes, they are not affected by Bank or Nudge commands, and the other channels move around them.

Nudge 1 Switches

The Nudge 1 switches move the display of tracks on the control surface to the left or right, one channel at a time.

To nudge the track focus forward or backward by one channel:
- With a track focused in the Focus Channel Strip, hold Control (Windows) or Command (Mac) and press the left or right Nudge 1 switch in the Bank/Nudge section.

Nudge 8 Switches

The Nudge 8 switches move the display of tracks on the controls surface to the left or right in eight-channel increments.

To nudge the track focus forward or backward by eight channels:
- With a track focused in the Focus Channel Strip, hold Control (Windows) or Command (Mac) and press the left or right Nudge 8 switch in the Bank/Nudge section.

Bank Switches

The Bank switches move the display of tracks on the controls surface to the left or right by the number of available channels on the control surface.

Home Switch

The Home switch moves the display of tracks so that the first track in the session is shown on the leftmost channel of the control surface.

Bank Select Matrix

The Bank Select matrix is used in Custom Fader modes to create and select Custom Groups and Mix/Edit Groups, to select Track Types for display in the Custom Faders, and to select Custom Fader Plug-in parameter pages.

See “Custom Fader Modes” on page 120 for complete information on the use of Bank Select matrix Custom Fader modes.

Bank Select Edit Switch

The Bank Select Edit switch is used when creating Mix/Edit Groups or Custom Groups from D-Control. After you press this switch, you can then select the tracks you want to add to the group.

You can also create new Mix/Edit Groups by selecting the tracks you want in the group and double-pressing the Bank Select Edit switch.

Bank Select Switches

The Bank Select switches are used when assigning or recalling Custom Groups or Mix/Edit Groups, and selecting Track Types or plug-in parameter pages from D-Control.
Chapter 9: Management Sections

Window Management Section

The Window Management section includes controls for opening and closing Pro Tools windows on-screen. When a window is open, its corresponding switch is lit.

- **MIDI Event Window Switch**: The MIDI Event Window switch opens and closes the MIDI Event window or brings it to the front.
- **MIDI Operations Window Switch**: The MIDI Operations Window switch opens and closes the MIDI Operations window.
- **Beat Detective Window Switch**: The Beat Detective Window switch opens and closes the Beat Detective window.
- **Workspace Browser Switch**: The Workspace Browser switch opens and closes the DigiBase Workspace Browser. Hold Alt (Windows) or Option (Mac) and press this switch to close all DigiBase windows.
- **Big Counter Switch**: The Big Counter switch opens and closes the Big Counter window.
- **Mic Pre Window Switch**: The Mic Pre Window switch opens and closes the Mic Pre window for the focused track.
- **Memory Locations Window Switch**: The Memory Locations Window switch opens and closes the Memory Locations window.
- **Transport Window Switch**: The Transport Window switch opens and closes the Transport window.
- **Pan Window Switch**: The Pan Window switch opens and closes the Pan window for the focused track. Hold Alt (Windows) or Option (Mac) to close all Pan windows.
- **Mix Window Switch**: The Mix Window switch opens the Mix Window or brings it to the front.
- **Edit Window Switch**: The Edit Window switch opens the Edit Window or brings it to the front.
- **Plug-in Window Switch**: The Plug-in Window switch opens and closes windows for any currently targeted plug-ins in the session. Hold Alt (Windows) or Option (Mac) to close all plug-in windows.
Session Management Section

The Session Management section includes controls for session-wide management and save operations.

Clear Clip Switch and Plug-in Clip Indicator

D-Control indicates occurrences of signal clipping on audio tracks, sends, and plug-ins. (Clip indication on D-Control follows the clip settings in the Pro Tools Display preferences.)

- If an audio track clips, its fader display lights red.
- If a send clips, the Send switch flashes in the channel’s Display Controls section. In addition, if the channel strip is displaying sends, the corresponding encoder display lights red.
- If a plug-in clips, the Insert switch flashes in the channel’s Display Controls section. In addition, if the channel strip is in top-level Inserts view, the corresponding encoder display lights red.

The Clear Clip switch lights if a clip occurs on an audio track or on a send anywhere in the session. The Plug-in Clip indicator lights if a clip occurs on a plug-in anywhere in the session.

Pressing the Clear Clip switch clears all peaks and clips in the session.

All Notes Off Switch

The All Notes Off switch can be used to silence stuck notes with MIDI devices. It sends an All Notes Off message to each channel for all connected MIDI devices.

QWERTY Disable Switch

The QWERTY Disable switch temporarily disables the computer keyboard on D-Control, to prevent the possibility of accidental key presses. When the keyboard is disabled, this switch lights.

The QWERTY Disable switch does not affect D-Control trackball operation.

Utility Switch

The Utility switch places D-Control in Utility mode. When D-Control is in Utility mode, this switch flashes.

Utility mode lets you view D-Control system information, name D-Control units, run D-Control diagnostic tests, and set certain D-Control hardware preferences. For complete information on Utility mode, see Appendix A, “Utility Mode.”

Publish Switch

The Publish switch executes the Send Session Via DigiDelivery command in Pro Tools, opening the Send To DigiDelivery dialog on-screen.

Save Switch

The Save switch executes the Save Session command in Pro Tools. Whenever a change is made in a session and the Save command is available, this switch lights.

To save the current session:

1. Press the Save switch. The switch flashes, prompting confirmation of the Save command.
2. Do one of the following:
   - To confirm the Save command, press the Save switch again.
   - To cancel the Save command, press Escape.

Redo Switch

The Redo switch executes the Redo command in Pro Tools.

Undo Switch

The Undo switch executes the Undo command in Pro Tools.
**Soft Keys Section**

The Soft Keys section provides access to a wide range of Pro Tools commands directly from the control surface. It also provides access to preferences and settings specific to D-Control. The section consists of six variable-function soft keys and displays, along with a matrix of mode switches that change the functions shown in the displays. When a function is shown in a Soft Key display, pressing the corresponding Soft Key switch activates that function.

**Default Soft Key Display**

When a session is first opened, the Soft Key displays show basic information about the session:

- Session Name
- Bit: Session Bit Depth
- Sampl: Session Sample Rate
- File: Session File Type
- Tcode: Session Time Code Rate
- Delay Compensation On/Off Status

Delay Compensation can be toggled on and off from this display. The other settings shown above cannot be changed from the Soft Keys section.

**Soft Keys Display with Pro Tools Dialogs**

When Pro Tools has a dialog on-screen, the two lower Soft Keys temporarily display “Escape” and “Enter,” letting you cancel or confirm the dialog from the control surface.

**Exiting from Soft Key Modes**

You can exit a Soft Key mode and return to the default Soft Key display by holding Control (Windows) or Command (Mac) and pressing the currently lit Soft Key switch.
Management Controls

Snap Switch
This function is currently not implemented for D-Control.

Group Switch
The Group switch displays the following commands:
- Create Edit: Create Edit Groups
- Suspnd: Suspend Groups
- Create Mix: Create Mix Groups
- Create Both: Create Mix and Edit Groups

Track Switch
The Track switch displays the following commands:
- New Track: Track > New
- Dup Track: Track > Duplicate
- Delete Selectd: Track > Delete
- Make Act/In: Track > Make Active/Inactive
- Bounce: File > Bounce To > Disk

Playlist Switch
The Playlist switch displays the following playlist commands:
- New: New Playlist
- Duplicate: Duplicate Playlist
- Delete Audio: Delete Unused Audio Playlists
- Delete MIDI: Delete Unused MIDI Playlists

Window Switch
The Window switch displays the following commands:

Page 1
- Auto Enabls: Window > Automation Enable
- Track Arm: Window > Machine Track Arming
- Strip Silnce: Edit > Strip Silence
- Sessn Setup: Setup > Session
- Task Managr: Window > Task Manager
- Project Browsr: Window > Project Browser

Page 2
- Color Pallet: Window > Color Palette
- Big Countr: Window > Big Counter
- Undo Histry: Window > Undo History
- Disk Space: Window > Disk Space
- Video Window: Window > Video
- System Usage: Window > System Usage

Page 3
- I/O Setup: Setup > I/O
- HW Setup: Setup > Hardware
- PB Engine: Setup > Playback Engine
- Disk Alloc: Setup > Disk Allocation
- Preferences: Setup > Preferences
- Peripherals: Setup > Peripherals

Edit Controls

Edit Function 1 Switch (Basic Edit Commands)
The Edit Function 1 switch displays the following commands:

Page 1
- Cut: Edit > Cut
- Copy: Edit > Copy
- Paste: Edit > Paste
- Clear: Edit > Clear
- TCE To TLSel: Edit > TCE Edit to Timeline Selection

Page 2
- CutSP AllAut: Edit > Cut Special > All Automation
- CopySP AllAut: Edit > Copy Special > All Automation
- CutSP PanAut: Edit > Cut Special > Pan Automation
- CopySP PanAut: Edit > Copy Special > Pan Automation
- CutSP PI Aut: Edit > Cut Special > Plug-in Automation
- CopySP PI Aut: Edit > Copy Special > Plug-in Automation

Page 3
- PsteSP Merge: Edit > Paste Special > Merge
- ClrSP AllAut: Edit > Clear Special > All Automation
- PsteSP RepFil: Edit > Paste Special > Repeat to Fill Selection
- ClrSP PanAut: Edit > Clear Special > Pan Automation
- PsteSP ToCurr: Edit > Paste Special > To Current Automation Type
- ClrSP PI Aut: Edit > Clear Special > Plug-in Automation

Edit Function 2 Switch
The Edit Function 2 switch displays the following commands:

Page 1
- Trim To Sel: Edit > Trim > To Selection
- Cpture Region: Edit > Capture Region
- Seprte Region: Edit > Separate Region
- Heal Seprtn: Edit > Heal Separation
- Consolidate: Edit > Consolidate Selection
- Time Stamp: Audio Regions List > Time Stamp Selected

Page 2
- SendTo Back: Region > Send to Back
- SendTo Front: Region > Bring to Front
- Group Region: Region > Group
- Ungrp Region: Region > Ungroup
- Ungrp All: Region > Ungroup All
- Regrp Region: Region > Regroup
Edit Function 3 Switch

The Edit Function 3 switch displays the following commands:

**Page 1**
- Duplicate: Edit > Duplicate
- Repeat: Edit > Repeat
- Shift: Edit > Shift
- Insert Silence: Edit > Insert Silence
- Lock Region: Region > Lock/Unlock
- Mute Region: Region > Mute/Unmute

**Page 2**
- Loop Region: Region > Loop Region
- Unloop Region: Region > Unloop Region
- ID/Rem SyncPT: Region > Identify/Remove Sync Point
- Rename Rgs: Region > Rename Regions
- Quantz ToGrid: Region > Quantize to Grid
- RgnDrop: Region List > Timeline Drop Order > L to R/Top to Bottom

Edit Modes Switch

The Edit Modes switch displays the Pro Tools Edit modes:
- Shuffle: Shuffle Mode
- Spot: Spot Mode
- Slip: Slip Mode
- Grid Rel: Relative Grid Mode
- Grid Abs: Absolute Grid Mode

Edit Tools Switch

The Edit Tools switch displays the Pro Tools Edit Tools. To cycle through multiple versions of the same tool, repeatedly press the corresponding Soft Key.
- Zoom: Normal/Single Zoomer tools
- Trim: Standard/Scrub/TCE Trimmer tools
- Select: Selector tool
- Grabbr: Time/Separation/Object Grabber tools
- Scrubber tool
- Pencil: Square, Random, Free, Line, Triangle, Arc, S-Curve

To select the Smart Tool, press any two buttons for the Trimmer, Selector or Grabber simultaneously.

Select/MIDI Controls

Bank Select Switch

The Bank Select switch (“Bank Sel”) sets the Soft Keys to mirror the selection in the Bank Select Matrix. When Bank Select is enabled, the Soft Keys show the names of the Mix/Edit Groups, Custom Groups, track types, or plug-in page numbers being controlled by the Bank Select Matrix.

Because the Bank Select Matrix has 12 switches, the Soft Keys display each bank of twelve in two pages of six. The Soft Key display is paged by repeatedly pressing the Bank Select switch in the Soft Keys section.

To page through the currently displayed bank in the Soft Keys:
- Press the Bank Select switch (“Bank Sel”) repeatedly to page through the current bank.

Memory Location Switch

The Memory Location switch (“Mem Loc”) displays the names of Memory Locations in pages of six. The Soft Key display is paged by repeatedly pressing the Memory Location switch in the Soft Keys section. To page backwards, hold Shift while pressing the Memory Location switch.

MIDI Switch

The MIDI switch displays the following commands:

**Page 1**
- Wait Note: Transport Window > Wait for Note button
- Count Off: Transport Window > Countoff button
- Merge Record: Transport Window > MIDI Merge button
- Transpose: Event > MIDI > Transpose
- Veloc: Event > MIDI > Change Velocity
- Click On/Off: Options > Click

**Page 2**
- Change Tempo: Change Tempo window
- Change Meter: Change Meter window
- Split Notes: Event > MIDI > Split Notes
- Select Notes: Event > MIDI > Select Notes
- Quantz: Event > MIDI > Grid/Groove Quantize
- Input Quantz: Event > MIDI > Input Quantize

**Page 3**
- Write PTProp: Track > Write MIDI Real Time Properties
- Remove DpNote: Event > Remove Duplicate Notes
Console Preferences

User Switch

The User switch lets you assemble a custom set of up to 12 Soft Key operations (six on each of two pages), providing quick access to frequently used commands or modes. You can add operations to either of the two available pages.

To add a Soft Key operation to the User Soft Key set:
1 In the Soft Keys section, press the User switch repeatedly to display the page (Page 1 or Page 2) where you want to add the operation.
2 Press the Soft Keys to display the page containing the operation you want to add.
3 Hold Control (Windows) or Command (Mac) and press the Soft Key for the operation.

The operation is appended to the list of User Soft Key operations on the chosen User page.

To remove a Soft Key operation from the User set:
1 In the Soft Keys section, press the User switch repeatedly to display the operation you want to remove.
2 Hold Control (Windows) or Command (Mac) and press the Soft Key for the User operation.

Meter Switch

Meter Switch (Page 1)

The Meter switch displays the D-Control metering preferences, in pages of six. The Soft Key display is paged by repeatedly pressing the Meter Prefs switch in the Soft Keys section.

The Meter switch control D-Control meters only, and do not affect the Pro Tools on-screen display.

SndMtr (Send Meters) Toggles send metering on channel rotary encoders on and off.

InsMtr (Insert Meters) Toggles plug-in metering on channel rotary encoders on and off.

Meters Toggles channel metering between pre- and post-fader modes.

CtrMtr (Center Meters) Toggles the 8-channel meter display on the Main Unit meter bridge between main output levels and the focused track.

GrChan (Gain Reduction Channel Display) Sets channel meters to display dynamics plug-in gain reduction when the plug-in is focused on a channel strip.

RefLvl (Reference Level) Lets you change the D-Control meter display to help monitor program material with respect to different reference levels.

Meter Switch (Page 2)

GRPrio (Gain Reduction Priority) When a multi-function Compressor/Limiter or Expander/Gate plug-in is used, this preference determines which function (“CompLm” or “ExpGat”) has metering priority when encoder LED rings and channel meters are set to display dynamics plug-in gain reduction.

Operation Switch

The Operation switch controls behaviors that are specific to D-Control, and that do not affect the Pro Tools on-screen display. For details on setting operation preferences, see “Setting D-Control Preferences” on page 40.

Operation Switch (Page 1)

BnkJus (Bank Justification) Determines whether banks of channels in Normal mode are justified at the left, left center (to the left of the Main Unit), right center, (to the right of the Main Unit) or right side of the control surface.

Rotary (Rotary Encoder Mode) Determines responsiveness of rotary encoder knobs. Fixed mode is at normal resolution. The velocity modes set different rates of encoder acceleration. In Fine mode, response is fixed and at fine resolution.

LCFJst (Left Custom Fader Justification) Determines whether the Custom Faders controlled by the left Custom Faders section are placed at the left, left center, right center, or right of the Main Unit.

RCFJst (Right Custom Fader Justification) Determines whether the Custom Faders controlled by the right Custom Faders section are placed at the left, left center, right center, or right of the Main Unit.

LMMaxCF (Left Maximum Custom Fader Bank Size) Determines the number of channels to be used when displaying channels in the Left Custom Fader Bank. Options are multiples of 8 channels, from zero (no Left Custom Fader Bank) up to the maximum number of channels on the system.

RMMaxCF (Right Maximum Custom Fader Bank Size) Determines the number of channels to be used when displaying channels in the Right Custom Fader Bank. Options are multiples of 8 channels, from zero (no Right Custom Fader Bank) up to the maximum number of channels on the system.
Chapter 9: Management Sections

Operation Switch (Page 2)

PanBot (Pan on Lower Encoder) Determines whether Pan controls are displayed on the bottom encoder of each channel, even when another type of controls is displayed on the upper encoders.

For stereo tracks, the encoder shows by default L (left channel). To change to the R channel, press Select.

Encod (Encoder Order) Determines whether inserts, sends, and pan controls will be displayed in order from top-to-bottom or bottom-to-top on D-Control rotary encoders.

ApTrgt (Target Track from Application) Determines whether selecting an Insert or Send on-screen focuses its track on the D-Control Main Unit.

Faders (Faders On/Off) Temporarily turns off D-Control faders to prevent fader movement when monitoring a mix.

ChanWin (Channel Window Display) Determines whether displaying plug-in or send pan parameters (by pressing an encoder Select switch) on D-Control opens the corresponding plug-in or send window on-screen in Pro Tools. Also determines whether the Channel Select switches (in the Dynamics or EQ sections) change the channel display of multi-mono plug-ins.

➢ When this preference is set to “Yes,” the on-screen display of plug-in and send windows changes to reflect the state of the control surface.

➢ When this preference is set to “No,” the on-screen display of plug-in and send windows does not change to reflect the state of the control surface.

Select (Select Switch Latch Mode) Determines whether channel Select buttons follow latching or exclusive-or (non-latching) behavior when in Select mode.

Operation Switch (Page 3)

Import PIMaps (Import Plug-in Maps) Opens “Choose a mapping file” dialog in Pro Tools.

Export PIMaps (Export Plug-in Maps) Opens “Save Plug-in Mapping As” dialog in Pro Tools.

TchVal (Touch Display of Parameter Values On/Off) Turns off the display of parameter values when faders or encoders are touched.

CFTrks (Custom Faders Display Hidden Tracks) Determines whether tracks that are hidden in Pro Tools are displayed or hidden in Custom Fader modes. Tracks that are hidden in Pro Tools but shown in Custom Faders cannot be Selected or Record enabled.

Brdcst (Broadcast) Determines whether the XMON monitoring system is in Broadcast mode, which prevents AFL and PFL solo modes from changing the XMON Control Room Input source.

Trk/Ed (Link Track and Edit Selection) Toggles the Options > Link Track and Edit Selection option, which automatically selects a track or range of tracks when a selection is made in the track’s timeline.
**Automation Controls**

**AutoMatch Switch**

The AutoMatch switch activates the AutoMatch command in Latch or Write automation modes.

**Join Switch**

The Join switch is used in Latch mode to resume writing of automation on all channels that were previously writing automation, after an interrupted automation pass.

**AutoJoin Switch**

The AutoJoin switch is used in Latch mode to automatically resume writing of automation after the transport is stopped and started again during an automation pass.

**Actions Switch**

The Actions switch displays the following commands:

**Actions Switch (Page 1)**

- **Wrt To Start (Write To Start)** Writes current automation values from the insertion point backward to the beginning of a selection or track while performing an automation pass.
- **Wrt To All (Write to All)** Writes current automation values to an entire selection or track while performing an automation pass.
- **Wrt To End (Write to End)** Writes current automation values from the insertion point forward to the end of a selection or track while performing an automation pass.
- **Wrt To Next (Write to Next Breakpoint)** Writes current automation values from the insertion point forward to the next automation breakpoint while performing an automation pass.
- **Snap Back** Causes all Latch or Write enabled tracks to exit their current automation pass and return instantly to the previously written automation levels. During playback, stops writing of automation without applying any AutoMatch ramping.

**Actions Switch (Page 2)**

- **Wrt To Current (Write To Current Parameter)** Writes the current control value to the currently displayed automation parameter (Edit > Automation > Write To Current).
- **Wrt To All Ena (Write To All Enabled Parameters)** Writes current control values to all enabled automation parameters (Edit > Automation > Write To All Enabled).
- **Trm To Current (Trim To Current Parameter)** Applies the current trim value to the currently displayed automation parameter (Edit > Automation > Trim To Current).
- **Trm To AllEna (Trim To All Enabled Parameters)** Applies current trim values to all enabled automation parameters (Edit > Automation > Trim To All Enabled).
- **Gld To Current (Glide To Current Parameter)** Applies a transition between automation values to the currently displayed automation parameter (Edit > Automation > Glide To Current).
- **Gld To AllEna (Glide To All Enabled Parameters)** Applies a transition between automation values to all enabled automation parameters (Edit > Automation > Glide To All Enabled).

**Actions Switch (Page 3)**

- **Copy To Send** Opens the Copy To Send dialog to allow copying of track control values to each selected track’s send (Edit > Automation > Copy To Send).
- **Thin Auto (Thin Automation)** Performs the Thin Automation command. (Edit > Automation > Thin).
Modes Switch

The Modes switch displays the following modes:

**AWrtTo Start (Auto Write to Start on Stop)** Automatically writes current automation values from the insertion point backward to the beginning of a selection or track when the transport is stopped after an automation pass.

By default, Automatic Write to Start on Stop mode is enabled for a single automation pass only. Hold Start+Alt (Windows) or Control+Option (Mac) while pressing the Auto ToStrt switch to configure the mode to remain enabled after an automation pass.

**AWrtTo All (Auto Write to All on Stop)** Writes current automation values to an entire selection or track when the transport is stopped after an automation pass.

By default, Automatic Write to All on Stop mode is enabled for a single automation pass only. Hold Start+Alt (Windows) or Control+Option (Mac) while pressing the Auto ToAll switch to configure the mode to remain enabled after an automation pass.

**AWrtTo End (Auto Write to End on Stop)** Writes current automation values from the insertion point forward to the end of a selection or track when the transport is stopped after an automation pass.

By default, Automatic Write to End on Stop mode is enabled for a single automation pass only. Hold Start+Alt (Windows) or Control+Option (Mac) while pressing the Auto ToEnd switch to configure the mode to remain enabled after an automation pass.

**AWrtTo Next (Auto Write to Next Breakpoint on Stop)** Writes current automation values from the insertion point forward to the next automation breakpoint when the transport is stopped after an automation pass.

Prefs Switch

The Prefs switch displays the following preferences:

**Match Time** Determines the AutoMatch Time, or the amount of time it takes for automation values to return to the previously written value after an automation pass stops.

**Glide Time** Determines the AutoGlide Time, or the amount of time it takes for surround pan values to move between two points in an automation pass performed with the optional D-Control surround panner.

Audio Files Switch

The Audio Files switch displays the following commands for importing and exporting data into Pro Tools:

- Import Audio: File > Import > Audio
- Import MIDI: File > Import > MIDI
- Audio To Trk: File > Import > Audio To Track
- MIDI To Trk: File > Import > MIDI To Track
- Import SesDat: File > Import > Session Data
- Export Selctd: Regions List > Export Selected As Files

Show/Hide Switch

The Show/Hide switch displays commands from the Show/Hide Tracks List menu.

**Show/Hide Switch (Page 1)**

- Show All: Show All Tracks
- Hide All: Hide All Tracks
- Show Selctd: Show Only Selected Tracks
- Hide Selctd: Hide Only Selected Tracks
- Show Inactv: Show Only Inactive Tracks
- Hide Inactv: Hide Only Inactive Tracks

**Show/Hide Switch (Page 2)**

- Show Audio: Show Only Audio Tracks
- Hide Audio: Hide Only Audio Tracks
- Show Aux: Show Only Auxiliary Inputs
- Hide Aux: Hide Only Auxiliary Inputs
- Show MIDI: Show Only MIDI Tracks
- Hide MIDI: Hide Only MIDI Tracks

**Show/Hide Switch (Page 3)**

- Show Instmt: Show Only Instrument Tracks
- Hide Instmt: Hide Only Instrument Tracks

You can select multiple Show/Hide categories by holding Shift while pressing the corresponding Soft Key.
Miscellaneous Controls Section

The Miscellaneous Controls section includes controls for basic Pro Tools editing and display functions.

Main and Sub Counter Switches
The Main and Sub Counter switches cycle through the time code display modes (Bars:Beats, Min.Secs, Time Code, Feet+Frames and Samples) on the corresponding counter.

Link Edit and Timeline Switch
The Link Edit and Timeline switch toggles the Link Edit and Timeline Selection command on and off. The switch is lit when the selections are linked.

Location Start/End/Length Switches
The Start/End/Length switches select the corresponding values in the Selection indicators. New values can be typed and confirmed by pressing Return.

Edit/Timeline Switch and Indicators
The Edit/Timeline switch toggles the Selection indicator values and the D-Control transport function between the edit selection and the timeline selection. The indicators above the switch light to show which is displayed. If Edit and Timeline Selections are linked, these values will be the same.

Edit Modes
The Edit Mode switches place Pro Tools directly in the corresponding Edit mode. The switch lights to indicate the current mode.

Shuffle Switch Places Pro Tools in Shuffle mode.
Spot Switch Places Pro Tools in Spot mode.
Slip Switch Places Pro Tools in Slip mode.
Grid Switch Toggles Pro Tools between Absolute and Relative Grid mode.

Edit Functions
The Edit Function switches directly execute the corresponding command in Pro Tools. The switches light to indicate which functions are available.

Cut Switch Cuts the current edit selection.
Copy Switch Copies the current edit selection to the Clipboard.
Paste Switch Pastes the current Clipboard contents.
Repeat Switch Pastes the current Clipboard contents end-to-end the specified number of times.
**Track Size Switches**

The Track Size Up and Down switches increase and decrease the height of all tracks where a selection or edit cursor is present.

**Explode Switch**

The Explode switch invokes the Zoom Toggle command in Pro Tools, which zooms in on the current edit selection and sets the track height to the size specified in the Pro Tools Display preferences.

**Go To Switch**

The Go To switch is used to focus a specific track onto the Focus Channel Strip on the Main Unit.

**To go to a specific track:**

1. Press the Go To switch.
2. Enter the track position number for the track and press Enter.
Chapter 10: Monitor and Meter Sections

Monitor Section Controls

The Monitor section includes a full set of controls for the control room monitoring, headphone/cue, and talkback/listenback sections of D-Control. All input and output connections to the D-Control monitoring system are made on the XMON interface, which is connected to the D-Control console with the XMON cable, and remotely controlled from this section.
Control Room Monitoring System

The Control Room Monitoring system is an 8-channel system with six input sources (two 8-channel surround, four stereo), and three available outputs (two 8-channel surround, one stereo).

Input sources are selected with dedicated switches, and can be combined in a special sum mode to allow monitoring of multiple inputs at the same time.

Control Room outputs are activated with dedicated switches and level controls, including a Dim function for momentary level reduction.

Control Room Input Source Selectors

Input Source Switches

The Control Room monitor system has six input sources:
- Main Inputs (8 channels)
- Surround Inputs (8 channels)
- Stereo 1 Inputs (2 channels)
- Stereo 2 Inputs (2 channels)
- Stereo 3 Inputs (2 channels)
- Stereo 4 Inputs (2 channels)

These sources are selected by pressing their corresponding Input switches, which light when the source is activated.

Input Level Trim Mode

Each input source can be trimmed independently, to allow for setting of different reference levels or to compensate for differences in gain structure. Available trim values range from –20 dB to +10 dB in 0.5 dB steps.

To trim input levels:
1. Press and hold the Input Source Selector switch for the input you want to trim, until the switch flashes.
2. Turn the Main Output Level encoder knob to set the trim value. The monitor section display shows “Trim” and the trim value in dB.
3. Press the flashing Input Source Selector switch to exit Trim mode.

Sum Switch

In normal operation, the Control Room Input Source switches follow exclusive-or (non-latching) behavior, allowing only one source to be monitored at a time.

However, D-Control has a Sum mode that allows multiple input sources to be monitored at the same time. When Sum mode is on, multiple input source switches can be active.

Sum mode ignores any input trim values when it is active.

To add or remove inputs in Sum mode:
1. Press the Sum switch. The switch lights to indicate Sum mode is on.
2. Press any number of Input Source switches to toggle their corresponding inputs on or off. It is possible to turn all inputs off in this mode.

To exit Sum mode:
- Press the Sum switch again. Monitoring reverts to the input that was selected when you entered Sum mode.
Chapter 10: Monitor and Meter Sections

Control Room Output Controls

Output On/Off Switches

The Control Room monitor system has three outputs:
- Main Control Room Outputs (8 channels)
- Alt Control Room Outputs (8 channels)
- Mini Control Room Outputs (2 channels)

Only one output can be active at a time. The Output On/Off switches follow exclusive-or (non-latching) behavior. When you activate an output, its name and gain value (in dB) are shown in the monitor section display.

Output Level Controls

Each of the three Control Room Outputs has a touch-sensitive rotary encoder for control of output level. When any of these encoder knobs is touched, the monitor section display shows the output name and its current level in dB. Gain ranges from a minimum level of –INF to a maximum level of +10 dB, in 1 dB steps.

Output Level Trim Mode

Each output level control can be trimmed independently, to allow for setting of different reference levels or to compensate for differences in gain structure. Available trim values range from –20 dB to +10 dB, in 0.5 dB steps.

To trim output levels:
1. Press and hold the On/Off switch for the output you want to trim, until the switch flashes.
2. Turn the corresponding encoder knob to set the trim value. The monitor display shows “Trim” and the trim value in dB.
3. Press the flashing On/Off switch to exit Trim mode.

Dim Level Control

The Dim Level control lets you adjust the amount of level reduction applied by the Dim switch, located at the bottom of the Monitor section. Level reduction ranges from –30 dB to 0 dB, in 1 dB steps.

When the Dim encoder knob is touched, the monitor section display shows “Dim” and the gain reduction in dB.

Monitor Output Mode Controls

Setup Switch

This function is currently not implemented for D-Control.

Calibration Mode Switch

The Calibration Mode switch invokes a mode that changes the output value displayed by the Monitor section display from gain (expressed in dB) to sound pressure level (expressed in dB SPL) for each of the control room outputs. This switch lights when an SPL value is shown for the active output.

To display output levels in dB SPL, you must first calibrate each output. This SPL calibration requires the use of a pink noise source (or other reference material) and a sound pressure level meter to measure the output of individual control room speakers.

To calibrate Control Room outputs to display SPL:
1. Send the reference material to the Main Control Room Outputs, and set the output level in Pro Tools to your studio reference level (for example, –18 dBFS).
2. Pan the signal to center (so that equal level is sent to all Main Control Room Output speakers).
3. Set the speaker-to-speaker balance for all speakers in the system using Output Trim mode for each channel, using the sound pressure level meter to measure SPL at the mix position. See “Individual Output Trim Mode” on page 107.
4. Solo the Center speaker, and adjust the Main Control Room Output level encoder until the sound pressure level meter measures the target reference level (for example, 85 dB) at the mix position. You can Output Level Trim mode for fine adjustment of the output level. See “Output Level Trim Mode” on page 105.
5 Press and hold the Calibration Mode switch until it flashes.

6 Adjust the Main Control Room Output level encoder until the target reference level is displayed in the Monitor Section display.

7 Press the flashing Cal switch.

8 Repeat steps 4–7 for the Alt and Mini outputs.

To toggle the output display between dB and dB SPL:
1. Select the output whose display you want to toggle (Main, Alt, or Mini).

2. Do one of the following:
   - To display output in dB SPL, press the Calibration Mode switch so that it is lit.
   - or –
   - To display output in dB, press the Calibration Mode switch so that it is unlit.

Mono Switch
The Mono switch mixes the Left and Right signals of any of the output modes (any surround channels are not affected) to provide mono output, useful for checking phase and balance relationships. The Mono switch lights to indicate that it is active.

Mono Trim Mode
Mono output can be trimmed to adjust its reference level in comparison to other outputs. Available trim values range from –12 dB to 0 dB, in 0.5 dB steps.

To trim mono output:
1. Press and hold the Mono switch until it flashes.

2. Turn Alt Output encoder knob to set the Mono trim value. The monitor display shows “Trim” and the trim value in dB.

3. Press the flashing Mono switch to exit Trim mode.

Dim Switch
The Dim function applies an adjustable gain reduction to the Control Room outputs. This function affects all three output destinations. The Dim switch toggles the dim function on and off, and lights to indicate that it is active.

The amount of gain reduction is set with the Dim Level control, located at the top right of the Control Room Output section.

Mute Switch
The Mute switch toggles the mute state for all Control Room outputs. Mute operates globally on all three output destinations. The Mute switch lights to indicate that it is active.

If the Mute switch on the XMON interface front panel is activated, the Mute switch on D-Control must be used to unmute the monitor system. (Outputs cannot be unmuted from XMON front panel.)

Monitor Displays
When any rotary encoder knob in the Monitor section is touched, the LED displays show the name of the control and its value.
Output Channel Select Controls

Channel Select Switches

The Channel Select switches let you solo or mute individual channels of the Control Room outputs. The function of the Channel Select switches depends on the mode of the Solo/Mute switch.

- When the mode is set to Solo, each Channel Select switch solos the corresponding output channel.
- When the mode is set to Mute, each Channel Select switch mutes the corresponding output channel.

In both modes, the Channel Select switches follow latched behavior, allowing multiple outputs to be soloed or muted. The Channel Select switches light to indicate that they are active.

There are Channel Select switches for the following channels:

- L (Left)
- Lc (Left Center)
- C (Center)
- Rc (Right Center)
- R (Right)
- Ls (Left Surround)
- Cs (Center Surround)
- Rs (Right Surround)
- LFE

These choices support all possible channel configurations in Pro Tools. A maximum of eight channels (7.1 surround) may be in use at any time.

Individual Output Trim Mode

Each output channel can be trimmed individually for each of the three control room outputs (Main, Alt, and Mini), allowing you adjust the channel balance for each set of control room speakers. Trim values are stored for each of the three outputs. Available trim values range from –30 dB to +10 dB, in 0.5 dB steps.

To trim the output level for an individual output channel:

1. Activate the control room output (Main, Alt, or Mini) whose channel levels you want to trim.
2. Press and hold the Channel Select switch for the output channel you want to trim, until the switch flashes.
3. Turn the Main Output encoder knob to set the trim value for the channel. The monitor display shows “Trim” and the trim value in dB.
4. Press the flashing Channel Select switch to exit Trim mode.
5. Repeat the above steps for each output channel and each set of outputs (Main, Alt, or Mini) you want to trim.

Solo/Mute Switch and Indicators

The Solo/Mute switch toggles the function of the Channel Select switches between Solo and Mute modes. The indicators light to indicate which mode is active.
Solo Mode Controls

The Solo function has three available modes: Solo in Place (SIP), After-Fader Listen (AFL) and Pre-Fader Listen (PFL).

- **SIP** mode mutes all unsoloed tracks, causing the soloed tracks to be auditioned alone in the main mix. The XMON Control Room Input source remains unchanged, so you can monitor the soloed channels in the Main control room monitors.

- **AFL and PFL** modes send signal to a separate output path with independently adjustable levels for each mode. The XMON Control Room Input source is automatically changed to monitor the AFL/PFL input, unless you put D-Control in Broadcast mode (see “Broadcast Mode for AFL and PFL Monitoring” on page 108). This lets you monitor the soloed channels in the Main control room monitors (with Broadcast mode off) or in a dedicated solo monitoring system (with Broadcast mode on).

⚠ **AFL and PFL Solo modes require the use of the Surround Mixer plug-in.**

To select the Solo mode:

- Press the SIP, AFL, or PFL switch in the D-Control Monitor section to select the corresponding Solo mode.

**Setting AFL and PFL Levels**

Levels can be set separately for AFL and PFL modes from the D-Control Monitor section.

💡 **AFL or PFL levels can be adjusted even if no channels are currently soloed.**

To set the AFL or PFL level:

1. Press the AFL or PFL switch in the D-Control Monitor section.
2. Turn the AFL/PFL rotary encoder. The AFL/PFL level is shown in the Monitor displays.

To set the AFL or PFL level to its default setting:

1. Press the AFL or PFL switch in the D-Control Monitor section.
2. Hold Alt (Windows) or Option (Mac) and touch the AFL/PFL rotary encoder.

**Broadcast Mode for AFL and PFL Monitoring**

You can put the D-Control monitoring system in Broadcast mode, which prevents AFL and PFL solo modes from changing the XMON Control Room Input source. This lets you solo channels while preserving the main monitor mix.

You can then use the AFL/PFL path selector in the I/O Setup dialog to route the AFL/PFL solo signal directly from the HD Audio Interface to a separate set of speakers or headphones.

To put the XMON monitoring system in Broadcast mode:

1. Press the Operation switch in the Soft Key section.
2. Press the Soft Key that corresponds to “Broadcast” to set the option to “On.”

While in Broadcast mode, any channels soloed while in AFL or PFL are still sent to the AFL/PFL path, but XMON does not switch the Control Room Input source to monitor that path.

While in Broadcast mode, any channels soloed while in SIP mode will still cause all other tracks to be muted.

**Solo Latch Options**

The three solo latch options can be selected directly from the D-Control Monitor section. These options apply to all three Solo modes (SIP, AFL and PFL).

- **Latch** When this option is selected, pressing subsequent channel Solo switches adds the channels to the Solo output.
- **X–OR** When this option is selected, pressing subsequent Solo switches cancels previous solos.
- **Momentary** When this option is selected, you can temporarily solo any number of channels by holding a single channel Solo switch and pressing any additional channel Solo switches. When you release the held Solo switch, all solos are cleared.

To override X–OR mode and solo more than one track at a time, press and hold the Solo button on the first track. Subsequently pressed Solo switches will latch.
Headphone/Cue System

The Headphone/Cue system is a two-channel system with four stereo input sources and five available stereo outputs.

Headphone/Cue Output Controls

The Headphone/Cue system has five available outputs:
- Cue 1 (2 channels)
- Cue 2 (2 channels)
- Cue 3 (2 channels)
- Headphone (2 channels)
- Studio Loudspeaker (2 channels)

The three Cue Outputs, Headphone Output, and Studio Loudspeaker Output can be active in any combination, including all on or all off. The On/Off switches light to indicate that an output is active.

You have the option of adding talkback signal to any of these cue outputs independently.

Headphone/Cue Level Controls

Each of the five outputs in the Headphone/Cue system has a touch-sensitive rotary encoder for control of output level. When any of these encoder knobs is touched, the monitor section display shows the name of the output and its current level in dB. Gain ranges from a minimum level of –INF to a maximum level of +10 dB, in 1 dB steps.

In addition, when any of these encoder knobs is touched, the Cue Input Source Selectors display the current input source and talkback assignment for the corresponding output. You can then edit the input source and talkback assignment for the displayed output. The output does not need to be active to display or change these assignments.

Headphone/Cue Talkback Dim Function

When talkback is engaged, an independent Dim function is automatically applied to the Headphone/Cue outputs. The amount of gain reduction is set from this section.

To set the gain reduction value for the Headphone/Cue Dim Function:

1. Press and hold the Talkback Assign switch until it flashes.
2. Turn the Main Output encoder knob to set the Dim value for the channel. The monitor display shows “TB Dim” and the gain reduction value in dB.
3. Press the flashing Talkback Assign switch.
4. Repeat the above steps for each output channel and each set of outputs (Main, Alt, or Mini) you want to trim.
Cue Input Source Selectors

Cue Input Source Switches

The Headphone/Cue monitor system has four input sources:

- Cue 1 Input (2 channels)
- Cue 2 Input (2 channels)
- Cue 3 Input (2 channels)
- Main Monitor Input (2 channels)

These input sources are routed to applicable outputs with the Cue Input Source switches, which light when the corresponding input source is active for a given output.

The table below shows possible outputs for each input source. (Talkback can be added to each of the outputs.)

<table>
<thead>
<tr>
<th>Input</th>
<th>Possible Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cue 1</td>
<td>Cue 1, HP, Studio LS</td>
</tr>
<tr>
<td>Cue 2</td>
<td>Cue 2, HP, Studio LS</td>
</tr>
<tr>
<td>Cue 3</td>
<td>Cue 3, HP, Studio LS</td>
</tr>
<tr>
<td>Main Monitor</td>
<td>Cue 1, Cue 2, Cue 3, HP, Studio LS</td>
</tr>
</tbody>
</table>

Assign Talkback Switch

The Assign Talkback switch lets you add the talkback signal to any of the Headphone/Cue system outputs. The Assign Talkback switch lights to indicate that talkback is active for a given output.

Headphone Outputs

A Headphone output is located on the underside of the D-Control Main Unit, near the front right side. The other four pairs of headphone outputs are available on the XMON interface.

Talkback/Listen System

Talkback and Listen controls

The Talkback/Listen system has two talkback microphone inputs with independent level controls, and two Listen microphone inputs with a shared level control.

Talkback Controls

The Talkback system has two talkback microphone inputs (one external, one built-in) each with a touch-sensitive rotary encoder for control of output volume. When either of these encoders is touched, the monitor section display shows the name of the input and its current volume level in dB. Level control on each ranges from a minimum level of –INF to a maximum level of +30 dB.

External Talkback Level Control

The External Talkback Level control adjusts the volume for the external talkback microphone. When this encoder knob is touched, the monitor section display shows “Ext TB” and the level in dB.

Talkback Level Control

The Talkback Level control adjusts the volume of the built-in (Internal) microphone, located on the meter bridge of the D-Control Main Unit. When this encoder knob is touched, the monitor section display shows “Int TB” and the level in dB.
**Talkback Dim Function**

When Talkback is engaged, the Dim function (as set by the Dim Level control in the Control Room Output section) is automatically applied to the Main outputs. Any adjustment of the Dim Level control affects both the Talkback Dim function and the Control Room Output Dim function. When Talkback is engaged, the Dim switch in the Monitor Output Mode section lights.

**Auto Talkback Switch**

The Auto Talkback switch activates a mode in which the talkback and listen microphones are automatically turned on whenever the Pro Tools transport is not in Play or Record. When Auto Talkback is active, the Auto Talkback switch lights, and the Talkback switches flash.

While in Auto Talkback mode, you can temporarily disable and re-enable talkback, while staying in Auto Talkback mode.

- **To temporarily disable Talkback while in Auto Talkback mode:**
  - Press either of the flashing Talkback switches.

- **To re-enable talkback while in Auto Talkback mode:**
  - Double-press either Talkback switch so it flashes again.

**Talkback Switch**

Two Talkback switches, located at the bottom of each Channel Strip Master section on the Main Unit, provide control of the D-Control Talkback function.

The Talkback switches can follow momentary or latched behavior. If held, the switch is active only when pressed down.

If rapidly double-pressed, the switch latches on and flashes to indicate that talkback is active. Press the switch again to turn off talkback.

**Listen Controls**

The Listen system has two selectable microphone inputs, with a shared touch-sensitive rotary encoder for level control.

**Listen Mic Level Control**

The Listen Mic Level control adjusts the volume for the selected listen microphone input, Mic 1 or Mic 2. When this encoder knob is touched, the monitor section display shows the input name “Lstn 1” or “Lstn2” and the level in dB. When both inputs are active, the monitor section display shows both input names and levels.

When one input is active, the encoder controls the level of that input independently. When both inputs are active, the encoder controls both levels simultaneously, maintaining any relative offset between the two.

Level control ranges from a minimum level of –INF to a maximum level of +30 dB.

**Listen Mic Select Switches**

There are two Listen Mic Select switches for the external listen microphone inputs:

- Mic 1
- Mic 2

Either or both of these inputs can be active at any time. If neither input is active, the Listen Mic Level control can still be adjusted, to prepare for the next time an input is activated.
Meter and Time Code Displays (Main Unit)

Meters

The meter bridge on the Main Unit includes eight 32-segment LED bar graphs for displaying output levels or the level of the track focused in the Focus Channel Strip, depending on the D-Control Meter Preferences setting. The top LED is red and indicates clipping on the corresponding channel.

For details on setting meter preferences, see “Meter Preferences” on page 43.

Time Scale and Location Displays

The five displays on the Main Unit mirror the Main and Sub Time Scales, and the Selection Start, End and Length indicators in Pro Tools.

Time Code Display Format Indicators

The indicators to the left of the Time Code displays show the currently displayed Time Code format for both the Main Time Scale and the Sub Time Scale. Formats include:

- Hours:Minutes:Seconds:Milliseconds
- Hours:Minutes:Seconds:Frames
- Feet+Frames
- Bars|Beats

Talkback Microphone

The built-in D-Control talkback microphone is located between the Meters and the Time Scale displays.
The meter displays on each Fader Module feature dual 32-segment LED bar graphs for each channel, and can display pre- or post-fader levels depending on the D-Control Meter Preferences setting. In Custom Fader mode, these meter displays can show plug-in input and output meters, gain reduction meters for Dynamics plug-ins, and other parameters. The top LED is red and indicates clipping on the corresponding channel or parameter.

Setting D-Control Meters for Different Reference Levels

The Pro Tools Reference Level meter preference lets you change the D-Control meter display to help monitor program material with respect to different reference levels.

At each setting except 0 dB, a single LED lights continuously across the meter bridge at a fixed point to indicate that reference level. You can then compare the peaks of the program material to the indicated level.

The following reference level settings are available:

- **0 dB** This is the normal setting used for referencing material to a 0 dB (full code) reference level.
- **–14 dB** This reference level setting lights a single amber LED at –14 dB across the meter bridge.
- **–18 dB** This reference level setting lights a single amber LED at –18 dB across the meter bridge.
- **–20 dB** This reference level setting lights a single amber LED at –20 dB across the meter bridge.
- **B–20 dB** This reference level is designed specifically for broadcast applications, with a lower threshold for the change to amber. The settings lights a single amber LED at –20 dB across the D-Control meter bridge. This mode also changes the meter LED colors: LEDs above –20 dB through –13 dB are green, and the LEDs from –12 dB to 0 dB are amber, with 0 dB remaining red.

To set a D-Control meter reference level:

1. In the Soft Keys section, press the Meter switch.
2. Press the Soft Key that corresponds to “RefLvl” to cycle among the meter reference level settings.
3. Press the Meter Prefs 1 switch to exit.
Chapter 11: Operating Modes

The power and flexibility of D-Control lies in its different operating modes, which let you customize the behavior of its channel strip controls to fit your workflow.

The two types of D-Control operating modes are Normal mode and the four Custom Fader modes. This section provides an overview of each mode and its associated commands.

Normal Mode

In Normal mode, Pro Tools tracks are displayed on D-Control in a standard console format. In this mode, each channel strip corresponds to a track in the session, and most of the channel strip controls correspond directly to on-screen controls or views in Pro Tools:

- Channel Fader controls channel volume
- Channel Display shows track name, and track volume when fader is touched
- Pan switch shows Pan values on encoders (this is the default view when a new track is created)
- Inserts switch shows name of each Insert on encoders
- Sends switch shows name of Send and Send level on encoders
- Pre switch shows controls for the channel’s Pre on encoders
- Dyn switch cycles through dynamics plug-ins on the track
- EQ switch cycles through EQ plug-ins on the track

Assigning Elements to Tracks

You can assign Inputs, Outputs, Inserts, and Sends to tracks directly from D-Control by entering a temporary Assign mode.

To assign an input, output, send or insert:

1. Press an Assign switch to enter the corresponding Assign mode.
2. On the channel where you want to make the assignment, turn an encoder knob to select from the first level of menu choices.
3. Press the encoder Select switch to move down and the Bypass/Mute/Pre switch to move up through menu levels.
4. Press the flashing encoder Select switch or press the flashing Assign switch to confirm the assignment.

To assign multiple inputs, outputs, sends, or inserts:

1. Press an Assign switch to enter the corresponding Assign mode.
2. Turn the encoder knobs and use the encoder Select and Bypass/Mute/Pre switches to select each assignment.
3. Press the flashing Assign switch to confirm all the assignments at once.

To remove an input, output, send or insert:

1. Press an Assign switch to enter the corresponding Assign mode.
2. For the assignment you want to remove, press the encoder Bypass/Mute/Pre switch repeatedly until you reach the top level menu for the assignment.
3. Turn the encoder knob counter-clockwise until no assignment is visible.
4. Do one of the following:
   - Press the flashing encoder Select switch or press the flashing Assign switch to confirm the removal.
   - or –
   - Press the flashing Escape switch to cancel the removal and restore the assignment.

Assigning Inputs in Sessions with Multiple Plug-in Outputs

In sessions with plug-ins that have multiple outputs, the auxiliary outputs of those plug-ins are available as inputs in other audio and Auxiliary Input tracks. These appear as a third category of inputs, labelled plug-ins, in the track input menu.

When assigning inputs from D-Control, this third category of inputs appears as a top-level menu choice.

To assign an input from a plug-in output:

1. Press the Assign Inputs switch.
2. On the channel where you want to make the assignment, turn an encoder knob to select Plug-in from the first level of menu choices.
3 Press the encoder Select switch to move down to the individual plug-in level.

4 Turn the encoder knob to select the plug-in whose auxiliary output you want to select.

5 Press the encoder Select switch to move down to the list of plug-in auxiliary outputs.

6 Do one of the following:
   • Press the flashing encoder Select switch or press the flashing Assign Inputs switch to confirm the assignment.
   – or –
   • Press the flashing Escape switch to cancel the assignment.

Assigning Inserts and Sends Directly from a Channel

You can assign Inserts or Sends directly to individual channels without entering global Assign mode.

To assign an individual insert or send:
1 On the channel where you want to make the assignment, press the Inserts or Sends switch to display the corresponding elements on the channel’s encoders.

2 Press the Select switch on the encoder where you want to make the assignment. The encoder scribble strip shows a right arrow (“> – –”) to indicate the encoder is in Assign mode.

3 Turn the corresponding encoder knob to select from the first level of menu choices.

4 Press the encoder Select switch to move down and the Bypass/Mute/Pre switch to move up through menu levels.

5 Do one of the following:
   • Press the flashing encoder Select switch to confirm the assignment.
   – or –
   • Press the flashing Escape switch to cancel the assignment.

To change a previously assigned insert or send:
1 On the channel where you want to change the assignment, press the Inserts or Sends switch to display the corresponding elements on the channel’s encoders.

2 Press and hold the encoder Select switch for the insert or send you want to change, until the encoder scribble strip shows a right arrow (“>”) next to the assignment to indicate the encoder is in assign mode.

3 Turn the corresponding encoder knob to select from the current level of menu choices.

4 Press the encoder Select switch to move down and the Bypass/Mute/Pre switch to move up through menu levels.

5 Do one of the following:
   • Press the flashing encoder Select switch to confirm the assignment.
   – or –
   • Press the flashing Escape switch to cancel the assignment.

Making Elements Active or Inactive

You can make Inputs, Outputs, Inserts, Sends, and entire tracks active or inactive directly from D-Control by entering a temporary Make Inactive mode.

To toggle an input, output, send, or plug-in active/inactive:
1 Make sure the channel is showing the top-level view for the element you want to make active/inactive.

2 Press a Make Inactive switch to enter the appropriate Make Inactive mode.

3 Press the Bypass/Mute/Pre switches on encoders to deactivate or reactivate their corresponding track elements.

4 Press the flashing Make Inactive switch to exit Inactive mode.

To toggle a track inactive/active:
1 Press any of the Make Inactive switches.

2 Press channel strip Select buttons to deactivate or reactivate the corresponding tracks.
3 Press the flashing Make Inactive switch to exit Inactive mode.

Selecting a Track

You can select tracks in Pro Tools directly from D-Control. In Select mode, Select switches can follow latching or non-latching behavior. For details on setting the latch mode for the Select switch, see “Select Switch Latch Mode” on page 41.

To select a track from D-Control:
1 Make sure the Select/Focus switch mode is set to Select.
2 Press the channel Select switch for the track you want to select.

To select a range of tracks:
1 Press the Select switch on the channel at the start of the range you want to select.
2 Hold Shift and press the Select switch on channel at the end range you want to select.

All tracks between the first channel and last channel (inclusive) are selected.

To select or deselect multiple, non-contiguous tracks, do one of the following:
1 If the Select Switch Latch Mode is set to latch, press additional Select switches.
   – or –
2 Hold Control (Windows) or Command (Macintosh) and press the Select switches on multiple channels.

Focusing a Track

You can focus any track in a session on the D-Control Focus Channel Strip. This mirrors the track controls in the channel strip on the D-Control main unit, bringing them to the center mix position. Focusing a track also makes it available for use with the Custom Fader modes.

To focus a track on the Focus Channel Strip from D-Control:
1 Make sure the Select/Focus switch mode is set to Focus.
2 Press the channel Select switch for the track you want to focus.

To focus a specific track number:
1 Press the Go To switch on D-Control.
   – or –
Choose Operations > Scroll to Track Number in Pro Tools.
2 Enter the track position number for the track and press Enter.

To nudge the track focus left or right by one channel:
1 Hold Control (Windows) or Command (Macintosh) and press the left or right Nudge 1 switch in the Bank/Nudge section.

To nudge the track focus left or right by eight channels:
1 Hold Control (Windows) or Command (Macintosh) and press the left or right Nudge 8 switch in the Bank/Nudge section.

Focusing a Plug-In

Focusing a plug-in on D-Control brings the plug-in’s controls to channel strip encoders and faders for convenient editing. You can focus a plug-in in several ways: on the encoders of its channel; on the encoders of the Focus Channel Strip, and in the Custom Faders section.

With dynamics and EQ plug-ins, you can also focus plug-in parameters on the dedicated Dynamics and EQ sections of D-Control.

To focus a plug-in on its channel:
1 Press the Inserts switch on the channel. The plug-in names are displayed in the channel’s encoders.
2 Press the Select switch under the name of the plug-in you want to focus. The plug-in parameters are displayed in the channel’s encoders.
3 If there is more than one page of parameters for the plug-in, the Page Up or Page Down switches light. To move through parameter pages, press the corresponding switch.

To focus a plug-in on the Focus Channel Strip:
1 Focus the plug-in’s track on the Focus Channel Strip.
2 Press the Inserts switch on the channel. The plug-in names are displayed in the channel’s encoders.
3 Press the Select switch under the name of the plug-in you want to focus. The plug-in parameters are displayed in the Focus Channel Strip’s encoders.
4 If there is more than one page of parameters for the plug-in, the Page Up or Page Down switches light. To move through parameter pages, press the corresponding switch.
To focus a plug-in in the Custom Faders section:

1. Focus the plug-in’s track on the Focus Channel Strip by pressing the track’s Select switch. The first plug-in that is not a dynamics or EQ plug-in is automatically focused, and its name appears in the Custom Faders display.

2. In the Custom Faders section, press the Bank/Cycle switch to cycle through the plug-ins on the focused channel. (The No Insert option is always available.)

The plug-in whose name appears in the Custom Faders display is then available for Custom Fader Plug-In mode. (See “Plug-In Mode” on page 124.)

To focus a plug-in in the Dynamics or EQ section:

1. Focus the plug-in’s track on the Focus Channel Strip by pressing the track’s Select switch. The first dynamics and EQ plug-ins on that track are automatically focused in the corresponding D-Control section.

2. Press the Cycle switch in the Dynamics or EQ section to focus successive dynamics or EQ plug-ins on that channel. (The No Insert option is always available.)

Automation Safe Mode

The Automation Safe switch invokes a mode in which the Bypass/Mute/Pre switch for each encoder and the channel Select switch become Automation Safe switches. While in this mode, pressing a Bypass/Mute/Pre switch on a plug-in or send protects any automation on that plug-in or send from being overwritten. Pressing a channel Select switch protects any automated parameters on that track from being overwritten.

In Automation Safe mode, the Automation Safe switch is lit. While in this mode, the Bypass/Mute/Pre switch for any protected insert or send is lit, and the channel Select switch for any protected channel is lit.

To toggle Automation Safe mode on and off:

1. Press the Automation Safe switch.

2. Press the channel Select switch on the tracks for which you want to toggle automation safe status.

3. Press the Bypass/Mute/Pre switch for the plug-ins or sends for which you want to toggle automation safe status.

4. Press the Automation Safe switch again to exit Automation Safe mode.

Bypassing Plug-Ins

When a plug-in name is displayed on an encoder (in the top level Inserts display), the encoder’s Bypass/Mute/Pre (B/M/P) switch bypasses the corresponding plug-in. The B/M/P switch lights when the insert or plug-in is bypassed.

To bypass a Plug-In:

1. Press the Inserts switch on the plug-in’s channel to display the Insert names on the channel’s encoders.

2. Press the B/M/P switch that corresponds to the plug-in you want to bypass. The B/M/P switch lights when the plug-in is bypassed.

Making Plug-Ins Active/Inactive

When a plug-in name is displayed on an encoder (in the top level Inserts display), it can be made inactive without entering Make Inactive mode.

To toggle a plug-in active/inactive:

1. Press the Inserts switch on a channel strip to display the names of the plug-ins on the channel’s encoders.

2. If the insert location for the plug-in that you want to make active/inactive is not showing, press the Page Up or Page Down switches on the channel where you want to make the assignment until the appropriate location is displayed.

3. Hold Control+Start (Windows) or Control+Command (Macintosh) and press the encoder Select switch for the plug-in.

Muting Sends

You can mute sends directly from D-Control by setting the appropriate mode for the Bypass/Mute/Pre switch.

To mute sends:

1. Press the Sends switch on the track to display Send names in the channel encoders.

2. Press the Switch Mode switch to set the mode to Mute.

3. Press the B/M/P switch for the send you want to mute. The red Mute LED lights to indicate that the send is muted.

Setting Send Pre-/Post-Fader Operation

You can set sends to pre-fader or post-fader operation directly from D-Control, by setting the appropriate mode for the Bypass/Mute/Pre switch.

To toggle sends between pre-fader and post-fader operation:

1. Press the Sends switch on the track to display Send names in the channel encoders.

2. Press the Switch Mode switch to set the mode to Pre.

3. Press the B/M/P switch for the send you want to toggle. The green Pre LED lights to indicate that the send is set for pre-fader operation.
**Flip Mode**

Channels in Normal mode can use Flip Mode, which transfers controls from a row of encoders to the channel faders.

In Flip mode, the rotary encoder control swaps with the channel fader; the encoder Select switch swaps with the channel Select switch; the encoder Bypass/Mute/Pre switch swaps with the channel Mute switch; and the encoder display swaps with the channel display.

In Flip mode, the Flip switch for the affected row of encoders lights, and the affected encoder displays appear in yellow.

**To transfer controls from a row of rotary encoders to the channel faders:**
- Press the Flip switch that corresponds to the encoder row that you want to transfer.

**To exit Flip mode:**
- Press a lighted Flip switch.

**Flop Mode**

Channels in Normal mode can use Flop mode, which transfers controls between any two rows of rotary encoders, allowing you to bring any encoder control within easy reach from the mix position.

**To transfer controls between any two rows of rotary encoders:**
- Hold Start (Windows) or Control (Macintosh) and repeatedly press the Flip switch on row of encoders where you want to transfer the controls. The Flip switches on each row light to indicate which controls are being transferred.

The transferred (or “flopped”) controls are indicated by yellow text in their encoder displays.

**To return flopped controls to their original positions:**
- Press either of the lit Flip switches.

**Assigning Inserts and Sends While in Flip Mode**

You can assign Inserts or Sends directly to an encoder even when its controls are flipped to the channel fader.

When an encoder’s controls are flipped to the channel fader, the channel Select switch replaces the encoder Select switch, the channel Mute switch replaces the Bypass/Mute/Pre switch, and the channel Fader replaces the encoder knob.

**To assign an individual insert or send to a flipped encoder:**
1. On the channel where you want to make the assignment, press the Inserts or Sends switch to display the corresponding elements on the channel. The controls for the flipped encoder appear on the channel fader.
2. Press and hold the channel Select switch on the channel where you want to assign the insert or send. The channel scribble strip shows a right arrow (“>”) next to the assignment to indicate the channel is in assign mode.
3. Move the channel fader to select from the first level of menu choices.
4. Press the channel Select switch to move down and the channel Mute switch to move up through menu levels.
5. Do one of the following:
   - Press the flashing channel Select switch to confirm the assignment.
   - or –
   - Press the flashing Escape switch to cancel the assignment.

**To change a previously assigned insert or send on a flipped encoder:**
1. On the channel where you want to change the assignment, press the Inserts or Sends switch to display the corresponding elements on the channel.
2. Press and hold the channel Select switch for the flipped insert or send you want to change, until the channel scribble strip shows a right arrow (“>”) next to the assignment to indicate the channel is in assign mode.
3. Do one of the following to select a new insert or send:
   - Move the channel fader to select from the current level of menu choices.
   - or –
   - Press the channel Select switch to move down and the channel Mute switch to move up through menu levels.
4. When the new insert or send is displayed in the channel scribble strip, do one of the following:
   - Press the flashing channel Select switch to confirm the assignment.
   - or –
   - Press the flashing Escape switch to cancel the assignment.

**To remove an individual insert or send on a flipped encoder:**
1. On the channel where you want to remove the assignment, press the Inserts or Sends switch to display the corresponding elements on the channel.
2 Press and hold the channel Select switch for the flipped insert or send you want to remove, until the channel scribble strip shows a right arrow (">") next to the assignment to indicate the channel is in assign mode.

3 Press the encoder Bypass/Mute/Pre switch repeatedly until you reach the top level menu for the assignment.

4 Move the channel fader until no assignment is visible.

5 Do one of the following:
   - Press the flashing channel Select switch to confirm the removal.
   - or –
   - Press the flashing Escape switch to cancel the removal and restore the assignment.

---

**Inline Console Mode**

With Inline mode, you can control an input channel and its corresponding monitor channel from a single channel strip on D-Control.

An input signal (for example, from a Digidesign PRE) is brought into an Auxiliary Input track, and routed to an Audio track for recording and monitoring. Inline mode on D-Control is then used to control each of these elements from a single channel strip: the PRE and Auxiliary Input level controls are controlled with the channel strip encoders, and the record track levels are controlled with the channel strip fader.

**To control an Auxiliary Input track and Audio track from a single D-Control channel strip:**

1 Assign the output of a Digidesign PRE (optional) or other audio source to an Auxiliary Input track.

2 Assign the output of the Auxiliary Input track to an Audio track.

3 On D-Control, press the Input switch in the Channel Strip Mode controls for the Audio channel.

4 On the Audio channel, press the encoder Select switch on the lowest row of encoders and turn the encoder knob to select the Auxiliary Input track.

5 Press Select to confirm the choice.

The controls for the PRE and the Auxiliary Input appear on the Audio channel’s rotary encoders as follows, from top to bottom:

- Encoder 1 Knob/Switch: PRE Phantom Power
- Encoder 2 Knob/Switch: PRE Polarity
- Encoder 3 Knob/Switch: PRE Impedance/Pad
- Encoder 4 Knob/Switch: PRE Source/Insert
- Encoder 5 Knob/Switch: PRE Gain/HPF
- Encoder 6 Knob/Switch: Aux Gain/Aux Mute

6 (Optional) Hide the Auxiliary Input channels using the Show/Hide Soft Keys.

7 Adjust the PRE gain using Encoder 5.

8 Fine tune the input gain by adjusting the Auxiliary Input level using Encoder 6 (the bottom encoder).

9 Press the Sends switch in the Channel Strip Mode controls and configure any cue mixes or effects sends for the channel.

10 Adjust the monitoring level with the Audio channel fader.

**To view a hidden Auxiliary Input channel while in Inline mode:**

- Press Control (Windows) or Command (Macintosh) and press the encoder Select switch on Encoder 6.

The Auxiliary Input channel is focused in the Focus Channel strip.

---

**Custom Fader Modes**

With the Custom Faders feature, you can temporarily set aside channel strips on D-Control and focus them on your own customized groups of tracks, on Pro Tools Mix and Edit groups, on specific track types, or on plug-in controls. Custom Fader modes are only accessible on D-Control, and are not displayed on-screen in Pro Tools.

On D-Control, Custom Fader channels are completely separate from the surrounding channels on the control surface. All tracks in the session bank around the Custom Fader channels, and continue to behave normally in Pro Tools and on D-Control.

All Custom Fader modes essentially duplicate the controls on tracks already represented in Normal mode, but let you rearrange them to fit your workflow. Any control moves performed on a Custom Fader channel are mirrored in the Normal mode channel if it is present on D-Control.

When channels are in use by any of the Custom Fader modes, the blue indicator marked “CF,” located to the left of the channel fader, is lit.

The status of Custom Fader modes is saved with the Pro Tools session. If you save and close a session with a Custom Fader mode active, the session will reopen with the same mode active.
Dual Custom Fader Banks

D-Control has available two independent banks of Custom Faders (Left Custom Faders and Right Custom Faders), controlled by the Custom Fader Control sections on the left and right sides of the Main Unit.

Each of the Custom Fader banks can be controlled from the Bank Select Matrix, with the corresponding group, track or plug-in information appearing in the Soft Keys. The Custom Fader bank currently targeted in the Bank Select Matrix is indicated by yellow text in the Custom Fader display.

Overview of Custom Fader Modes

The four Custom Fader modes are covered in detail later in this section:

- **Custom Groups Mode** Lets you create and recall up to 48 custom arrangements of tracks on D-Control that are independent of the Mix or Edit groups in Pro Tools.

- **Mix/Edit Groups Mode** Lets you recall Pro Tools Mix or Mix/Edit groups and display them on the Custom Fader channel strips. You can also activate and delete Mix or Mix/Edit groups from this mode.

- **Tracks Mode** Lets you bring all tracks of a particular type to the Custom Fader channel strips. Track Types include Audio tracks, Auxiliary Input tracks, MIDI tracks, Instrument tracks, Master Fader tracks, and Hidden Tracks.

- **Plug-In Mode** Lets you focus the controls of two separate plug-in on the two available Custom Fader channel banks. A special expanded Plug-In mode focuses the plug-in header controls (such as Bypass, Compare and Safe) on the channel strip Mute switches.

Two additional modes work in conjunction with these Custom Fader modes:

- **Custom Fader Flip Mode** Lets you flip rows of encoder controls to the faders on the Custom Fader channel strips.

- **Custom Fader Map Mode** Lets you map individual encoder controls to faders on the Custom Fader channel strips on a track-by-track basis.

Setting the Maximum Custom Fader Bank Size

You can independently set the size of each of the two available Custom Fader banks (Left Custom Faders and Right Custom Faders). The size of each bank is set in increments of 8 channels, from zero (no Custom Fader Bank) up to the total number of channels on the D-Control system.

To set the maximum Custom Fader bank size:

1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Custom Fader Bank Size preferences (“LMax CF” or “RMax CF”):

2. Do one of the following:
   - To increment the number of channel strips, press the Soft Key that corresponds to “LMax CF” or “RMax CF.”
   - To decrement the number of channel strips, hold Shift and press the Soft Key that corresponds to “LMax CF” or “RMax CF.”

3. Hold Control (Windows) or Command (Macintosh) and press the Operation switch to exit.

Setting the Custom Fader Justification

You can independently set the distribution of the two available Custom Fader banks on the control surface.

To set Custom Fader bank justification:

1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes the Custom Fader Bank Justification preferences (“LCFJst” or “RCFJst”):

2. For each bank of Custom Faders, choose between the “Left,” “CenterL,” “CenterR,” and “Right” settings.

3. Hold Control (Windows) or Command (Macintosh) and press the Operation switch to exit.

Displaying Hidden Tracks in Custom Faders

You can set D-Control to show hidden tracks in the Custom Fader views. You can then mix those hidden tracks, but you cannot select or record-enable them. Hidden track names are displayed in yellow in the Custom Faders.

To make hidden tracks visible in Custom Fader views:

1. In the Soft Keys section, press the Operation switch repeatedly to display the page that includes Custom Fader Tracks (“CFTrks”).

2. Press the Soft Key that corresponds to “CFTrks” to toggle the setting between Show Hidden Tracks (“ShwHdn”) and Hide Hidden Tracks (“HidHdn”).

3. Hold Control (Windows) or Command (Macintosh) and press the Operation switch to exit.

Custom Fader Controls

The Custom switch, Groups switch, Master switch, and Plug-In switch in the Custom Faders sections light when the corresponding Custom Fader mode is active.

The Map switch and Flip switch work in combination with the Custom Fader modes (except Master Faders mode), and have no independent effect.
The Lock switch and Window switch function both in the Custom Fader modes and independently. See “Lock Switch” on page 62.

**Custom Groups Mode**

Custom Groups mode lets you create a custom collection of tracks and arrange them in any order in either of the two available banks of Custom Fader channels. You can create up to 48 independent Custom Groups in a session.

Custom Groups are useful for temporarily associating tracks that are not part of a Pro Tools Mix/Edit group. Also, because you can add multiple instances of the same track to a Custom Group, you can use this mode, in conjunction with Flip mode or Map mode, to map multiple parameters from a single track onto adjacent channel faders.

Custom Groups are created and recalled entirely on D-Control, and are independent of Mix/Edit groups in Pro Tools. D-Control Custom Groups are not reflected on-screen in Pro Tools. Custom Groups are saved in the Pro Tools session file, and move with the session to any other system that supports D-Control operation.

**Displaying Custom Groups**


Custom Groups can also be displayed and recalled from the Soft Keys section (in pages of six) by repeatedly pressing the Bank Select switch in the Soft Keys section.

**To create a new Custom Group:**

1. Press the Custom switch in the left or right Custom Faders section. The switch lights to indicate the mode is active for the corresponding Custom Fader bank.

2. Hold Shift and press the Bank/Cycle switch in that Custom Faders section to go to the page (1–12, 13–24, 25–36, or 37–48) of the Bank Select Matrix where you want to assign the new Custom Group.

3. In the Bank Select Matrix, press the Bank Select switch (1–12) to which you want to assign the new Custom Group. The switch lights to indicate the selection.

4. Press the Edit switch in the Bank Select section. The Edit switch flashes to indicate Edit mode.

5. Do one of the following:
   - Press the Select switch for each source channel you want to add to the Custom Group.
   - Hold Shift while pressing a lit Select switch to put the same track on multiple faders.
   - To remove a track from the Custom Group, press its Select switch in the Custom Fader channels.

Tracks are added to the Custom Group in the order you select them, and are right-justified in the Custom Fader channels.

6. Press the flashing Edit switch in the Bank Select section when you are finished.

**To recall a Custom Group:**

1. Press the Custom switch in the left or right Custom Faders section. The switch lights to indicate the mode is active for the corresponding Custom Fader bank.

2. Hold Shift and press the Bank/Cycle switch in that Custom Faders section to go to the page (1–12, 13–24, 25–36, or 37–48) of the Bank Select Matrix containing the Custom Group you want to recall.

3. Press the Bank Select switch (1–12) for the Custom Group you want to recall.

   *The Bank Select switches remember their previous mode of operation (either Custom Groups or Mix/Edit Groups). If you last used the Bank Select switch in Custom Groups mode, you can recall a Custom Group directly from the Bank Select switches. It is not necessary to press the Custom Group switch first.*

**To name a Custom Group:**

1. Recall the Custom Group you want to name.


3. Enter a name for the Custom Group and click OK.
To add channels to a Custom Group:
1. Recall the Custom Group you want to edit.
2. Press the Edit switch in the Bank Select section. The Edit switch flashes to indicate Custom Groups Edit mode.
3. Press the channel Select switch on the Custom Fader channel strip to the right of the position where you want to insert new channels.
4. Press the channel Select switch on each source channel you want to add to the Custom Group.
5. Press the flashing Edit switch in the Bank Select section to exit.

The new channels are added the Custom Group, located to the left of the selected Custom Fader channel strip.

To remove channels from a Custom Group:
1. Recall the Custom Group you want to edit.
2. Do one of the following:
   - Press the channel Select switch on the source channels you want to remove from the Custom Group.
   - Hold Control+Start (Windows) or Control+Command (Macintosh) and press the channel Select switch on the Custom Fader channels you want to remove.
   - Hold the Set To Default switch and press the channel Select switch on a Custom Fader channel you want to remove.

To delete a Custom Group:
1. Recall the Custom Group you want to delete.
2. Hold Start+Alt+Control (Windows) or Control+Option+Command (Macintosh) and press the corresponding switch in the Bank Select Matrix.

To exit Custom Groups Mode:
- Press the lit Custom Groups switch.

Mix/Edit Groups Mode

Mix/Edit Groups mode lets you create, display, and edit Pro Tools Mix and Mix/Edit groups in either of the two available banks of Custom Fader channels. Mix/Edit Groups mode is useful for quickly calling the members of a group to a set of faders for mixing and automation.

To show a Mix/Edit group in the Custom Fader channels:
- Press the Groups switch in the left or right Custom Fader section.
The switch lights, the group’s letter and name appear in the corresponding Custom Fader display, and the group members appear in the Custom Fader channels.

Mix/Edit Groups can also be displayed and recalled from the Soft Keys section (in pages of six) by repeatedly pressing the Bank Select switch in the Soft Keys section.

To focus different groups, press the corresponding switch in the Bank Select Matrix. Groups are recalled in sequence according to their group letter:
- Bank Select 1 corresponds to the All group.
- Bank Select 2–12 correspond to groups a–k.
- Hold Shift and press Bank/Cycle to change Bank Select switches 1–12 to correspond to groups l–w.
- Hold Shift and press Bank/Cycle a second time to change Bank Select switches 1–3 to correspond to groups x–z.

\textit{The Bank Select switches remember their previous mode of operation (either Custom Groups or Mix/Edit Groups). If you last used the Bank Select switch in Mix/Edit Groups mode, you can recall a Mix/Edit Group directly from the Bank Select switches. It is not necessary to press the Mix/Edit Group switch first.}

To activate/deactivate a Mix/Edit group:
- While in Mix/Edit Groups mode, do one of the following:
  - Hold Start+Control (Windows) or Control+Command (Macintosh) and press the group’s corresponding switch in the Bank Select section.
  - Hold the Custom Fader Groups switch until it flashes, then press switches in the Bank Select section for the groups you want to activate/deactivate. When you are finished, press the flashing Groups switch.

A deactivated group is indicated by inverted text in the Custom Faders display.

To create a Mix/Edit group:
1. Make sure you are in Select mode.
2. Select the tracks you want to group by pressing their Select switches.
3. Press the Groups switch to enter Mix/Edit Groups mode.
4. In the Bank Select Matrix, press the Bank Select switch to which you want to assign the new Mix/Edit group.
6. Choose the type of group to create: Edit Group, Mix Group, or Edit/Mix Group.
7. Enter a name for the Group and press Enter.
To edit a Mix/Edit group:

1. Make sure you are in Select mode.
2. Press the Groups switch to enter Mix/Edit Groups mode.
3. In the Bank Select Matrix, press the Bank Select switch to recall the Mix/Edit group you want to edit.
4. Press the Edit switch in the Bank Select section.
5. Do any of the following:
   - Press the channel Select switch on the source channels you want to add or remove from the group.
   - Press the lit channel Select switch on the Custom Fader channels you want to remove from the group.
6. Press the flashing Edit switch to confirm the group.

To delete a Mix/Edit group:

- In Mix/Edit Groups mode, hold Start+Alt+Control (Windows) or Control+Option+Command (Macintosh) and press the switch in the Bank Select section that corresponds to the group you want to delete.

To exit Mix/Edit Groups Mode:

- Press the lit Groups switch.

Tracks Mode

Tracks Mode lets you bring all tracks of a particular type to either of the two available banks of Custom Fader channels.

Track type for each bank of Custom Faders can be selected from the Bank Select Matrix:
- Bank Select 1 = Master Faders
- Bank Select 2 = Audio Tracks
- Bank Select 3 = Auxiliary Inputs
- Bank Select 4 = MIDI Tracks
- Bank Select 5 = Instrument Tracks
- Bank Select 6 = Hidden Tracks

The name of the selected track type is shown in the Custom Faders display.

If the number of tracks exceeds the number of Custom Fader channel strips, the tracks can be banked with the Bank/Cycle switch in the Custom Faders section.

Track types can also be displayed and selected in the Soft Keys section by pressing the Bank Select switch in the Soft Keys section.

To bring a Track type to Custom Fader channels:

1. Press the Tracks switch in the left or right Custom Fader section.
2. Press the Bank Select switch to display track types in the Soft Keys section.
3. Press the Soft Key that corresponds to the track type you want to display in the Custom Fader channels.

The name of the Track type appears in the corresponding Custom Fader display. Tracks of the designated type appear right-justified in the Custom Fader channels.

To exit Tracks mode:

- Press the lit Tracks switch.

Plug-In Mode

Plug-In mode focuses available plug-ins on the focused channel on the left and right Custom Fader channels. This places all of the plug-in’s parameters on the Custom Fader channel encoders, and any plug-in meters on the Custom Fader channel meters.

With plug-ins that have multiple pages of parameters, you can select pages from the Bank Select Matrix. If a plug-in has more than 12 pages, you can cycle through pages by holding Shift and pressing the Bank/Cycle switch in the Custom Faders section.

The plug-in pages can also be accessed from the Soft Keys section by pressing the Bank Select switch in the Soft Keys section.

This mode is useful for controlling plug-ins with a large number of controls, such as virtual instruments.

To focus a plug-in on Custom Fader channels:

1. Focus the plug-in’s track on the Focus Channel Strip by pressing the track’s Select switch. The names of available plug-ins appear in the left and right Custom Fader displays.
2. Press the Plug-In switch in either of the Custom Fader sections. The switch lights to indicate the mode is active. The plug-in name and channel format appear in the corresponding Custom Fader channel display, and the plug-in’s parameters appear in the Custom Fader channel encoders.
3. In either of the Custom Faders sections, press the Bank/Cycle switch to cycle through the plug-ins on the focused channel. (The No Insert option is always available.)

You can go directly to Custom Fader Plug-In mode from top-level Inserts view by holding Control (Windows) or Command (Macintosh) and pressing the encoder Select switch for the plug-in you want to focus.

Custom Faders and Plug-Ins

In general, continuous plug-in parameters map to the Custom Fader encoder knobs, and switched parameters functions map to the B/M/P (Bypass/Mute/Pre) encoder switches. The presence of a switched parameter is indicated by the Pre indicator above the corresponding B/M/P switch.
To see what parameter is controlled by a B/M/P switch, press the Switch Info switch.

In some cases, the same control may be mapped to both an encoder knob and its corresponding switch, allowing you to use either control to adjust the parameter.

Plug-in meters map to the Custom Fader channel meters. Plug-in input and output meters appear as standard level meters with green, yellow, and red segments. Any dynamics gain reduction meters (for example, in a compressor or limiter plug-in) are shown as top-to-bottom meters with yellow segments.

**Expanded Plug-In Mode**

Expanded Plug-In mode lets you access additional plug-in controls and manage individual channels (also called *streams*) of a multi-mono plug-in. This mode places the following standard header controls in the Custom Fader channel displays:

- Plug-In Bypass
- Plug-In Compare
- Plug-In Automation Safe
- Plug-In Automation Enable

**To enter Expanded Plug-In mode:**

- Press and hold the Plug-In switch in the Custom Fader section until the switch flashes. The plug-in header controls are mapped as follows:

  **Plug-In Bypass** To bypass the currently displayed plug-in, press the Mute switch that corresponds to “Bypass” in the channel displays. This toggles the Effect Bypass button in the Plug-In window.

  **Plug-In Compare** To toggle between the original saved plug-in setting and any changes you have made to it, press the Mute switch that corresponds to “Comp” in the channel displays. This toggles the Compare button in the Plug-In window.

  **Plug-In Automation Safe** To prevent existing plug-in automation from being overwritten, press the Mute switch that corresponds to “Safe” in the channel displays. This toggles the Safe button in the Plug-In window.

  **Plug-In Automation Enable** To enable individual plug-in controls for automation, press the Mute switch that corresponds to “AutoEn” in the channel displays. This lists the automatable plug-in controls on the Custom Fader encoders. Choose the controls to automate by pressing their encoder Select switches. This toggles the Auto button in the Plug-In window.

**Multi-Mono Plug-Ins and Expanded Plug-In Mode**

With multi-mono plug-ins, the following plug-in channel controls are also mapped to the Custom Fader channel displays:

- **Link** To link channels of a multi-mono plug-in, press the Mute switch that corresponds to “Link” in the channel displays. This toggles the Master Link button in the Plug-In window.

- **Target Stream** To target a particular multi-mono plug-in channel for editing, press the Mute switch that corresponds to “TargtS” in the channel displays. This lists the channels of the plug-in on the Channel Fader encoders. You can then choose a channel by pressing its encoder Select switch. The switch lights to indicate the targeted channel.

- **Group Stream** To group individual multi-mono plug-in channels for editing, press the Mute switch that corresponds to “GroupS” in the channel displays. This lists the channels of the plug-in on the Channel Fader encoders. You can then group any number of streams by pressing their encoder Select switches. The Select switches light to indicate grouped channels.

- **Bypass Stream** To bypass individual multi-mono plug-in streams, press the Mute switch that corresponds to “BypS” in the channel displays. This lists the channels of the plug-in on the Channel Fader encoders. You can then bypass a stream by pressing its encoder B/M/P switch. The B/M/P switch lights to indicate the bypassed stream.

**To exit Expanded Plug-In mode:**

- Press the flashing Plug-In switch.

**Custom Fader Flip Mode**

When in any of the Custom Fader modes, you can flip Custom Fader encoder rows to the faders with Custom Fader Flip mode. The single Custom Fader Flip switch is used to cycle the encoder rows through the faders. The Custom Fader Flip switch only affects Custom Fader channels, and has no effect on channels in Normal mode.

In Custom Fader Flip mode, the Custom Fader Flip switch is lit, and the affected encoder displays appear in yellow.

**To enter Custom Fader Flip mode:**

1. From any of the Custom Fader modes, press the Custom Fader Flip switch. The top row of encoders transfers to the faders.
2. To flip successive rows, repeatedly press the Custom Fader switch.

**To exit Custom Fader Flip mode:**

- Press the Custom Fader Flip switch repeatedly until you exit Flip mode.

  - or –

- Hold Control (Windows) or Command (Macintosh) and press the Custom Fader Flip switch.
Custom Fader Map Modes

When in Custom Groups, Mix/Edit Groups, or Plug-In mode, you can map individual encoder controls to faders on a track-by-track basis with Custom Fader Map modes.

This mapping feature works differently depending on which of the main Custom Fader modes you are in. (Mapping is not available in Master Faders mode.)

Custom Groups and Mix/Edit Groups Map Modes

When in Custom Groups or Mix/Edit Groups mode, you can map any encoder parameter to the fader on the same Custom Fader channel. In these Map modes, the rotary encoder control swaps with the channel fader, and the encoder By-pass/Mute/Pre switch swaps with the channel Mute switch.

Mapping while in these modes is vertically restricted to encoders and faders in the same channel strip.

How Custom Group and Mix/Edit Group Mapping is Stored

Custom Group and Mix/Edit Group mapping is saved in the Pro Tools session file, and moves with the session to any other system that supports D-Control operation.

To map an encoder to a fader (Custom Groups mode or Mix/Edit Groups mode):

1. While in Custom Groups mode or Mix/Edit Groups mode, press and hold the Map switch in the Custom Faders section until the switch flashes.
2. In the Custom Fader channels, touch any rotary encoders that you want to map to their corresponding channel fader.
3. Do one of the following:
   - Press the flashing Map switch to confirm the mapping.
   - or –
   - Press the Escape switch to cancel the mapping and leave Map edit mode.

The Map switch lights solid to indicate that the mapping is active.

To bypass mapping (Custom Groups mode or Mix/Edit Groups mode):

Press the lit Map switch. Even when it is not displayed, mapping is remembered for each Custom Group or Mix/Edit Group.

To recall mapping (Custom Groups mode or Mix/Edit Groups mode):

1. Recall the Custom Group or Mix Edit Group by pressing the corresponding switch in the Custom Faders section.
2. Press the Map switch.

Plug-in Map Mode

When in Custom Faders Plug-in mode, you can map any plug-in parameter to any of the faders in the Custom Fader channels, including faders on different channels. In Plug-In Map mode, a mapped rotary control is duplicated on the fader, and a mapped switch is duplicated on the channel Mute switch. (Because Plug-In mode does not use the faders, no swapping takes place.)

Mapping while in this mode has no restriction on the vertical relationship between encoders and faders.

How Plug-In Mapping is Stored

- When you map a plug-in, all other instances of that plug-in in the session will use the same mapping.
- Plug-in mapping is saved as a preference file with a .pim extension.
- Plug-In mapping for the last opened session is remembered by the Pro Tools system (saved in the Pro Tools application preferences file), so when you create a new session on the system, all instances of the same plug-in will use the stored mapping.
- Plug-In mapping files (.pim) files can be imported and exported for use with other D-Control and D-Command consoles.

To map an encoder to a fader (Plug-In mode):

1. While in Plug-In mode, press the Map switch in the Custom Faders section.
2. In the Custom Fader channels, press the channel Select switch on the channel where you want to map the encoder. The Select switch flashes to indicate Map mode.
3. Do one of the following:
   - In the Custom Fader channels, touch any rotary encoder that you want to map to the selected channel’s fader.
   - or –
   - In the Custom Fader channels, press any switch that you want to map to the selected channel’s Mute switch.

The mapped control appears on the selected channel’s fader. Plug-In parameter mapping is remembered for that plug-in, and is usable on any channel where it occurs.

To bypass mapping (Plug-In mode):

Press the lit Map switch. Even when it is not displayed, mapping is remembered for each plug-in.

To recall mapping (Plug-In mode):

1. Focus the plug-in in the Focus Channel Strip.
2. Recall the plug-in by pressing the Plug-In switch in the Custom Faders section.
3. Press the Map switch.
To clear mapping (Plug-In mode):

1. In Custom Faders Plug-In Map mode, display the plug-in whose map you want to clear.
2. Press the Set to Default switch.
3. Press the Do To All switch.
4. Press the Select switch on any of the Custom Fader channel strips.
5. Press the flashing Do To All and Set To Default switches.

Exporting and Importing .pim Files

To export plug-in mapping:

1. Press the Operation switch repeatedly to display the page that includes Export Plug-In Maps (“Export PIMaps”).
2. Press the Soft Key that corresponds to “Export PIMaps.”
3. Enter a name for the Plug-In Map (.pim) file, choose a location, and click Save.
4. Hold Control (Windows) or Command (Macintosh) and press the Operation switch to exit.

To import plug-in mapping:

1. Press the Operation switch repeatedly to display the page that includes Import Plug-In Maps (“Import PIMaps”).
2. Press the Soft Key that corresponds to “Import PIMaps.”
3. Locate the Plug-In Map (.pim) file you want to use and click Import.
4. Hold Control (Windows) or Command (Macintosh) and press the Operation switch to exit.
Appendix A: Utility Mode

D-Control Utility mode lets you view system information, run diagnostic tests, set hardware preferences, and reset system settings.

Entering Utility Mode

You can enter Utility mode at any time to change D-Control settings. Utility mode can be accessed from the D-Control Main Unit and also on individual D-Control Fader Modules.

Entering Utility Mode from a Main Unit

When putting a D-Control Main Unit into Utility mode, the behavior of connected Fader Modules depends on whether or not the units are online.

A D-Control unit is online if Pro Tools is running and the unit is declared in the Peripherals page of the Setups dialog. A unit is offline when Pro Tools is not running, or if it is not declared on a system that is running Pro Tools.

To enter Utility mode from the Main Unit:

- Press the Utility switch in the Session Management section. The Utility switch and the Soft Keys flash to indicate Utility mode is active.
  - If the Main Unit is online, any Fader Modules declared on the same Pro Tools system also enter Utility mode.
  - If the Main Unit is offline, all offline Fader Modules on the same Ethernet network enter Utility mode.

Entering Utility Mode on a Fader Module

You can put individual Fader Modules into Utility mode to test them independently of other D-Control units.

To put an individual Fader Module into Utility mode:

1. If Pro Tools is running, do one of the following:
   - Quit Pro Tools.
   - or –
   - Choose Setups > Peripherals, click Ethernet Controllers, and make sure the Fader Module is not declared.

2. Press and hold the Modifier Keys in the lower left of the Fader Module in the following sequence: Shift + Alt/Command + Win/Option. The encoder Select switches in the bottom row flash to indicate Utility mode is active.

Navigating Utility Mode

When the unit is in Utility mode, the Utility Setup Page is displayed on the Soft Key displays (Main Unit) or on the bottom row of encoders (Fader Module).

The Utility Setup page has five top level options:

- **System**: System Info Page
- **Name**: Name Setup Page
- **Test**: Test Setup Page
- **Reset**: Reset D-Control to Defaults
- **Pref**: Preference Setup Page

To access an option on the Utility Setup Page:

- Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to the option.

To move back up to the Utility Setup Page:

- Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Escape.”
Exiting Utility Mode

To exit Utility mode, do one of the following:
- Press the flashing Utility switch (Main Unit).
- or –
- Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

D-Control System Info Page

The System Info page provides access to the system firmware version and Ethernet information.

To display the System Info page:
- From the Utility Setup page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “System.”

To exit the System Info page:
- Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

Firmware Version

In the System Info page, hold the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “FW ver.” This shows the Comm board and Motor Control board firmware versions.

Ethernet Info

In the System Info page, hold the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Ethrnt” to display the following information:
- Unit Name (as named on the Name Page)
- ID: Ethernet address (Machine Address Code) for the unit
- Num: The Digidesign serial number for the unit
- Type: The Ethernet packet type used by Digidesign for control surface communication

D-Control Name Page

The Name page is used to view and change D-Control unit names. These names appear in the Pro Tools Peripherals dialog, and must be unique so as to identify each D-Control unit correctly. This is especially important if your system is on an Ethernet network with multiple controllers connected to it.

To display the Name page for a D-Control unit:
1. Put the unit you want to name into Utility mode. Fader Modules must be put into Utility mode independently. (See “Entering Utility Mode on a Fader Module” on page 129.)
2. From the Utility Setup page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Name.”

The Main Unit name appears in the Soft Keys section. The Fader Module name appears in its encoder displays. The first character of the name flashes to indicate text entry.

To change the unit name:
1. Turn the Scrub/Shuttle wheel (Main Unit) or any encoder knob (Fader Module) to change the selected text.
2. To move forward and backward through the name field, press the flashing Soft Keys (Main Unit) or encoder Select switches (Fader Module) that correspond to the “<” and “>” symbols.
3. When you are finished entering text, do one of the following:
   - Confirm the new name by pressing the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “OK.”
   - Clear the name field by pressing the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Clear.”
   - Cancel the new name by pressing the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Cancel.”
D-Control Test Pages

The Test pages let you test various mechanical and electronic components of the unit.

To display the Test Setup page:
- From the Utility Setup page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Test.”

The Test Setup page has five top level test modes:
- Ethernet: Ethernet Test Page
- LED: Switch and LED Test Pages
- Display: Display Test Page
- Fader: Fader Test Page
- Rotary: Rotary Encoder Test Page

To enter a test mode on the Test Setup page:
- Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to the test mode name.

To exit the Test Setup page:
- Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

Ethernet Test Page

There are three test levels for Ethernet communication on D-Control: Internal, Mendec, and External. These tests can assist Digidesign Technical Support should you ever experience difficulty with Ethernet communication between D-Control and Pro Tools.

Each test sends data packets through that unit’s Ethernet system. The Transmit (Xmit) and Receive (Recv) values for each test show the number of packets sent and received in the test, and the “Error” and “Retry” fields show percentage error in the transmission and receiving process. An error rate of 1 percent or less generally indicates acceptable performance. (In normal operation, errors are retried and no data loss occurs.)

To display the Ethernet Test page:
1. Put the unit you want to test into Utility mode. Fader Modules must be put into Utility mode independently. (See “Entering Utility Mode on a Fader Module” on page 129.)
2. From the Test Setup page, press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Ethrnt.”

To exit the Ethernet Test page:
- Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

Internal

The Internal test verifies the first stage of Ethernet communication by sending data packets through the unit’s Ethernet link chip.

To perform the Internal Ethernet test:
1. From the Ethernet Test page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Clear” to clear any values in the unit’s test data page.
2. Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Intml.”

To exit the Internal Ethernet test:
- Press the flashing Soft Key (Main Unit) or encoder Select switch (Fader Module).

Mendec

The Mendec (Manchester Encoder/Decoder) test verifies the second stage of Ethernet communication by sending data packets through the unit’s Ethernet encoder and decoder.

To perform the Mendec Ethernet test:
1. From the Ethernet Test page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Clear” to clear any values in the unit’s test data page.
2. Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Mendec.”

To exit the Mendec Ethernet test:
- Press the flashing Soft Key (Main Unit) or encoder Select switch (Fader Module).

External

The External test verifies the third stage of Ethernet communication by sending data packets out of the unit’s external Ethernet port and back into the unit using the Ethernet loopback connector (provided with the D-Control Main Unit).

To perform the External Ethernet test:
1. If Pro Tools is running, quit Pro Tools.
2. Disconnect the unit from the Ethernet network.
3. Plug the Ethernet Loopback connector into the unit’s Ethernet port.
4. From the Ethernet Test page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Clear” to clear any values in the unit’s test data page.
5. Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Extrnl.”
To exit the External Ethernet test:
- Press the flashing Soft Key (Main Unit) or encoder Select switch (Fader Module).

**Switch and LED Test Page**

The Switch and LED Test page has five modes:
- **Switch**: Switch Test Mode
- **Red**: Red LED Test Mode
- **Yellow**: Yellow LED Test Mode
- **Green**: Green LED Test Mode
- **Vegas**: Vegas Mode

**To display the Switch and LED Test page:**
- From the Test Setup page, press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “LED.”

**To exit the Switch and LED Test page:**
- Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

**Switch Test Mode**

Switch Test mode lets you test each switch on the unit individually.

**To test any switch:**
- Press the switch you want to test.

The switch LED lights as long as it is held and the Soft Key display (Main Unit) or encoder displays (Fader Module) show the location information for the switch.

**To exit Switch Test mode:**
- Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

**LED Test Modes (Red, Yellow, Green)**

The LED Test modes let you test all red, yellow, and green LEDs on the unit individually.

**To test LEDs:**
- Press the Soft Key that corresponds to “Red,” “Yellow,” or “Green” to test all LEDs of the corresponding color.

**To exit LED Test mode:**
- Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

**Vegas Mode**

Vegas mode randomly lights every switch, meter, and display on the unit, and runs the faders in sine wave mode.

**To enter Vegas mode:**
- Press the Soft Key that corresponds to “Vegas.”

**To exit Vegas mode:**
- Press any switch on the unit.

**Display Test Page**

The Display Test page has three modes:
- **Text**: Display Test
- **Time Code**: Time Code Display Test
- **Meter**: Meter Bridge LED Test

**To display the Display Test page:**
- From the Test Setup page, press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Display.”

**To exit the Display Test page:**
- Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

**To enter any of the Display Test modes:**
- Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to the mode name.

**Text (Display) Test**

The Text test mode cycles through a series of display tests that check all displays on the control surface.

**To exit Text Test mode:**
- Press any flashing Soft Key (Main Unit) or encoder Select switch (Fader Module).

**Meter Bridge LED Test**

The Meter Bridge LED test cycles through a series of automated tests that check all LEDs on each meter.

**To exit Meter Bridge LED Test mode:**
- Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”
Time Code Display Test
(Main Unit Only)

The Time Code Display test cycles through a series of automated tests that check all LED segments on the Main Unit Time Code display.

To exit Time Code Display Test mode:
■ Press the Soft Key that corresponds to “Escape.”

Fader Test Page

The Fader Test page provides four test modes and a calibration mode:
• Step: Fader Step Test Mode
• Cycle: Fader Cycle Test Mode
• Group: Fader Group Test Mode
• Touch: Fader Touch Test Mode
• Recal: Recalibrates Faders

To display the Fader Test page:
■ From the Test Setup page, press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Fader.”

To exit the Fader Test page:
■ Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

To enter any of the Fader Test modes:
■ Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to the test name.

Step Test Mode

In Step Test mode, faders jump together, in stepped fashion, to positions that are adjustable with the Scrub/Shuttle wheel (Main Unit) or any encoder knob (Fader Module).

To exit Step Test mode:
■ Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

Cycle Test Mode

In Cycle Test mode, faders move together, from the bottom to top, in a continuous cycle, at a speed that is adjustable with the Scrub/Shuttle wheel (Main Unit) or any encoder knob (Fader Module).

Fader position values are shown in the channel displays and are updated in real time as the faders move.

To exit Cycle Test mode:
■ Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

Group Test Mode

In Group Test mode, faders can be moved to test group response.

This mode displays which faders are currently being touched by showing the letter “T” in their channel displays.

To exit Group Test mode:
■ Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

Touch Test Mode

The Touch Test page lets you test the touch sensitivity of each fader. The channel displays show when a fader is touched and what frequency the fader is currently recognizing. The fader frequency value is updated in real time.

This mode displays which faders are currently being touched by showing the letter “T” in their channel displays.

To exit Touch Test mode:
■ Press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Escape.”

Recal

The Recal command recalibrates D-Control fader touch sensitivity and position to factory specifications.

In addition, under conditions of heavy use, the D-Control fader motor protection feature may disengage a fader if it is in danger of overheating. The Recal command reengages any disengaged faders.

To recalibrate the faders:
■ From the Fader Test page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Recal.”
**Rotary Test Page**

The Rotary Test page lets you test the touch-sensitive encoder knob and the LED ring in each rotary encoder, as well as the Scrub/Shuttle wheel on the Main Unit.

**To enter Rotary Test mode:**
- From the Test Setup page, press the Soft Key (Main Unit) or encoder Select switch (Fader Module) that corresponds to “Rotary.”

**To exit Rotary Test mode:**
- Press the Soft Key next to “Escape” (Main Unit) or the flashing encoder Select switch.

**To test the rotary encoders:**
- Touch any encoder knob. When the encoder knob is touched, the encoder’s display turns red and the “Auto” indicator LED below the knob lights.
- Turn any encoder knob. When the encoder knob is turned, each LED in the LED ring lights in order.

**To test the Scrub/Shuttle wheel:**
- Turn the Scrub/Shuttle wheel. The numerical value in the lower left display of the Soft Key section value changes depending on which way you turn the wheel.

---

**Resetting D-Control to Factory Defaults**

The Reset (Factory Default) page lets you reset the D-Control Main Unit and Fader Modules to their factory default settings.

**To reset D-Control:**
1. From the Utility Setup Page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Reset.”
2. Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “OK.”
3. Do one of the following:
   - Confirm your choice by pressing OK again.
   - Cancel the reset operation by pressing the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Cancel.”

---

**D-Control Preferences**

D-Control Preferences let you set various display and operation preferences for the unit.

**To display the Preferences page:**
- From the Utility Setup Page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Prefs.”

The D-Control Preferences page has five preferences:
- Bright: Display Brightness
- Contrast: Display Contrast
- Foot 1: Footswitch 1 Settings
- Foot 2: Footswitch 2 Settings
- Sleep: Sleep Mode Settings

**To access a preference on the Preferences page:**
- Press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to the preference name.

---

**Display Brightness Page**

The Display Brightness page lets you adjust the brightness of the display LEDs.

**To set the display brightness:**
1. From the Preferences page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Bright.”
2. Turn the Scrub/Shuttle wheel (Main Unit) or any encoder knob (Fader Module) to change the brightness value. Brightness values range from 0–127.
3. Do one of the following:
   - Confirm the new brightness value by pressing the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “OK.”
   - Cancel the new brightness value by pressing the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Cancel.”
Display Contrast Page

The Display Contrast page lets you adjust the level of backlighting in the display LEDs.

To set the display contrast:

1. From the Preferences page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Contrast.”

2. To adjust the overall contrast for all displays, press the Soft Keys (Main Unit) or the encoder Select switches (Fader Module) that correspond to “>>” or “<<” to increase or decrease the contrast value. Overall contrast values range from 0–9.

3. To adjust the relative contrast for individual rows of displays, turn the Flip encoder knobs (Main Unit) or any encoder knobs in a given row (Fader Module). Individual contrast values are shown as “Step” numbers ranging from 0–62.

4. To cycle the displays through inverted text display, repeatedly press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Invert.”

5. Do one of the following:
   - Confirm the new contrast values by pressing the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “OK.”
   - Reset the contrast values to their defaults by pressing the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Reset.”
   - Cancel the new contrast values by pressing the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Cancel.”

Footswitch 1 and 2 Settings Pages
(Main Unit Only)

The Footswitch Settings pages for Footswitch 1 and Footswitch 2 let you set the function for each. For each setting, pressing the footswitch is the functional equivalent of pressing the corresponding switch on the D-Control Main Unit.

Each Footswitch Settings page has four options:

- Flip + / Flip – : Changes the polarity of the footswitch connection to positive (+) or negative (–).
- Play: Simulates pressing the Play switch on the transport
- Record: Simulates pressing the Record switch on the transport
- Talkback: Simulates pressing the Talkback switch on the D-Control Main Unit

To set the function of the footswitches:

1. From the Preferences page, press the Soft Key that corresponds to “Foot 1” or “Foot 2.”

2. Press the Soft Key that corresponds to the function you want to assign to the footswitch. The Soft Key for the selected function lights continuously.

   Press the Soft Key that corresponds to “Escape.”

Sleep Mode Settings Page

Sleep mode saves power by dimming the LEDs on the D-Control unit. The Sleep Mode Settings page lets you set the amount of idle time before the LEDs on the unit dim automatically.

To set the time before the D-Control unit sleeps:

1. From the Preferences page, press the Soft Key (Main Unit) or the encoder Select switch (Fader Module) that corresponds to “Sleep.”

2. Turn the Scrub/Shuttle wheel (Main Unit) or any encoder knob (Fader Module) to change the time before the unit goes to sleep. Times range in 1-minute increments from 1 to 59 minutes, then in 1-hour increments from 1 to 12 hours, to Off (the unit never goes to sleep).
Appendix B: Audio Connections and Pinouts

All external D-Control audio connections are made to the back panel of the XMON interface, shown below. All audio connectors are standard female DB-25 connectors. The connector for communication with D-Control is a 15-pin female connector.

**XMON back panel connectors**

### 25-Pin Female Connector Pinouts

All XMON DB-25 connector pinouts conform to the pin numbering scheme shown below.

![DB-25 Connector (user view)](image)

#### Cue Inputs

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Hot (+)</th>
<th>Cold (-)</th>
<th>Ground (shield)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cue Input 1 (Left)</td>
<td>24</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Cue Input 1 (Right)</td>
<td>10</td>
<td>23</td>
<td>11</td>
</tr>
<tr>
<td>Cue Input 2 (Left)</td>
<td>21</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Cue Input 2 (Right)</td>
<td>7</td>
<td>20</td>
<td>8</td>
</tr>
<tr>
<td>Cue Input 3 (Left)</td>
<td>18</td>
<td>6</td>
<td>19</td>
</tr>
<tr>
<td>Cue Input 3 (Right)</td>
<td>4</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>[Not Connected]</td>
<td>15</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>[Not Connected]</td>
<td>1</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>GND</td>
<td></td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>SHIELD GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
</tbody>
</table>

#### Main Inputs

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Hot (+)</th>
<th>Cold (-)</th>
<th>Ground (shield)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Input 1 (L)</td>
<td>24</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Main Input 2 (Lc)</td>
<td>10</td>
<td>23</td>
<td>11</td>
</tr>
<tr>
<td>Main Input 3 (C)</td>
<td>21</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Main Input 4 (Rc)</td>
<td>7</td>
<td>20</td>
<td>8</td>
</tr>
<tr>
<td>Main Input 5 (R)</td>
<td>18</td>
<td>6</td>
<td>19</td>
</tr>
<tr>
<td>Main Input 6 (Ls)</td>
<td>4</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>Main Input 7 (Rs)</td>
<td>15</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>Main Input 8 (LFE)</td>
<td>1</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>GND</td>
<td></td>
<td></td>
<td>13</td>
</tr>
<tr>
<td>SHIELD GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
</tbody>
</table>
### Surround Inputs

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Hot (+)</th>
<th>Cold (-)</th>
<th>Ground (shield)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surround Input 1 (L)</td>
<td>24</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Surround Input 2 (Lc)</td>
<td>10</td>
<td>23</td>
<td>11</td>
</tr>
<tr>
<td>Surround Input 3 (C)</td>
<td>21</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Surround Input 4 (Rc)</td>
<td>7</td>
<td>20</td>
<td>8</td>
</tr>
<tr>
<td>Surround Input 5 (R)</td>
<td>18</td>
<td>6</td>
<td>19</td>
</tr>
<tr>
<td>Surround Input 6 (Ls)</td>
<td>4</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>Surround Input 7 (Rs)</td>
<td>15</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>Surround Input 8 (LFE)</td>
<td>1</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
<tr>
<td>SHIELD GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
</tbody>
</table>

### Stereo Inputs

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Hot (+)</th>
<th>Cold (-)</th>
<th>Ground (shield)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo Input 1 (Left)</td>
<td>24</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Stereo Input 1 (Right)</td>
<td>10</td>
<td>23</td>
<td>11</td>
</tr>
<tr>
<td>Stereo Input 2 (Left)</td>
<td>21</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Stereo Input 2 (Right)</td>
<td>7</td>
<td>20</td>
<td>8</td>
</tr>
<tr>
<td>Stereo Input 3 (Left)</td>
<td>18</td>
<td>6</td>
<td>19</td>
</tr>
<tr>
<td>Stereo Input 3 (Right)</td>
<td>4</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>Stereo Input 4 (Left)</td>
<td>15</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>Stereo Input 4 (Right)</td>
<td>1</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
<tr>
<td>SHIELD GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
</tbody>
</table>

### Main Speaker Outputs

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Hot (+)</th>
<th>Cold (-)</th>
<th>Ground (shield)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main 1 (L)</td>
<td>24</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Main 2 (Lc)</td>
<td>10</td>
<td>23</td>
<td>11</td>
</tr>
<tr>
<td>Main 3 (C)</td>
<td>21</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Main 4 (Rc)</td>
<td>7</td>
<td>20</td>
<td>8</td>
</tr>
<tr>
<td>Main 5 (R)</td>
<td>18</td>
<td>6</td>
<td>19</td>
</tr>
<tr>
<td>Main 6 (Ls)</td>
<td>4</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>Main 7 (Rs)</td>
<td>15</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>Main 8 (LFE)</td>
<td>1</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
<tr>
<td>SHIELD GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
</tbody>
</table>

### Cue Outputs

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Hot (+)</th>
<th>Cold (-)</th>
<th>Ground (shield)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLS Output (Left)</td>
<td>24</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>SLS Output (Right)</td>
<td>10</td>
<td>23</td>
<td>11</td>
</tr>
<tr>
<td>Cue Output 1 (Left)</td>
<td>21</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Cue Output 1 (Right)</td>
<td>7</td>
<td>20</td>
<td>8</td>
</tr>
<tr>
<td>Cue Output 2 (Left)</td>
<td>18</td>
<td>6</td>
<td>19</td>
</tr>
<tr>
<td>Cue Output 2 (Right)</td>
<td>4</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>Cue Output 3 (Left)</td>
<td>15</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>Cue Output 3 (Right)</td>
<td>1</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
<tr>
<td>SHIELD GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
</tbody>
</table>
### Alt Speaker Outputs

**Alt Speaker Outputs**

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Hot (+)</th>
<th>Cold (–)</th>
<th>Ground (shield)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt 1 (L)</td>
<td>24</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Alt 2 (Lc)</td>
<td>10</td>
<td>23</td>
<td>11</td>
</tr>
<tr>
<td>Alt 3 (C)</td>
<td>21</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Alt 4 (Rc)</td>
<td>7</td>
<td>20</td>
<td>8</td>
</tr>
<tr>
<td>Alt 5 (R)</td>
<td>18</td>
<td>6</td>
<td>19</td>
</tr>
<tr>
<td>Alt 6 (Ls)</td>
<td>4</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>Alt 7 (Rs)</td>
<td>15</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>Alt 8 (LFE)</td>
<td>1</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>GND</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SHIELD GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
</tbody>
</table>

### Talkback/Listenback Pinouts

**Talkback/Listenback**

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Hot (+)</th>
<th>Cold (–)</th>
<th>Ground (shield)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ext Talkback Mic Input</td>
<td>24</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Listen Mic 1 Input</td>
<td>10</td>
<td>23</td>
<td>11</td>
</tr>
<tr>
<td>Listen Mic 2 Input</td>
<td>21</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>AFL Input 1</td>
<td>20</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>AFL Input 2</td>
<td>6</td>
<td>18</td>
<td>19</td>
</tr>
<tr>
<td>Mini Speaker Out (L)</td>
<td>4</td>
<td>17</td>
<td>5</td>
</tr>
<tr>
<td>Mini Speaker Out (R)</td>
<td>15</td>
<td>3</td>
<td>16</td>
</tr>
<tr>
<td>Talkback/Slate Out</td>
<td>1</td>
<td>14</td>
<td>2</td>
</tr>
<tr>
<td>GND</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SHIELD GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
</tbody>
</table>

### 15-Pin Connector Pinouts

The XMON 15-pin connector pinouts conform to the pin numbering scheme shown below.

![15-pin connector (user view)](image)

**XMON to D-Control Connector Pinouts**

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Hot (+)</th>
<th>Cold (–)</th>
<th>Ground (shield)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS422 Input</td>
<td>1</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>RS422 Output</td>
<td>2</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>MIDI Input</td>
<td>12</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>MIDI Output</td>
<td>11</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Headphones L</td>
<td>5</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>Headphones R</td>
<td>6</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>Internal Talkback Mic</td>
<td>15</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>GND</td>
<td></td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>SHIELD GND</td>
<td></td>
<td></td>
<td>connector housing</td>
</tr>
</tbody>
</table>
Numerics
9-Pin Remote switch 85

A
Actions switch (automation) 98
After-Fader Listen (Monitor section) 108
All Enabled switch (automation) 58
All Notes Off switch 92
All switch (automation) 58
Alt outputs (Monitor section) 105
Arrow switches 88
Assign controls 55, 115, 116
Inputs 55
Inserts 55
Outputs 55
Sends 55
Assign Talkback switch 110
Attack control (Dynamics plug-ins) 70
Audio Files switch 99
Audition Mode switch 86
Audition switches 86
Audition Mode 86
Mark In 86
Mark Out 86
Post-Roll 86
Pre-Roll 86
Auto Insert/Punch switch 87
Auto Talkback switch 111
AutoJoin switch 98
AutoMatch indicators 52
AutoMatch switch 98
automation enabling for plug-ins 67, 125
encoder mode indicator 48
plug-ins 54, 74, 80
Automation controls 98
Action 98
AutoJoin 98
AutoMatch 98
Join 98
Modes 99
Prefs 99
Automation Enable controls 57
Mute 57
Pan 57
Plug-in 57
Send Level 58
Send Mute 58
Send Pan 58
Volume 57
Automation Mode controls 8, 63
Latch 63
Off 63
Load 63
Read 63
Touch 63
Trim 63
Write 63
Automation Mode indicators 52
Automation Mode switches 51
Automation Safe mode 55, 118, 125
Automation Safe switch (plug-ins) 74
Automation Suspend switch 61
Automation switch (plug-ins) 74, 80
Automation Trim switch 51
Automation Write controls 58
Write to All 58
Write to All Enabled 58
Write to Current 58
Write to End 58
Write to Start 58
Auxiliary Input tracks 120

B
B/M/P (see Bypass/Mute/Pre)
Back and Play switch 86
Back switch 86
Bank justification (Custom Faders) 121
Bank Justification preference 40
Bank Select matrix 89
Bank Select switch 95
Bank Select switches 8
bank size (Custom Faders) 121
Bank/Cycle switch and Custom Fader mode 63
Bank/Nudge switches 8, 89
banking (tracks) 8
Broadcast mode (Monitor section) 108
Bypass/Mute switches (channel strips) 49
Bypass/Mute/Pre switch 118
Bypass/Mute/Pre switches (rotary encoders) 48
Show Values 57
Switch Info 57
switch mode 57

C
calibration
faders 44
meters 44
output level indication 44
Calibration Mode switch 105
channel display modes 51
Channel Select switches for channel strips 51
for Monitor section 107
for plug-ins 72, 79
Channel Strip Function controls 50
Automation Mode 51
Automation Trim 51
Channel Select 51
display modes 51
Input Monitor Mode 51
Mute 51
Record Enable 51
Record Safe mode 51
Solo 51
Channel Strip Master Function controls 61
Automation Suspend 61
Display Mode 61
Escape 61
Mute Clear 61
Select/Focus 61
Solo Clear 61
Channel Strip Master section 8
Channel Strip Mode controls 49, 50
Bypass/Mute 49
Dynamics 49
EQ 49
Global Input 60
Input 49
Inserts 49
Mic Pre 49
Pan 49
Sends 50
channel strips 47
Channel Select switch 51
fader section 52
Focus Channel Strip 8, 47
master section 53
channels
focusing 51, 117
Inline Console mode 120
PRE controls 120
selecting 51
Clear Clip switch 92
clipping indication 92
Compare switch (plug-ins) 74, 80
connections
audio 35, 137
alt 139
cue system 37, 137, 138
headphone 37
main 137, 138
solo outputs 139
surround inputs 138
talkback/listenback 139
Ethernet 9, 10, 33, 34, 39
footswitch 9, 34
power 33
USB 9, 34
XMON 9, 12, 35, 139
Console Preferences
Meter 96
Operation 96
User 96
Console prefs controls 96
Control Room Monitor system 104
Dim Level control 105
Input controls 104
Input Level Trim controls 104
Input Source Sum controls 104
Monitor Output Mode controls 105
Output Channel Select switches 107
Output controls 105
Output Level Trim controls 105
Current switch (automation) 58
Custom Fader Flip mode 62, 125
Custom Fader Map modes 62, 126
and Custom Fader Plug-in mode 126
and Custom Groups mode 126
Custom Fader Mode indicators 52
Custom Fader modes 62, 120, 121
Custom Groups mode 62, 122
Expanded Plug-in mode 125
Mix/Edit Groups 62, 123
Plug-in 62, 124
Tracks 62, 124
Custom Faders 8
bank justification 121
bank size 121
banks 121
display 62
displaying plug-ins 62
locking plug-ins 62
preferences 41
Custom Groups mode (Custom Fader) 62, 122
Cycle switch (plug-ins) 74, 81
D
D-Control Units
declaring 39
naming 40
Dim function 109, 111
Dim Level control 105
Display Brightness 134
Display Contrast 135
Display Mode switch 81
Display preferences 42
Do To All switches 59
Do To Selected switches 59
Dynamics (plug-ins) 8, 65, 69
gain reduction display 68, 75
Dynamics plug-in controls
Attack 70
External Key 73
Filter Frequency 71
Filter In 71
Filter Q/Slope 71
Gain 71
Hold 71
Hysteresis 70
Key Listen 73
Knee 70
Notch/Shelf 71
Range 70
Ratio 70
Release 70
Threshold 71
Dynamics switches (channel strips) 49
E
Edit Controls
Edit Functions 94, 95
Edit Modes 95
Edit Tools 95
Edit controls 94
Edit Function switches 94, 95, 100
Edit Mode switches 100
Edit window
navigation 8, 88
playback of selections 84
Edit/Timeline switch 100
Enable Parameters switch 54
Encoder Order preference 41
Encoder Select switches 48
End (Start/End/Length) switch 100
End switch (automation) 58
EQ (plug-ins) 8, 65, 76
EQ Band Pass controls (plug-ins) 78
EQ plug-in controls
Band Pass 78
High Shelf/Peak 77
High-Pass 77
Low Shelf/Peak 77
LowPass 77
EQ switches (channel strips) 49
Escape switch 61
Ethernet 9, 10, 33, 34, 39
expansion options 4
Explode switch 101
External Key switch (Dynamics plug-ins) 73
External Machine Online switches 87
External Machines switches 87
Auto Insert/Punch 87
Insert/Assemble 87
Machine Insert 87
Track Arm from Channel Strips 87
F
Fader Module
back panel overview 10
components 3
top panel overview 10
Utility mode 129
faders 52
calibration 44
Faders On/Off preference 40
Filter Frequency controls (Dynamics plug-ins) 71
Filter In switches (Dynamics plug-ins) 71
Filter Q/Slope controls (Dynamics plug-ins) 71
Flip mode 53, 119
and Instrument tracks 50
Flip switch (Custom Fader mode) 62
Flip switches 53
Flip mode 53, 119
Focus Channel Strip (8, 47
Focus mode (Channel Select switch) 51
focusing channels 51, 101, 117
plug-ins 65, 66, 117
footswitch 9, 34
Footswitch settings 135
Forward and Play 86

G
Gain controls (plug-ins) 75, 81
Gain/Hold control (Dynamics plug-ins) 71
Global Channel Strip Mode controls 60
   Dynamics 60
   EQ 60
   Inserts 61
   Mic Pre 60
   Page 60
   Pan 61
   Sends 61
Global controls 58
   Do To All 59
   Do To Selected 59
   Set To Default 60
   Suspend Groups 60
Global Input switch 80
   Go To End switch 86
   Go To Start switch 86
   Go to switch 101
Group Status indicators 52
Group switch 94
groups
   activating 123
   creating 123
   deleting 124
   editing 124

H
Headphone/Cue system 109
   Input controls 110
   Output controls 109
High Shelf/Peak controls (EQ plug-ins) 77
High-Pass controls (EQ plug-ins) 77

I
Inline Console mode 120
Input controls (Monitor section) 104
Input Level Trim controls (Monitor section) 104
Input Monitor Mode switches 51
Input Source Sum controls (Monitor section) 104
Input switches 49
   inputs
      assigning 115
      making inactive 116
   inputs (Monitor section)
      main 104
      selecting 104
      stereo 104
      summing 104
      surround 104
      trimming 104
Insert/Assemble switch 87
   inserts
      assigning 115, 116, 119
      making inactive 116
   inserts switches 49
   Instant Playback switch 87
   Instrument tracks 50, 57

J
Join switch 98

K
Key Listen switch (Dynamics plug-ins) 73
   keyboard
      reconfiguring for Windows 30
      keyboard modifiers 52
Knee/Hysteresis control (Dynamics plug-ins) 70
   Lnature
Monitor section 103
Control Room Monitoring controls 104
displays 106
Headphone/Cue controls 109
Tailback/Listen controls 110
monitoring 8, 103, 104
Mono switch 106
Mute Clear switch 61
Mute switch (automation) 57
Mute switch (Monitor section) 106
Mute switches (channel strips) 51

Navigate Mode switch 88
navigation controls 8, 88
Notch/Shelf switches (Dynamics plug-ins) 71
nudging (tracks) 8

Off switch (automation) 63
Operation switch 96
Output Channel Select switches (Monitor section)
Mute 107
Solo 107
Output Channel Trim mode (Monitor section) 107
Output controls (Monitor section) 105
outputs assigning 115
making inactive 116
outputs (Monitor section)
Alt 105
calibrating 105
channels 107
main 105
Mini (stereo) 105
selecting 105
trimming 105, 107

Page switch (plug-ins) 73
Page switches (channel strips) 49
Pan on Lower Encoder preference 41
Pan switch (automation) 57
Pan switches 49
pinout diagrams 137
Playlist switch 94
Plug-in Automation controls 54
plug-in controls
Dynamics 8, 65, 69
Gain 75, 81
Plug-in mode (Custom Fader) 62, 124
Plug-in switch (automation) 57
plug-ins 8, 65, 69, 76
assigning 65
Automation Safe 55, 125
Automation Safe switch 74
Automation switch 74, 80
bypassing 74, 81, 118, 125
changing settings 67
Channel Select switches 72, 79
Compare switch 74, 80, 125
copying settings 67
Custom Fader mode 124
Cycle switch 74, 81
Dynamics 69, 118
Dynamics gain reduction 68
enabling automation 54, 67, 125
EQ 76, 118
focusing 65, 66, 117, 118, 124
Lock switch 74, 80
making inactive 67, 118
Master Bypass switch 74, 81
Master Link switch 72, 79
meters 75
multichannel 65, 72, 79
multi-mono 65, 72, 129
multiple plug-in windows 66, 67
opening plug-in windows 66, 74, 81
Page switch 73
Save switch 81
Save As switch 73, 80
Select/Link/Bypass Mode switch 72, 79
targeting 66
Window switch 74, 81
Post-Roll switch 86
PRE controls
tracks
PRE controls 120
Pre-Fader Listen (Monitor section) 108
Preferences (D-Control) 40, 134
Blank Justification 40
Custom Faders 41
Display 42
Display Brightness 134
Display Contrast 135
Encoder Order 41
Faders On/Off 40
Footswitch settings 135
Pan on Lower Encoder 41
Rotary Encoder Velocity mode 41
Select Switch Latch mode 41
Sleep Mode settings 135
Touch Value 40
Prefs switch (automation) 99
Pre-Roll switch 86
Pro Tools Online switch 85
Publish switch 92
QuickPunch switch 85
QWERTY Disable switch 92
Ratio/Range control (Dynamics plug-ins) 70
Read switch (automation) 63
Record Enable switches 51
Record Safe mode 51
Redo switch 92
reference level preference (meters) 113
Release Control (Dynamics plug-ins) 70
requirements
connections 4, 33, 35, 137
operational 4
system 4
resetting D-Control units (Utility mode) 134
Rotary Encoder Velocity mode 41
rotary encoders 47
automation mode indicator 48
Bypass/Mute/Pre Switch mode 57
display color 48
Safe switch (plug-ins) 81
Save As switch (plug-in settings) 73, 80
Save switch (sessions) 92
saving settings 73, 80
Scrub switch 84
Scrub/Shuttle controls 84
Scrub switch 84
Scrub/Shuttle wheel 84
Shuttle switch 84
Trim switch 84
Scrub/Shuttle wheel 84
Select mode (Channel Select switch) 51
Select Switch Latch mode 41
Select/Focus switch 61
Select/Link/Bypass Mode switch (plug-ins) 72, 79
Select/MIDI controls 95
Blank Select 95
Memory Location 95
MIDI 95
selections
playback from transport controls 84
setting Start/End/Length 100
Send Level switch (automation) 58
Send Mute switch (automation) 58
Send Pan mode 50
Send Pan switch (automation) 58
 sends
assigning 115, 116, 119
Automation Safe 55
making inactive 116
muting 118
setting pre- or post-fader 118
Sends switches 50
Session Management switches 8, 92
All Notes Off 92
Clear Clip 92
Publish 92
QWERTY Disable 92
Redo 92
Save 92
Undo 92
Utility 92
Set to Default switch 60
Show Values switch 57
Show/Hide switch 99
Shuttle switch 84
Sleep Mode settings 135
Soft Keys 8, 93
Automation controls 98
Console Prefs controls 96
Edit controls 94
Management controls 94
Select/MIDI controls 95
solo
latching 51
output connections 139
Solo Clear switch 61
Solo In Place (Monitor section) 108
Solo Latch options (Monitor section) 108
Solo Mode controls (Monitor section)
After-Fader Listen 108
Broadcast 108
Pre-Fader Listen 108
Solo In Place 108
Solo Safe mode 51
Solo switches 51
Solo/Mute switch (Monitor section) 107
specifications
mechanical 5
stand
assembly 19, 20, 21
components 3, 16
finishing 25, 26
hardware 17
installing D-Control units 22, 23, 24
leveling 18
Start (Start/End/Length) switch 100
Start switch (automation) 58
Stereo inputs (Monitor section) 104
Sum mode (Monitor section) 104
Surround inputs (Monitor section) 104
Suspend Groups switch 60
Switch Info switch 57
System Info (Utility mode) 130
T
talkback
Assign switch 110
connections 139
Dim function 109, 111
External level control 110
Level control (built-in) 110
microphone (built-in) 112
Talkback switches 8, 63, 111
Auto Talkback switch 111
Talkback/Listen system 110
targeting plug-ins 66
Test pages (Utility mode) 131
Threshold control (Dynamics plug-ins) 71
time scale display 8, 112
time scale display format indicator 112
Touch switch (automation) 63
Touch Value preference 40
Track Arm from Channel Strips switch 87
Track Size switches 101
Track switch 94
trackball
moving or replacing 31
TrackPunch switch 85
tracks
Automation Safe 55
focusing 51, 117
Inline Console mode 120
making inactive 116
selecting 51, 117
Tracks mode (Custom Fader) 62, 124
transport controls 8, 83
latching behavior 84
Transport Mode switches 85
9-pin Remote 85
Loop Playback 85
Pro Tools Online 85
QuickPunch 85
TrackPunch 85
Trim mode (Monitor section) 107
Trim switch (automation) 63
Trim switch (Scrub/Shuttle controls) 84
U
Undo switch 92
Unit Name (Utility mode) 130
User switch 96
Utility mode 92, 129
Reset Unit 134
System Info 130
Test pages 131
Unit Name 130
Utility switch (Utility mode) 92
V
video display 8, 27
Volume switch (automation) 57
W
Window Management switches 8, 91
Window switch (Custom Fader Plug-In mode) 62
Window switch (plug-ins) 74, 81
windows
opening 91, 94
Write switch (automation) 63
Write to All (automation) 58
Write to All Enabled (automation) 58
Write to Current (automation) 58
Write to End (automation) 58
Write to Start (automation) 58
X
XMON 137
back panel overview 12
components 3
connections 9, 12, 35, 139
front panel overview 11
Z
Zoom Mode switch 88
Zoom Preset switches 88
Zoom Toggle 101
Zoom/Navigate section 88
Arrow switches 88
Navigate Mode switch 88
Zoom Mode switch 88
Zoom Preset switches 88